• Apple, Mac, Mac OS, and MacBook are trademarks of Apple Inc. registered in the U.S. and other countries.
• Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
• MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.
• Adobe, Adobe PDF, Adobe Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
• Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.
• HDMI, the HDMI Logo and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI Licensing LLC.

- DisplayPort and DisplayPort Compliance Logo are trademarks owned by the Video Electronics Standards Association.

- Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other countries and areas.
- Wi-Fi®, Wi-Fi Alliance®, and Wi-Fi Protected Access (WPA, WPA2)® are registered trademarks of the Wi-Fi Alliance.
- Blu-ray is a trademark of Blu-ray Disc Association
- CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other countries.
- Other product and company names mentioned in this user's manual may be the trademarks or registered trademarks of their respective holders.

NOTES
(1) The contents of this user's manual may not be reprinted in part or whole without permission.
(2) The contents of this user's manual are subject to change without notice.
(3) Great care has been taken in the preparation of this user's manual; however, should you notice any questionable points, errors or omissions, please contact us.
(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions

Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

**CAUTION**

To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.

**CAUTION**

TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.
This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided.
The information should be read carefully to avoid problems.

**WARNING:** TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)

This Class B digital apparatus complies with Canadian ICES-003.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

**CAUTION**

Avoid displaying stationary images for a prolonged period of time.
Doing so can result in these images being temporarily sustained on the surface of the LCD panel.
If this should happen, continue to use your projector. The static background from previous images will disappear.

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic products carrying the mark (left) must be disposed of separately from normal household waste. This includes projectors and their electrical accessories or lamps. When you dispose of such products, please follow the guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member States.
Important Information

WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regulation could void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards

These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

⚠️ Installation

• Do not place the projector in the following conditions:
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.

• If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
**WARNING**

- Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of the cap due to the heat emitted from the light output.
- Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead to the object melting from the heat that is emitted from the light output.

---

Do not use the projector with it leaning to the left and right. This may result in a malfunction. However, portrait installation is possible* (when a custom-designed stand is made). For portrait installation, install the projector with the air intake at the bottom and leave a space of at least 130 mm below the air intake.

---

**Fire and Shock Precautions**

- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your projector. Allow enough space between your projector and a wall. (*→ page vii*)
- Do not try to touch the ventilation outlet on the left front (when seen from the front) as it can become heated while the projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation.
  Use caution when picking up the projector.

- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.
- Do not place any objects on top of the projector.
- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
- The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.
- Do not look into the lens while the projector is on. Serious damage to your eyes could result.
- Keep any items (magnifying glass etc.) out of the light path of the projector. The light path being projected from the lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause an unpredictable outcome such as a fire or injury to the eyes.
- Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent. Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust.
Important Information

- Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
  - Do not use any power cord other than the one supplied with the projector.
  - Do not bend or tug the power cord excessively.
  - Do not place the power cord under the projector, or any heavy object.
  - Do not cover the power cord with other soft materials such as rugs.
  - Do not heat the power cord.
  - Do not handle the power plug with wet hands.

- Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cord or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user's manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.

- Disconnect the power cord and any other cables before carrying the projector.
- Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
- Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
- When using a LAN cable:
  For safety, do not connect to the connector for peripheral device wiring that might have excessive voltage.

CAUTION

- Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging on the wall can cause damage to the projector.
- Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the soft case could be damaged.
- Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select [SETUP] → [OPTIONS(1)] → [FAN MODE] → [MODE] → [HIGH].)
- Do not move the projector by holding the cable cover. Doing so may result in the projector falling or causing injury.
- Do not unplug the power cable from the wall outlet or projector when the projector is powered on. Doing so can cause damage to the AC IN connector of the projector and (or) the prong plug of the power cable.
  To turn off the AC power supply when the projector is powered on, use a power strip equipped with a switch and a breaker.
- Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blinking blue. Doing so could cause premature lamp failure.

Caution on Handling the Optional Lens

When shipping the projector with the lens, remove the lens before shipping the projector. Always attach the dust cap to the lens whenever it is not mounted on the projector. The lens and the lens shift mechanism may encounter damage caused by improper handling during transportation.

Do not hold the lens part when carrying the projector.

Doing so could cause the focus ring to rotate, resulting in accidental dropping of the projector.

Remote Control Precautions

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/−) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.
Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement
• Use the specified lamp for safety and performance.
• To replace the lamp, follow all instructions provided on page 142.
• Be sure to replace the lamp and filter when the message [THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER. USE THE SPECIFIED LAMP FOR SAFETY AND PERFORMANCE.] appears. If you continue to use the lamp after the lamp has reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury.
If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a high-pressure mercury lamp as a light source.
A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on and off will increase the possibility of its lower brightness.

⚠️ CAUTION:
• DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
• When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass fragments could fall if the lamp has been burned out.

About High Altitude mode
• Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5249 feet/1600 meters or higher.
Using the projector at altitudes approximately 5249 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
• Using the projector at altitudes less than approximately 5249 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
• Using the projector at altitudes approximately 5249 feet/1600 meters or higher can shorten the life of optical components such as the lamp.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with the following functions may raise concern about the infringement of copyrights which are protected by copyright law. [ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.
### Health precautions to users viewing 3D images

Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your 3D eyeglasses or your 3D compatible content such as Blu-ray Discs, video games, computer’s video files and the like.

To avoid any adverse symptoms, heed the following:

- Do not use 3D eyeglasses for viewing any material other than 3D images.
- Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a distance can strain your eyes.
- Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour of viewing.
- If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D images.
- While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor.
- View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain.

### Power management function

In order to keep power consumption low, the following power management functions (1) and (2) have been set when shipped from the factory. Please display the on-screen menu and change the settings (1) and (2) according to the aim of using the projector.

1. **STANDBY MODE (Factory preset: NORMAL)**
   - When [NORMAL] is selected for [STANDBY MODE], the following connectors and functions will not work:
     - HDMI OUT connector, AUDIO OUT connector, Ethernet/HDBase T Port, USB-A Port, LAN functions, Mail Alert function
     (→ page 114)

2. **AUTO POWER OFF (Factory preset: 60 minutes)**
   - When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 1 hour if there is no signal received by any input or if no operation is performed.
     (→ page 115)
Clearance for Installing the Projector

Allow ample clearance between the projector and its surroundings as shown below. The high temperature exhaust coming out of the device may be sucked into the device again. Avoid installing the projector in a place where air movement from the HVAC is directed at the projector. Heated air from the HVAC can be taken in by the projector’s intake vent. If this happens, the temperature inside the projector will rise too high causing the over-temperature protector to automatically turn off the projectors power.

Example 1 – If there are walls on both sides of the projector.

![Diagram Example 1]

NOTE:
The drawing shows the proper clearance required for the front, back and top of the projector.

Example 2 – If there is a wall behind the projector.

![Diagram Example 2]

NOTE:
The drawing shows the proper clearance required for the back, sides and top of the projector.

Example 3 – In the case of portrait projection.

![Diagram Example 3]

NOTE:
- The drawing shows the proper clearance required for the front, back and top of the projector.
- See page 134 for an installation example on portrait projection.
# Table of Contents

**Important Information**

---

## 1. Introduction

1. What's in the Box? ......................................................................................... 1
2. Introduction to the Projector
   - Congratulations on Your Purchase of the Projector .................................. 2
   - Installation .................................................................................................... 2
   - Videos ......................................................................................................... 2
   - Network ....................................................................................................... 3
   - Energy-saving .............................................................................................. 3
   - Maintenance ................................................................................................. 3
   - About this user's manual .......................................................................... 4

3. Part Names of the Projector
   - Front/Top .................................................................................................. 5
   - Rear .......................................................................................................... 6
   - Control Panel/Indicator Section ................................................................ 7
   - Terminal Panel Features ......................................................................... 8

4. Part Names of the Remote Control
   - Battery Installation .................................................................................. 9
   - Remote Control Precautions .................................................................... 10
   - Operating Range for Wireless Remote Control ....................................... 11

## 2. Projecting an Image (Basic Operation)

1. Flow of Projecting an Image ..................................................................... 12
2. Connecting Your Computer/Connecting the Power Cord ......................... 13
3. Turning on the Projector
   - Note on Startup screen (Menu Language Select screen) ...................... 15
4. Selecting a Source
   - Selecting the computer or video source ............................................... 16

5. Adjusting the Picture Size and Position
   - Adjusting the vertical position of a projected image (Lens shift) ........ 19
   - Focus ....................................................................................................... 20
   - Applicable lens: NP30ZL .................................................................. 21
   - Applicable lens: NP11FL .................................................................. 22
   - Zoom ........................................................................................................ 23
   - Adjusting the Tilt Feet .......................................................................... 23

6. Optimizing Computer Signal Automatically
   - Adjusting the Image Using Auto Adjust ............................................. 24

7. Turning Up or Down Volume .................................................................... 24
8. Turning off the Projector .......................................................................... 25
9. After Use ..................................................................................................... 26

## 3. Convenient Features

1. Turning off the Image and Sound ............................................................... 27
2. Freezing a Picture ...................................................................................... 28
3. Enlarging a Picture .................................................................................. 28
Table of Contents

Checking Energy-Saving Effect [CARBON METER] .............................................30
5 Using the Optional Remote Mouse Receiver (NP01MR) ..................................31
6 Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE] ........33
7 Preventing the Unauthorized Use of the Projector [SECURITY] .........................36
8 Projecting 3D videos.......................................................................................39
   Procedure to watch 3D videos using this projector ........................................39
   When videos cannot be viewed in 3D.............................................................41
9 Controlling the Projector by Using an HTTP Browser ..................................42

4. Multi-Screen Projection ..............................................................................48
1 Things that can be done using multi-screen projection ....................................48
   Case 1. Using a single projector to project two types of videos [PIP/PICTURE
            BY PICTURE] ..................................................................................48
   Case 2. Using four projectors (liquid crystal panel: XGA) to project videos with
            a resolution of 1920 × 1080 pixels [TILING] .................................49
   Things to note when installing projectors .......................................................51
2 Displaying Two Pictures at the Same Time ..................................................52
   Projecting two screens..................................................................................53
   Switching the main display with the sub-display and vice versa ....................54
   Restrictions....................................................................................................55
3 Displaying a Picture Using [EDGE BLENDING] ..........................................56
   Setting the overlap of projection screens.......................................................57
   Black Level Adjustment..............................................................................60

5. Using On-Screen Menu ..............................................................................62
1 Using the Menus..........................................................................................62
2 Menu Elements............................................................................................63
3 List of Menu Items ........................................................................................64
4 Menu Descriptions & Functions [INPUT] .....................................................70
   1:HDMI1 .........................................................................................................70
   2:HDMI2 .........................................................................................................70
   3:DisplayPort .................................................................................................70
   4:BNC ............................................................................................................70
   5:BNC(CV) .....................................................................................................70
   6:BNC(Y/C) ...................................................................................................70
   7:COMPUTER ...............................................................................................70
   8:HDBaseT .....................................................................................................70
   ENTRY LIST ...................................................................................................70
   TEST PATTERN .............................................................................................70
5 Menu Descriptions & Functions [ADJUST] ..................................................74
   [PICTURE] ......................................................................................................74
   [IMAGE OPTIONS] ......................................................................................78
   [VIDEO] ........................................................................................................82
   [3D SETTINGS] ............................................................................................84
6 Menu Descriptions & Functions [DISPLAY] .................................................85
   [PIP/PICTURE BY PICTURE] .......................................................................85
   [GEOMETRIC CORRECTION] .....................................................................87
   [EDGE BLENDING] ......................................................................................91
   [MULTI SCREEN] ........................................................................................92
6. Connecting to Other Equipment

Connecting to a Wired LAN ................................................................. 137
Connecting to a HDBaseT transmission device (sold commercially) ..... 133
Portrait projection (vertical orientation) ............................................. 134
Connecting to a Wired LAN ................................................................. 137

7. Maintenance

Cleaning the Filters ........................................................................... 138
Cleaning the Lens .............................................................................. 141
Cleaning the Cabinet .......................................................................... 141
Replacing the Lamp and the Filters .................................................... 142

8. User Supportware

Operating Environment for Software Included on CD-ROM .......... 147
Names and Features of Bundled Software Programs ...................... 147
Download service ........................................................................... 147
Operating Environment .................................................................. 147

Installing Software Program ............................................................... 148
Installation for Windows software .................................................... 148

Operating the Projector Via the LAN (Virtual Remote Tool) .......... 151
Connect the projector to a LAN ........................................................ 152

Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5) .................................................. 154
9. Appendix..............................................................................................................................................158
   ❶ Throw distance and screen size ........................................................................................................158
       Lens types and throw distance ..................................................................................................158
       Tables of screen sizes and dimensions .................................................................................161
       Lens shifting range ..................................................................................................................162
   ❷ Compatible Input Signal List ......................................................................................................164
   ❸ Specifications .............................................................................................................................167
   ❹ Cabinet Dimensions ................................................................................................................169
   ❺ Mounting the cable cover (sold separately) ............................................................................170
   ❻ Pin assignments and signal names of main connectors ..........................................................171
   ❼ Troubleshooting ........................................................................................................................173
       Indicator Messages ..................................................................................................................173
       Common Problems & Solutions ...............................................................................................175
       If there is no picture, or the picture is not displayed correctly ............................................177
   ❽ PC Control Codes and Cable Connection ...............................................................................178
   ❾ Troubleshooting Check List .......................................................................................................179
1. Introduction

What’s in the Box?

Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

Projector

Dust cap for lens
* The projector is shipped without a lens. For the types of lens and throw distances, see page 158.

Remote control (7N900961)

AA alkaline batteries (x2)

Input selection character seal

Power cord (US: 7N080241) (EU: 7N080022)

Lens theft prevention screw (24V00841)
This screw makes it difficult to remove the lens mounted on the projector. (→ page 124)

Straps (24J23901) (for preventing lamp cover from falling)
Attaching the straps to the lamp cover prevents them from falling when the projector is suspended from the ceiling.

- Important Information (For North America: 7N8N4121) (For Other countries than North America: 7N8N4121 and 7N8N4131)
- Quick Setup Guide (For North America: 7N8N4141) (For Other countries than North America: 7N8N4141 and 7N8N4151)

NEC Projector CD-ROM
User’s manual (PDF) and the utility software (7N951971)

For North America only
Registration card
Limited warranty

For customers in Europe:
You will find our current valid Guarantee Policy on our Web Site: www.nec-display-solutions.com
Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

Congratulations on Your Purchase of the Projector

This projector is one of the very best projectors available today. The projector enables you to project precise images up to 500 inches across (measured diagonally) from your PC or Mac computer (desktop or notebook), VCR, Blu-ray player, or document camera.

You can use the projector on a tabletop or cart, you can use the projector to project images from behind the screen, and the projector can be permanently mounted on a ceiling*. The remote control can be used wirelessly.

* Do not attempt to mount the projector on a ceiling yourself.

The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.

In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes. Please consult your dealer for more information.

Installation

- Liquid crystal type high brightness/high resolution projector

<table>
<thead>
<tr>
<th>Model</th>
<th>Brightness</th>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA622U</td>
<td>6200 lm</td>
<td>WUXGA (1920 × 1200)</td>
<td>16:10</td>
</tr>
<tr>
<td>PA522U</td>
<td>5200 lm</td>
<td>WUXGA (1920 × 1200)</td>
<td>16:10</td>
</tr>
<tr>
<td>PA672W</td>
<td>6700 lm</td>
<td>WXGA (1280 × 800)</td>
<td>16:10</td>
</tr>
<tr>
<td>PA572W</td>
<td>5700 lm</td>
<td>WXGA (1280 × 800)</td>
<td>16:10</td>
</tr>
<tr>
<td>PA722X</td>
<td>7200 lm</td>
<td>XGA (1024 × 768)</td>
<td>4:3</td>
</tr>
<tr>
<td>PA622X</td>
<td>6200 lm</td>
<td>XGA (1024 × 768)</td>
<td>4:3</td>
</tr>
</tbody>
</table>

- Wide range of optional lenses selectable according to the place of installation

This projector supports 6 types of optional lenses, providing a selection of lenses adapted to a variety of places of installation and projection methods.

In addition, the lenses can be mounted and removed in one touch.

Note that no lens is mounted upon shipment from the factory. Please purchase optional lenses separately.

- Lens shift function for easily adjusting the position of the projected image

The position of the projected image is moved by turning the two dials on the projector’s front, one for the vertical direction, one for the horizontal direction.

- 360° installation angle (tilt-free)

The projector can be installed at any angle (360°).

Note, however, that the “fan mode” setting must be changed according to the angle of installation.

Also, the projector cannot be installed tilted to the left or right.

- Portrait projection is possible

This projector can perform portrait projection with the projection screen turned 90°.

However, the lamp replacement time* is 2000 hours for portrait projection.

* Replacement time not guaranteed.

Videos

- Wide range of input/output connectors (HDMI, DisplayPort, BNC, etc.) and built-in monaural speaker

The projector is equipped with a variety of input/output connectors: HDMI (input × 2, output × 1), DisplayPort, BNC (5-core), computer (analog), etc.

The projector’s HDMI input/output connectors and DisplayPort input connector support HDCP.

The projector is also equipped with a built-in 10W monaural speaker.
1. Introduction

• Equipped with HDBaseT input terminal
This projector is equipped with a HDBaseT input terminal which can be connected to a HDBaseT transmission device sold commercially.
HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance.

• Simultaneous display of 2 images (PIP/PICTURE BY PICTURE)
Two images can be projected simultaneously with a single projector.
There are two types of layouts for the two images: “picture-in-picture” in which a sub-picture is displayed on the main picture, and “picture-by-picture” in which the main and sub pictures are displayed next to each other.

• Multi-screen projection using multiple projectors
This projector is equipped with multiple HDMI input & output terminals that can connect multiple projectors in a digital chain. A high quality picture is achieved by dividing and projecting high resolution videos among the various projectors.
Furthermore, the boundaries of the screens are smoothed using an edge blending function.

• Seamless switch function for smoother screen changes when switching the signal
When the input connector is switched, the image displayed before switching is held so that that the new image can be switched to without a break due to absence of a signal.

• Supports HDMI 3D format
This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear and 3D emitters that support Xpand 3D.

Network

• Convenient utility software (User Supportware) provided as standard
The three utility software stored in the enclosed NEC Projector CD-ROM (Virtual Remote Tool, PC Control Utility Pro 4 (for Windows) and PC Control Utility Pro 5 (for Mac OS)) can be used. The following three utility software on the CD-ROM cannot be used.
Image Express Utility Lite (for Windows/Mac OS), Image Express Utility 2.0 (for Windows) and Desktop Control Utility 1.0 (for Windows)

Energy-saving

• Energy-saving design with a standby power consumption of 0.11 watts (100-130 V)/0.16 watts (200-240 V)
When the on-screen menu’s standby mode is set to “NORMAL”, the power consumption in the standby mode is 0.11 watts.

• “Eco mode” for low power consumption and “Carbon Meter” display
The projector is equipped with an “eco mode” for reducing power consumption during use. Furthermore, the power-saving effect when the eco mode is set is converted into the amount of reductions of CO₂ emissions and this is indicated on the confirmation message displayed when the power is turned off and at “Information” on the on-screen menu (CARBON METER).

Maintenance

• Maximum lamp replacement time of 4000 hours and no need to clean the filters
When used in the eco mode, the lamp replacement time* is extended to a maximum of 4000 hours.
* This time is not guaranteed.
Furthermore, this projector uses large 2-layer filters. When these filters are replaced with new ones when changing the lamp, there is no need for regular filter cleaning.
About this user's manual

The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user's manual. This may save you time later on. At the beginning of each section of the manual you'll find an overview. If the section doesn't apply, you can skip it.
Part Names of the Projector

Front/Top

The lens is sold separately. The description below is for when the NP13ZL lens is mounted.

1. Introduction

Mounting the strap

1. Mount the strap to the filter cover and lamp cover as shown on the diagram below.
2. Insert the knot in the strap into the hole on the bottom of the projector and pull in the direction of the arrow to fasten.

How to paste the input selection character sticker of the remote control

- Peel off the cover of the sticker and align the sticker holes with Buttons 1 to 6 before pasting.
- Please take care not to let the sticker contact the buttons when pasting.
- The explanations and illustrations in this manual are provided with the sticker pasted.
1. Introduction

Rear

Terminal Panel (→ page 8)

Remote Sensor (located on the front and the rear) (→ page 11)

Rear Remote Sensor (located on the front and the rear) (→ page 11)

AC Input
Connect the supplied power cord's three-pin plug here, and plug the other end into an active wall outlet. (→ page 13)

Ventilation (inlet) / Filter Cover (→ page 138, 145)

Ventilation (outlet)
Heated air is exhausted from here.

Cable cover connection (right and left)
Screw holes and grooves for the optional cable cover (→ page 170)

Built-in Security Slot ( )*

* This security slot supports the MicroSaver ® Security System.
1. \( \bigcirc \) (POWER) Button
   (→ page 14, 25)

2. POWER Indicator
   (→ page 13, 14, 25, 173)

3. STATUS Indicator
   (→ page 173)

4. LAMP Indicator
   (→ page 142, 174)

5. TEMP. Indicator
   (→ page 174)

6. INPUT Button
   (→ page 16)

7. AUTO ADJ. Button
   (→ page 24)

8. Geometric. Button
   (→ page 33)

9. MENU Button
   (→ page 62)

10. \( \uparrow \downarrow \leftrightarrow \leftrightarrow \) / Volume Buttons
    (→ page 24, 62)

11. ENTER Button
    (→ page 62)

12. EXIT Button
    (→ page 62)
Terminal Panel Features

1. HDMI 1 IN Connector (Type A)  
   (→ page 126, 128, 132, 171)
2. HDMI 2 IN Connector (Type A)  
   (→ page 126, 128, 132, 171)
3. DisplayPort IN Connector  
   (→ page 126, 171)
4. BNC IN [R/Cr/CV, G/Y/Y, B/Cb/C, H, V] Connectors (BNC x 5)  
   (→ page 125, 130)
5. BNC (CV) Input Connector (BNC x 1)  
   (→ page 130)
6. BNC (Y/C) Input Connector (BNC x 2)  
   (→ page 130)
7. BNC AUDIO IN Mini Jack (Stereo Mini)  
   (→ page 128, 130)
8. COMPUTER IN/ Component Input Connector  
   (Mini D-Sub 15 Pin)  
   (→ page 13, 125)
9. COMPUTER AUDIO IN Mini Jack (Stereo Mini)  
   (→ page 13, 125)
10. Ethernet/HDBase T Port (RJ-45)  
    (→ page 133, 172)
11. USB-A Port (Type A)  
    (→ page 172)  
    (For future expansion. This port allows for power supply.)
12. HDMI OUT Connector (Type A)  
    (→ page 129)
13. AUDIO OUT Mini Jack (Stereo Mini)  
    (→ page 129)
14. 3D SYNC Connector (Mini DIN 4 Pin)  
    (→ page 39)
15. PC CONTROL Port (D-Sub 9 Pin)  
    (→ page 172)  
    Use this port to connect a PC or control system.  
    This enables you to control the projector using serial communication protocol.  
    If you are writing your own program, typical PC control codes are on page 178.
16. REMOTE Connector (Stereo Mini)  
    Use this connector for wired remote control of the projector using the NEC optional remote control.  
    Connect the projector and optional remote control using a commercially available wired remote control cable.

NOTE:
- When a remote control cable is connected to the REMOTE connector, infrared remote control operations cannot be performed.
- When [HDBaseT] is selected in the [REMOTE SENSOR] and the projector is connected to a commercially-available transmission device that supports HDBaseT, remote control operations in infra-red cannot be carried out if transmission of remote control signals has been set up in the transmission device. However, remote control using infrared rays can be carried out when the power supply of the transmission device is switched off.
Part Names of the Remote Control

8. TEST Button  
(→ page 70)
9. Edge Blend. Button  
(→ page 91)
10. Multi. Button  
(→ page 92)
(→ page 33)
12. INPUT Button  
(→ page 16)
13. PIP Button  
(→ page 53)
14. PBP/POP Button  
(→ page 53)
15. AUTO ADJ. Button  
(→ page 24)
16. 1 (HDMI 1) Button  
(→ page 16)
17. 2 (HDMI 2) Button  
(→ page 16)
18. 3 (DisplayPort) Button  
(→ page 16)
19. 4 (BNC) Button  
(→ page 16)
20. 5 (BNC(CV)) Button  
(→ page 16)
21. 6 (BNC(Y/C)) Button  
(→ page 16)
22. 7 (Computer) Button  
(→ page 16)
23. 8 (HDBaseT) Button  
(→ page 16)
24. 9 (USB-A) Button  
(→ page 16)
25. ID SET Button  
(→ page 105)
(→ page 105)
27. MENU Button  
(→ page 62)
28. EXIT Button  
(→ page 62)

29. ▲▼◀▶ Button  
(→ page 62)
30. ENTER Button  
(→ page 62)
31. L-CLICK Button*  
(→ page 32)
32. R-CLICK Button*  
(→ page 32)
33. VOL./FOCUS (+)(−) Button  
(→ page 24)
34. D-ZOOM/ZOOM (+)(−) Button  
(→ page 28)
(“ZOOM” Button does not work on this series of projectors)
35. SHUTTER Button  
(not available on this series of projectors)
36. LENS SHIFT Button  
(not available on this series of projectors)
37. PICTURE Button  
(→ page 74, 76)
38. DISPLAY Button  
(→ page 85)
39. ASPECT Button  
(→ page 80)
40. COLOR Button  
(→ page 76)
41. 3D Set. Button  
(→ page 39)
42. SETUP Button  
(→ page 94)
43. CTL Button  
(→ page 31, 32)
44. ECO Button  
(→ page 29)
45. INFO Button  
(→ page 118)
46. HELP Button  
(→ page 118)

* The ▲▼◀▶, L-CLICK and R-CLICK buttons work only when a USB cable is connected with your computer.
Battery Installation

1. Press the catch and remove the battery cover.
2. Install new ones (AA). Ensure that you have the batteries’ polarity (+/−) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place.

NOTE: Do not mix different types of batteries or new and old batteries.

Remote Control Precautions

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/−) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.
The infrared signal operates by line-of-sight up to a distance of above meters and within a 60-degree angle of the remote sensor on the projector cabinet. The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.
2. Projecting an Image (Basic Operation)

This section describes how to turn on the projector and to project a picture onto the screen.

1. Flow of Projecting an Image

Step 1
- Connecting your computer / Connecting the power cord (→ page 13)

Step 2
- Turning on the projector (→ page 14)

Step 3
- Selecting a source (→ page 16)

Step 4
- Adjusting the picture size and position (→ page 18)
- Correcting keystone distortion [KEYSTONE] (→ page 33)

Step 5
- Adjusting a picture and sound
  - Optimizing a computer signal automatically (→ page 24)
  - Turning up or down volume (→ page 24)

Step 6
- Making a presentation

Step 7
- Turning off the projector (→ page 25)

Step 8
- After use (→ page 26)
2. Projecting an Image (Basic Operation)

2. Connecting Your Computer/Connecting the Power Cord

1. Connect your computer to the projector.
   This section will show you a basic connection to a computer. For information about other connections, see “(2) Making Connections” on page 125.

Connect the display output terminal (mini D-sub 15 pin) on the computer to the computer video input terminal on the projector with a commercially-available computer cable (with ferrite core) and then turn the knobs of the connectors to secure them.

2. Connect the supplied power cord to the projector.
   First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other plug of the supplied power cord in the wall outlet.
   Upon connecting the power cable, the POWER indicator of the projector will light up in orange. If there are no input signals, the device will go into the standby mode after about 10 seconds and light up in red*.
   The STATUS indicator will light off*.
   * This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator section. (→ page 173)

![Diagram of power cord connection]

CAUTION:
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation.
Use caution when picking up the projector.
2. Projecting an Image (Basic Operation)

3 Turning on the Projector

1. Remove the lens cap.

2. Press the (POWER) button on the projector cabinet or the POWER ON button on the remote control.

   The POWER indicator will light up in blue from red and then start blinking. After that, the image will be projected onto the screen.

   TIP:
   • When the message “PROJECTOR IS LOCKED! ENTER YOUR PASSWORD.” is displayed, it means that the [SECURITY] feature is turned on. (→ page 36)
   • When the ECO message is displayed, it means that [ON] is selected for [ECO MESSAGE]. (→ page 95)
   • Pressing buttons such as power button and MENU button will make sound. To turn off the beep sound, select [OFF] for [BEEP] from the menu. (→ page 106)

   After you turn on your projector, ensure that the computer or video source is turned on.

   NOTE: A blue screen (blue background) is displayed when no signal is being input (by factory default menu settings).
2. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 29 menu languages.

To select a menu language, follow these steps:

1. Use the ▲, ▼, ◀ or ▶ button to select one of the 29 languages from the menu.

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu operation.
If you want, you can select the menu language later. (→ [LANGUAGE] on page 66 and 94)

NOTE:
• During projection, after shutting down the power supply (direct power off), wait for about 1 minute or longer before turning on the power again.
• Keep the lens cap off the lens while the projector’s power is on.
  If the lens cap is on, it could be warped due to high temperature.
• If one of the following things happens, the projector will not turn on.
  - If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool down.
  - When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
  - If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. Cancel the lock by turning it off. (→ page 104)
  - If the lamp fails to light, and if the LAMP indicator flashes on and off in a cycle of six times, wait a full minute and then turn on the power.
• While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
• Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is stabilized.
• When the projector is turned on, it may take some time before the lamp light becomes bright.
• If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without displaying an image for some time and then the projector will display the image.
Selecting a Source
Selecting the computer or video source

NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the INPUT button for 1 second or longer. The projector will search for the available input source and display it. The input source will change as follows:

HDMI1 → HDMI2 → DisplayPort → BNC → BNC(CV) → BNC(Y/C) → COMPUTER → HDBaseT → HDMI1 → …

• Press it briefly to display the [INPUT] screen.

Using the Remote Control
Press any one of the 1/HDMI 1, 2/HDMI 2, 3/DisplayPort, 4/BNC, 5/ BNC(CV), 6/BNC(Y/C), 7/Computer, or 8/HDBaseT buttons.

TIP: If no input signal is present, the input will be skipped.
Selecting Default Source
You can set a source as the default source so that it will be displayed each time the projector is turned on.

1. **Press the MENU button.**
   The menu will be displayed.

2. **Press the ▶ button to select [SETUP] and press the ▼ button or the ENTER button to select [BASIC].**
3. **Press the ▶ button to select [SOURCE OPTIONS].**
4. **Press the ▼ button four times to select [DEFAULT INPUT SELECT] and press the ENTER button.**

![Menu Screen](image)

The [DEFAULT INPUT SELECT] screen will be displayed.

5. **Select a source as the default source, and press the ENTER button.**
6. **Press the EXIT button a few times to close the menu.**
7. **Restart the projector.**
   The source you selected in step 5 will be projected.

**NOTE:** Even when [AUTO] is turned on, the [HDBaseT] will not be automatically selected. To set your network as the default source, select [HDBaseT].

**TIP:**
- When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER IN input will power on the projector and simultaneously project the computer's image. ([AUTO POWER ON SELECT] → page 115)
- On the Windows 7 keyboard, a combination of the Windows and P keys allows you to set up external display easily and quickly.
5 Adjusting the Picture Size and Position

Use the lens shift dial, the adjustable tilt foot lever, the zoom lever/zoom ring and the focus ring to adjust the picture size and position.

*In this chapter drawings and cables are omitted for clarity.*

**Adjusting the projected image’s vertical and horizontal position**

[Lens shift]  
(→ page 19)

**Finely adjusting the size of an image**

[Zoom lever/Zoom ring]  
(→ page 21, 23)

**Adjusting the focus**

[Focus ring]  
(→ page 20)

**Adjusting the projected image’s height and horizontal tilt**

[Tilt foot]  
(→ page 23)

---

**NOTE**:*¹: Adjust the projected image’s height using the tilt feet when you want to project the image at a position higher than the lens shift adjustment range.
2. Projecting an Image (Basic Operation)

Adjusting the vertical position of a projected image (Lens shift)

⚠️ CAUTION

Perform the adjustment from behind or from the side of the projector. Adjusting from the front could expose your eyes to strong light which could injure them.

- **Turn the lens shift dials clockwise or counterclockwise.**

  Vertical dial
  Turn this clockwise or counterclockwise to adjust the projection position in the vertical direction. Approximate turning range: About 6 turns counterclockwise, about 2 turns clockwise when the lens is at the center position.

  Horizontal dial
  Turn this clockwise or counterclockwise to adjust the projection position in the horizontal direction. Approximate turning range: About 1 turn counterclockwise, about 1 turn clockwise when the lens is at the center position.

  **NOTE:**
  - The dials can be turned more than one full turn, but the projection position cannot be moved more than the range indicated on the following page.
  - If the lens is shifted to the maximum in the diagonal direction, the edges of the screen will be dark or shaded.
  - The vertical shift adjustment must be finished with an image shifted upward. If you finish the vertical shift adjustment with an image shifted down, the zoom/focus adjustments or strong shaking may cause a projected image to slightly shift down.
  - The lens shift function cannot be used when using the separately sold NP11FL lens.
**TIP:**
- The diagram below shows the lens shift adjustment range for the PA622U and PA522U (projection mode: desktop front). To raise the projection position higher than this, use the tilt feet. (→ page 23)
- For the PA672W/PA572W/PA722X/PA622X and the ceiling mount/front projection lens shift adjustment range, see page 162, 163.

Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).

**Focus**
Applicable lens: NP12ZL/NP13ZL/NP14ZL/NP15ZL
Use the FOCUS ring to obtain the best focus.
2. Projecting an Image (Basic Operation)

Applicable lens: NP30ZL

The NP30ZL lens unit aligns the peripheral focus around the optical axis.

1. Turn the focus ring left and right to align the focus around the optical axis.
   * The diagram shows an example when the lens shift is moved to the top. The top of the screen is adjusted. When the lens is in the center, the center of the screen is adjusted.

2. Turn the peripheral focus ring to the left and right to align the focus of the overall screen.
   At this point, the focus around the optical axis adjusted in (1) remains unchanged.
2. Projecting an Image (Basic Operation)

Applicable lens: NP11FL
With the NP11FL lens, adjust the focus and picture distortion.

Preparations:
Turn the lens shift dials (vertical and horizontal) on the projector to return the lens shift to the center.

Approximate lens center position (explained here for the desktop front projection mode)

- Horizontal dial........ First turn the dial to the left edge, then turn it further so that the knob is horizontal.
  - From this position, turn the dial 1 full turn clockwise.
- Vertical dial......... First turn the dial to the bottom edge, then turn it further so that the knob is horizontal.
  - From this position, turn the dial 2 full turns counterclockwise.

1. Turn the distortion ring to the left edge.

2. Turn the focus lever clockwise and counterclockwise to adjust the focus at the center of the screen.

3. Use the distortion ring to correct the screen’s distortion.
   (This also brings the edges of the screen into focus.)

4. Use the focus lever to adjust the screen’s overall focus.
   * If the focus at the center of the screen is off, turn the distortion ring a little counterclockwise. The focus at the center of the screen can now be adjusted with the focus lever.
2. Projecting an Image (Basic Operation)

Adjusting the Tilt Feet

1. **Turn the left and right tilt feet to adjust.**

   The tilt feet lengthen and shorten when turned.

   The height of the projected image is adjusted by turning the left and right tilt feet.

   If the projected image is tilted, turn one of the tilt feet to adjust the image so that it is level.

   • If the projected image is distorted, see “3-6 Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]” (→ page 33) and “[GEOMETRIC CORRECTION]” (→ page 87).

   • The tilt feet can be lengthened by a maximum of 20 mm.

   • The tilt feet can be used to tilt the projector by a maximum of 4°.

**NOTE:**

• Do not lengthen the tilt feet any more than 20 mm/0.8”. Doing so will make the tilt feet’s mount section unstable and could cause the tilt feet to come off the projector.

• Do not use the tilt feet for any purpose other than adjusting the projector’s projection angle.

Handling the tilt feet improperly, such as carrying the projector by grasping the tilt feet or hooking it onto a wall using the tilt feet, could damage the projec- tor.
2. Projecting an Image (Basic Operation)

6 Optimizing Computer Signal Automatically

Adjusting the Image Using Auto Adjust

Optimizing a computer image automatically. (COMPUTER/BNC(Analog RGB))
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

![Poor picture]

![Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
• If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] manually. (→ page 78, 79)

7 Turning Up or Down Volume

Sound level from the speaker can be adjusted.

![Volume adjustment]

TIP: When no menus appear, the ◀ and ▶ buttons on the projector cabinet work as a volume control.

NOTE:
• Volume control is not available with the ◀ or ▶ button when an image is enlarged by using the D-ZOOM (+) button or when the menu is displayed.
2. Projecting an Image (Basic Operation)

8 Turning off the Projector

To turn off the projector:

1. **First, press the (POWER) button on the projector cabinet or the POWER OFF button on the remote control.**
   
   The [POWER OFF / ARE YOU SURE ? / CARBON SAVINGS- SESSION 0.000[g-CO2]] message will appear.

   ![Power Off Message]

2. **Secondly, press the ENTER button or press the (POWER) or the POWER OFF button again.**
   
   The lamp will go off and the power supply will be cut. At this point, if there are no input signals, the projector will go into the standby mode after about 10 seconds. When in standby mode, the POWER indicator will light red and the STATUS indicator will light off when [NORMAL] is selected for [STANDBY MODE].

   ![Power Indicator]

   **CAUTION:**
   
   Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Use caution when picking up the projector.

   ![Power Indicator]

   **NOTE:**
   
   • While the POWER indicator is blinking blue in short cycles, the power cannot be turned off.
   
   • You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
   
   • Do not unplug the power cord from the projector or from the power outlet while an image is being projected. Doing so could deteriorate the projector’s AC input connector or the power plug’s contact. To turn off the AC power while an image is being projected, use the power strip’s switch, the breaker, etc.
   
   • Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing the menu. Doing so can cause loss of adjustments and settings.
2. Projecting an Image (Basic Operation)

9 After Use
Preparation: Make sure that the projector is turned off.

1. Unplug the power cord.

2. Disconnect any other cables.

3. Mount the lens cap on the lens.

4. Before moving the projector, screw in the tilt feet if they have been lengthened.
3. Convenient Features

1 Turning off the Image and Sound

The projected video and the output sound from the internal speaker and sound output terminal will disappear momentarily.

Press the BLANK button.
The projected video will be cut off.

Press the MUTE button.
The projected audio will be cut off.

Press the AV-MUTE button.
The projected video and audio will be cut off.

- Press the buttons one more time for the cancelled video and audio to appear again.
  When AV-MUTE and BLANK are continued for some time, the energy-saving function will activate to lower the lamp power.

**NOTE:**
- When the AV-MUTE and BLANK buttons are pressed immediately after the energy-saving function is activated, sometimes the brightness may not return to normal immediately.

**TIP:**
- The video will disappear but not the menu display.
3. Convenient Features

② Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume motion.

NOTE: The image is frozen but the original video is still playing back.

③ Enlarging a Picture
You can enlarge the picture up to four times.

NOTE: The maximum magnification may be less than four times depending on the signal.

To do so:

1. Press the D-ZOOM (+) button to magnify the picture.

2. Press the ▲▼◄► button.
The area of the magnified image will be moved

3. Press the D-ZOOM (−) button.
Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE:
• The image will be enlarged or reduced at the center of the screen.
• Displaying the menu will cancel the current magnification.
3. Convenient Features

Changing Eco Mode/Checking Energy-Saving Effect Using Eco Mode [ECO MODE]

This feature enables you to select two brightness modes of the lamp: OFF and ON modes. The lamp life can be extended by turning on the [ECO MODE].

<table>
<thead>
<tr>
<th>[ECO MODE]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OFF]</td>
<td>This is the default setting (100% Brightness).</td>
</tr>
<tr>
<td>[ON]</td>
<td>Low lamp power consumption (approx. 80% Brightness).</td>
</tr>
</tbody>
</table>

To turn on the [ECO MODE], do the following:

1. **Press the ECO button on the remote control to display [ECO MODE] screen.**
2. **Use the ▲ or ▼ button to select [ON].**
3. **Press the ENTER button.**

To change from [ON] to [OFF], Go back to Step 2 and select [OFF]. Repeat Step 3.

**NOTE:**
- The [ECO MODE] can be changed by using the menu.
  Select [SETUP] → [INSTALLATION] → [LAMP MODE] → [ECO MODE].
- The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].
- [ECO MODE] is always set to [OFF] for 1 minute immediately after the lamp is turned on. The lamp condition will not be affected even when [ECO MODE] is changed.
- After a lapse of 1 minute from when the projector displays a blue, black or logo screen, [ECO MODE] will automatically switch to [ON].
- If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [ON] mode to protect the projector. This is called “Forced ECO Mode”. When the projector is in the Forced Eco Mode, the picture brightness decreases slightly and the TEMP. indicator lights orange. At the same time the Thermometer symbol [▼] is displayed at the bottom right of the screen.
  When the projector comes back to normal temperature, the Forced Eco Mode is cancelled and the [ECO MODE] returns to [OFF] mode.
3. Convenient Features

Checking Energy-Saving Effect [CARBON METER]
This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector's [ECO MODE] is set to [OFF], or [ON]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON SAVINGS] message shows the total amount of CO₂ emission reduction from the time of shipment up to now. You can check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 118)

The [CARBON SAVINGS-SESSION] message shows the amount of CO₂ emission reduction between the time of changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE ?] message at the time of power-off.

TIP:
• The formula as shown below is used to calculate the amount of CO₂ emission reduction.
  \[
  \text{Amount of CO}_2 \text{ emission reduction} = (\text{Power consumption in OFF for ECO MODE} - \text{Power consumption in ON for ECO MODE}) \times \text{CO}_2 \text{ conversion factor}.*
  \]
  When the image is turned off with the AV-MUTE button the amount of CO₂ emmission reduction will also increase.
  
  * Calculation for amount of CO₂ emission reduction is based on an OECD publication “CO₂ Emissions from Fuel Combustion, 2008 Edition”.

• The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
• This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
3. Convenient Features

6 Using the Optional Remote Mouse Receiver (NP01MR)

The optional remote mouse receiver enables you to operate your computer’s mouse functions from the remote control. It is a great convenience for clicking through your computer-generated presentations.

Connecting the remote mouse receiver to your computer

If you wish to use the remote mouse function, connect the mouse receiver and computer. The mouse receiver can be connected directly to the computer’s USB port (type A).

NOTE: Depending on the type of connection or OS installed on your computer, you may have to restart your computer or change your computer settings.

When operating a computer via the remote mouse receiver

When connecting using the USB terminal

For PC, the mouse receiver can only be used with a Windows XP*, Windows Vista, Windows 7, or Mac OS X 10.0.0 or later operating system.

* NOTE: In SP1 or older version of Windows XP, if the mouse cursor will not move correctly, do the following:
Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer Options tab].

NOTE: When using PowerPoint for Mac OS, the CTL button and the page ▼/▲ buttons (page up and down) on the remote control will be disabled.

NOTE: Wait at least 5 seconds after disconnecting the mouse receiver before reconnecting it and vice versa. The computer may not identify the mouse receiver if it is repeatedly connected and disconnected in rapid intervals.
3. Convenient Features

Operating your computer’s mouse from the remote control
You can operate your computer’s mouse from the remote control.

CTL Button + PAGE ▼/▲ Button
............................................. scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint on your computer.

▲▼◀▶ Buttons.... moves the mouse cursor on your computer.
L-CLICK Button....... works as the mouse left button.
R-CLICK Button ...... works as the mouse right button.

NOTE:
- When you operate the computer using the ▲▼◀ or ▶ button with the menu displayed, both the menu and the mouse pointer will be affected. Close the menu and perform the mouse operation.
- When using PowerPoint for Mac OS, the CTL button and the page ▼/▲ buttons (page up and down) on the remote control will be disabled.

About Drag Mode:
By pressing the L-CLICK or R-CLICK button for 2 or 3 seconds then releasing, the drag mode is set and the drag operation can be performed simply by pressing the ▲▼◀▶ button. To drop the item, press the L-CLICK (or R-CLICK) button. To cancel it, press the R-CLICK (or L-CLICK) button.

TIP: You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user documentation or online help supplied with your computer.
3. Convenient Features

6. Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]

Use the [CORNERSTONE] feature to correct keystone (trapezoidal) distortion to make the top or bottom and the left or right side of the screen longer or shorter so that the projected image is rectangular.

1. **Press and hold the Geometric button for a minimum of 2 seconds to reset current adjustments.**
   
   Current adjustments for [GEOMETRIC CORRECTION] will be cleared.

2. **Project an image so that the screen is smaller than the area of the raster.**

3. **Pick up any one of the corners and align the corner of the image with a corner of the screen.**

4. **Press the Geometric button.**

![Projected image diagram]

The drawing shows the upper right corner.

Display the [GEOMETRIC CORRECTION] screen of the on-screen menu.
5. Press the ▼ button to align with the [CORNERSTONE] and then press the ENTER button.

The drawing shows the upper left icon (▼) is selected.

The screen will switch to the [CORNERSTONE] screen.

NOTE:
• When a [GEOMETRIC CORRECTION] function other than [CORNERSTONE] has been set up, the [CORNERSTONE] screen will not be displayed. When the screen is not displayed, either press the Geometric button for 2 or more seconds, or run [RESET] in [GEOMETRIC CORRECTION] to clear the adjustment value of [GEOMETRIC CORRECTION].

6. Use the ▲▼◀▶ button to select one icon (▲) which points in the direction you wish to move the projected image frame.
7. Press the ENTER button.
8. Use the ▲▼◀▶ button to move the projected image frame as shown on the example.

9. Press the ENTER button.
10. Use the ▲▼◀▶ button to select another icon which points in the direction.

On the [CORNERSTONE] screen, select [EXIT] or press the EXIT button on the remote control.

The confirmation screen is displayed.
11. **Press the ◀ or ▶ button to highlight the [OK] and press the ENTER button.**
   
   This completes the [CORNERSTONE] correction.
   
   - Select [CANCEL] and press the ENTER button to return to the [CORNERSTONE] screen.
   
   Selecting [CANCEL] will return to the adjustment screen without saving changes (Step 3). Selecting [RESET] will return to the factory default. Selecting [UNDO] will exit without saving changes.

**NOTE:**

- Even when the projector is turned on, the last used correction values are applied.
- Carry out either one of the following actions to clear the adjustment value of [CORNERSTONE].
  - In Step 11, select [RESET] and then press the ENTER button.
  - Press the Geometric. button for 2 or more seconds.
  - Run [DISPLAY] → [GEOMETRIC CORRECTION] → [RESET] in the on-screen menu.
- Using CORNERSTONE correction can cause the image to be slightly blurred because the correction is made electronically.
3. Convenient Features

7 Preventing the Unauthorized Use of the Projector [SECURITY]

A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the projector cannot project an image.

- The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1. **Press the MENU button.**
   The menu will be displayed.

2. **Press the ▶ button twice to select [SETUP] and press the ▼ button or the ENTER button to select [MENU].**

3. **Press the ▶ button to select [CONTROL].**

4. **Press the ▼ button three times to select [SECURITY] and press the ENTER button.**

   ![Menu Screen](image)

   The OFF/ON menu will be displayed.

5. **Press the ▼ button to select [ON] and press the ENTER button.**

   ![Security Menu](image)

   The [SECURITY KEYWORD] screen will be displayed.

6. **Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.**

   **NOTE:** A keyword must be 4 to 10 digits in length.

   ![Security Key Screen](image)

   The [CONFIRM KEYWORD] screen will be displayed.

   **NOTE:** Make a note of your password and store it in a safe place.
3. Convenient Features

7. Type in the same combination of ▲▼ ◄► buttons and press the ENTER button.

The confirmation screen will be displayed.

8. Select [YES] and press the ENTER button.

The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1. Press the POWER button.
   The projector will be turned on and display a message to the effect that the projector is locked.

2. Press the MENU button.

3. Type in the correct keyword and press the ENTER button. The projector will display an image.

NOTE: The security disable mode is maintained until the main power is turned off or unplugging the power cord.
To disable the SECURITY function:

1. **Press the MENU button.**  
The menu will be displayed.

2. **Select [SETUP] → [CONTROL] → [SECURITY] and press the ENTER button.**

   ![Menu Screen]

   The OFF/ON menu will be displayed.

3. **Select [OFF] and press the ENTER button.**

   ![Security Off Screen]

   The SECURITY KEYWORD screen will be displayed.

4. **Type in your keyword and press the ENTER button.**  
   When the correct keyword is entered, the SECURITY function will be disabled.

   **NOTE:** If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] is a request code.
8 Projecting 3D videos
This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear. In order to synchronize the 3D video and eyewear, a commercially-available 3D emitter needs to be connected to the projector (on the projector side).
The 3D eyewear receives information from the 3D emitter and performs opening and closing on the left and right.

⚠️ CAUTION

Health precautions
Before use, please make sure to read any health precautions that may be stated in the operating manuals enclosed with the 3D eyewear and 3D video software (Blu-ray player, games, computer animation files, etc.).
Please take note of the following in order to avoid adverse health effects.
• Please do not use the 3D eyewear for purposes other than to watch 3D videos.
• Please keep a distance of at least 2 m away from the screen when watching videos. Watching a video too close to the screen will increase eye fatigue.
• Please do not watch videos continuously for a long period of time. Please take a 15 minutes' break after every hour of watching.
• Please consult a doctor before watching if you or any of your family members have a history of suffering from seizures caused by light sensitivity.
• Please stop watching immediately and take a rest when you feel physically unwell while watching (vomiting, giddiness, nausea, headaches, sore eyes, blurred vision, cramps and numbness in the limbs, etc.). Please consult a doctor if the symptoms persist.
• Please watch a 3D video directly in front of the screen. If you watch a 3D video obliquely from the sides, this may result in physical and eye fatigue.

3D eyewear and 3D emitter preparations
Please use an active shutter-type 3D eyewear that conforms with the VESA standard.
A commercially-available RF type made by Xpand is recommended.

3D eyewear............ Xpand X105-RF
3D emitter Xpand... AD025-RF-X1

Procedure to watch 3D videos using this projector
1. Connect the video device to the projector.
2. Switch on the power supply to the projector.
3. Run the 3D video software and project the video using the projector.
   This has been automatically set up when shipped from the factory. When a 3D video cannot be projected, it may be because the 3D detection signals are not included or because they are not detectable by the projector.
   Please manually select the format.
4. Select the 3D video format.
   (1) Press the “3D Set.” button on the remote control.
3. Convenient Features

The [3D SETTINGS] screen will be displayed.

(2) Press the ▼ button to align the cursor with the [FORMAT] and press the ENTER button.

The format screen will be displayed.

(3) Select the input signal format using the ▼ button and then press the ENTER button.

![FORMAT Menu]

The 3D settings screen will disappear and the 3D video will be projected.

Press the MENU button and the on-screen menu will disappear.

The 3D caution message screen will be displayed when switching to a 3D video (default factory setting when shipped). Please read the “Health Precautions” on the previous page to watch videos in the correct manner. The screen will disappear after 60 seconds or when the ENTER button is pressed. (→ page 95)

5. Turn on the power supply of the 3D eyewear and wear the eyewear to watch the video.

A normal video will be shown when a 2D video is input.

To watch a 3D video in 2D, select [OFF(2D)] in the [FORMAT] screen mentioned above in (3).

NOTE:

- Upon switching to 3D image, the following functions will be cancelled and disabled. [BLANKING], [PIP/PICTURE BY PICTURE], [GEOMETRIC CORRECTION], [EDGE BLENDING] ([GEOMETRIC CORRECTION] and [EDGE BLENDING] adjustment values will be maintained.)
- The output may not automatically switch to a 3D video depending on the 3D input signal.
- Check the operating conditions described in the user manual of the Blu-ray player.
- Please connect the DIN terminal of the 3D emitter to the 3D SYNC of the main projector.
- The 3D eyewear allows videos to be viewed in 3D by receiving synchronized optical signals output from the 3D emitter. As a result, the 3D image quality may be affected by conditions such as the brightness of the surroundings, screen size, viewing distance, etc.
- When playing a 3D video software on a computer, the 3D image quality may be affected if the computer CPU and graphics chip performance are low. Please check the required operating environment of the computer that is stated in the operating manual attached to the 3D video software.
- Depending on the signal, [FORMAT] and [L/R INVERT] may not be able to be selected. Please change the signal in that case.
### When videos cannot be viewed in 3D

Please check the following points when videos cannot be viewed in 3D. Please also read the operating manual attached to the 3D eyewear.

<table>
<thead>
<tr>
<th>Possible reasons</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The selected signal does not support 3D output.</td>
<td>Please change the video signal input to one that supports 3D.</td>
</tr>
<tr>
<td>The format for the selected signal is turned to [OFF(2D)].</td>
<td>Please change the format in the on-screen menu to [AUTO] or a format that supports 3D.</td>
</tr>
<tr>
<td>An eyewear that is not supported by the projector is being used.</td>
<td>Please purchase a commercially-available 3D eyewear or 3D emitter (recommended). (→ page 39)</td>
</tr>
<tr>
<td>Please check the following points when a video cannot be viewed in 3D using a 3D eyewear that is supported by the projector.</td>
<td></td>
</tr>
<tr>
<td>The power supply of the 3D eyewear is turned off.</td>
<td>Please turn on the power supply of the 3D eyewear.</td>
</tr>
<tr>
<td>The internal battery of the 3D eyewear is flat.</td>
<td>Please charge or replace the battery.</td>
</tr>
<tr>
<td>The viewer is located too far away from the screen.</td>
<td>Please get closer to the screen until the video can be seen in 3D.</td>
</tr>
<tr>
<td>Due to multiple 3D projectors working at the same time in the vicinity, the projectors may interfere with one another. Alternatively, there may be a bright light source near the screen.</td>
<td>Please maintain sufficient distance between the projectors. Please keep the light source away from the screen. Please turn the L/R INVERT in the on-screen menu to [OFF].</td>
</tr>
<tr>
<td>There is an obstacle between the optical receiver of the 3D eyewear and the 3D emitter.</td>
<td>Please remove the obstacle.</td>
</tr>
<tr>
<td>The 3D format of the 3D video contents is not supported.</td>
<td>Please check with the company selling the 3D video contents.</td>
</tr>
</tbody>
</table>
3. Convenient Features

9 Controlling the Projector by Using an HTTP Browser

Overview
The HTTP Server function provides settings and operations for:

1. Setting for wired network (NETWORK SETTINGS)
   To use wired LAN connection, connect the projector to the computer with a commercially available LAN cable. (→ page 137)

2. Setting Alert Mail (ALERT MAIL)
   When the projector is connected to a wired network, lamp replace time or error messages will be sent via e-mail.

3. Operating the projector
   Power on/off, selecting input, volume control and picture adjustments are possible.

4. Setting PJLink PASSWORD and AMX BEACON

Access to the HTTP server function is available:

- Start the Web browser on the computer via the network connected to the projector and enter the following URL:
  http://<the projector’s IP address> /index.html

TIP: The factory setting IP address is [DHCP ON].

NOTE:
- To use the projector in a network, consult with your network administrator about network settings.
- The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your network.
  Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projector.
- If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web browser (or clear the cache).
- This projector uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting method will vary depending on the version of browser. Please refer to the help files and the other information provided in your software.

Preparation before Use
Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 137)
Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
3. Convenient Features

Handling of the Address for Operation via a Browser

Regarding the actual address that is entered for the address or entered to the URL column when operation of the projector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the projector has been registered to the domain name server by a network administrator, or the host name corresponding to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network setting by specifying

http://pj.nec.co.jp/index.html

for the address or the entry column of the URL.

Example 2: When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by specifying

http://192.168.73.1/index.html

for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.

ON ........................... Power is switched on.
OFF .......................... Power is switched off.

VOLUME: This controls the volume of the projector.

▲ ............................. Increases the volume adjustment value.
▼ ............................. Decreases the volume adjustment value.

AV-MUTE: This controls the mute function of the projector.

PICTURE ON ............... Mutes the video.
PICTURE OFF .............. Cancels the video muting.
SOUND ON ................. Mutes the audio.
SOUND OFF ............... Cancels the audio muting.
ALL ON ..................... Mutes each of the video, and audio functions.
ALL OFF .................... Cancels the muting of each of the video, and audio functions.
3. Convenient Features

PICTURE: Controls the video adjustment of the projector.

- BRIGHTNESS ▲ .... Increases the brightness adjustment value.
- BRIGHTNESS ▼ .... Decreases the brightness adjustment value.
- CONTRAST ▲ .... Increases the contrast adjustment value.
- CONTRAST ▼ .... Decreases the contrast adjustment value.
- COLOR ▲ .... Increases the color adjustment value.
- COLOR ▼ .... Decreases the color adjustment value.
- HUE ▲ .... Increases the hue adjustment value.
- HUE ▼ .... Decreases the hue adjustment value.
- SHARPNESS ▲ .... Increases the sharpness adjustment value.
- SHARPNESS ▼ .... Decreases the sharpness adjustment value.

- The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 76, 77)

SOURCE SELECT: This switches the input connector of the projector.

- HDMI1 .... Switches to the HDMI 1 IN connector.
- HDMI2 .... Switches to the HDMI 2 IN connector.
- DisplayPort .... Switches to the DisplayPort.
- BNC .... Switch to BNC (analog RGB) video input.
- BNC(CV) .... Switch to BNC (CV) video input.
- BNC(Y/C) .... Switch to BNC (Y/C) video input.
- COMPUTER .... Switches to the COMPUTER IN connector.
- HDBaseT .... Switch to image input sent from a transmission device that supports HDBaseT.

PROJECTOR STATUS: This displays the condition of the projector.

- LAMP LIFE REMAINING .... Displays the remaining life of the lamp as a percentage.
- LAMP HOURS USED .... Displays how many hours the lamp has been used.
- FILTER HOURS USED .... Displays how many hours the filter has been used.
- ERROR STATUS .... Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
### NETWORK SETTINGS

#### SETTINGS

<table>
<thead>
<tr>
<th>WIRED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SETTING</td>
<td>Set for wired LAN.</td>
</tr>
<tr>
<td>APPLY</td>
<td>Apply your settings to wired LAN.</td>
</tr>
<tr>
<td>PROFILE 1/PROFILE 2</td>
<td>Two settings can be set for wired LAN connection. Select PROFILE 1 or PROFILE 2.</td>
</tr>
<tr>
<td>DISABLE</td>
<td>Turn off wired LAN connection</td>
</tr>
<tr>
<td>DHCP ON</td>
<td>Automatically assign IP address, subnet mask, and gateway to the projector from your DHCP server.</td>
</tr>
<tr>
<td>DHCP OFF</td>
<td>Set IP address, subnet mask, and gateway to the projector assigned by your network administrator.</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of the network connected to the projector.</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector.</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector.</td>
</tr>
<tr>
<td>AUTO DNS ON</td>
<td>DHCP server will automatically assign IP address of DNS server connected to the projector.</td>
</tr>
<tr>
<td>AUTO DNS OFF</td>
<td>Set your IP address of DNS server connected to the projector.</td>
</tr>
</tbody>
</table>
### 3. Convenient Features

#### NAME

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROJECTOR NAME</td>
<td>Enter a name for your projector so that your computer can identify the projector. A projector name must be 16 characters or less. TIP: Projector name will not be affected even when [RESET] is done from the menu.</td>
</tr>
<tr>
<td>HOST NAME</td>
<td>Enter the hostname of the network connected to the projector. A host name must be 15 or less.</td>
</tr>
<tr>
<td>DOMAIN NAME</td>
<td>Enter the domain name of the network connected to the projector. A domain name must be 60 characters or less.</td>
</tr>
</tbody>
</table>

#### ALERT MAIL

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALERT MAIL</td>
<td>This option will notify your computer of lamp replace time or error messages via e-mail when using wired LAN. Placing a checkmark will turn on the Alert Mail feature. Clearing a checkmark will turn off the Alert Mail feature. Sample of a message to be sent from the projector: The lamp and filters are at the end of its usable life. Please replace the lamp and filters. Projector Name: NEC Projector Lamp Hours Used: 100 [H]</td>
</tr>
<tr>
<td>SENDER'S ADDRESS</td>
<td>Enter sender's address.</td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td>Enter the SMTP server name to be connected to the projector.</td>
</tr>
<tr>
<td>RECIPIENT'S ADDRESS 1, 2, 3</td>
<td>Enter your recipient's address. Up to three addresses can be entered.</td>
</tr>
<tr>
<td>TEST MAIL</td>
<td>Send a test mail to check whether your settings are correct or not</td>
</tr>
<tr>
<td></td>
<td>NOTE:</td>
</tr>
<tr>
<td></td>
<td>• If you execute a test, you may not receive an Alert mail. Should this happen, check if network settings are correct.</td>
</tr>
<tr>
<td></td>
<td>• If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient's Address is correct.</td>
</tr>
<tr>
<td>SAVE</td>
<td>Click this button to save your settings to the projector's memory.</td>
</tr>
</tbody>
</table>

46
### 3. Convenient Features

**NETWORK SERVICE**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PJLink PASSWORD</td>
<td>Set a password for PJLink*. A password must be 32 characters or less. Do not forget your password. However, if you forget your password, consult with your dealer.</td>
</tr>
<tr>
<td>HTTP PASSWORD</td>
<td>Set a password for HTTP server. A password must be 10 characters or less. When a password is set up, you will be prompted for your user name (arbitrary) and password during LOGON.</td>
</tr>
<tr>
<td>AMX BEACON</td>
<td>Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX’s NetLinx control system. <strong>TIP:</strong> When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server. Placing a checkmark will enable detecting the projector from AMX Device Discovery. Clearing a checkmark will disable detecting the projector from AMX Device Discovery.</td>
</tr>
</tbody>
</table>

*What is PJLink?*

PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005. The projector supports all the commands of PJLink Class 1. Setting of PJLink will not be affected even when [RESET] is done from the menu.

**INFORMATION**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRED LAN</td>
<td>Display a list of settings of wired LAN connection.</td>
</tr>
<tr>
<td>UPDATE</td>
<td>Reflect settings when they are changed.</td>
</tr>
</tbody>
</table>

**NOTE:** If you forget your password, contact your dealer.
4. Multi-Screen Projection

Things that can be done using multi-screen projection
This projector can be used singly or arranged in multiple units for multi-screen projection. We will introduce an example using two projection screens here.

Case 1
Using a single projector to project two types of videos at the same time
[PIP/PICTURE BY PICTURE]

Case 2
Using four projectors (liquid crystal panel: XGA) to project video with a resolution of $1920 \times 1080$ pixels[ TILING]

Case 1. Using a single projector to project two types of videos [PIP/PICTURE BY PICTURE]

Connection example and projection image

On-screen menu operations
Display [DISPLAY] → [PIP/PICTURE BY PICTURE] → [MODE] screen in the on-screen menu and select [PIP] or [PICTURE BY PICTURE].
For details, please refer to “4-2 Displaying Two Pictures at the Same Time”. (→ page 52)
Case 2. Using four projectors (liquid crystal panel: XGA) to project videos with a resolution of 1920 × 1080 pixels [TILING]

Connection example and projection image

On-screen menu operations

1 Four similar videos are displayed when four projectors are projected.

Please request the retail store to adjust the projection position of each projector.
4. Multi-Screen Projection

2 Operate the on-screen menu using the four respective projectors to divide the image into four portions. Display [DISPLAY] → [MULTI SCREEN] → [PICTURE SETTING] Screen in the on-screen menu and select [TILING].

(1) In the screen for setting the number of horizontal units, select [2 UNITS]. (number of units in the horizontal direction)
(2) In the screen for setting the number of vertical units, select [2 UNITS]. (number of units in the vertical direction)
(3) In the screen for setting the horizontal order, select [1st UNIT] or [2nd UNIT].
   (look at the screens, the one on the left is the [1st UNIT] while the one on the right is the [2nd UNIT])
(4) In the screen for setting the vertical order, select the [1st UNIT] or the [2nd UNIT].
   (look at the screens, the one at the top is the [1st UNIT] while the one at the bottom is the [2nd UNIT])

3 Adjust the lens shift of each projector to fine-tune the boundaries of the screen.
   For further fine-tuning, adjust using [DISPLAY] → [EDGE BLENDING] in the on-screen menu for each projector.
   For details, please refer to “4-3 Displaying a Picture Using [EDGE BLENDING]”.
   (→ page 56)
4. Multi-Screen Projection

**Things to note when installing projectors**

- Leave sufficient space on the left and right of the projector so that the air intake and discharge outlets of the projector are not obstructed. When the air intake and discharge outlet are obstructed, the temperature inside the projector will rise and this may result in a malfunction.

- Please do not pile up the projectors directly on top of one another when installing them. When the projectors are piled up on top of one another, they may fall down, resulting in damage and failure.

- Installation example when using two projectors
  The following installation is recommended when combining the installation of two projectors for multi-screen projection. Please leave a space of at least 10 cm between the air intake/discharge outlet and the wall.

[Installation example]

![Installation example diagram]

---

**WARNING**

Please request the retail store for special installation services such as when mounting the projector to the ceiling. Never carry out the installation by yourself. The projector may fall down and result in injury. Please use a sturdy cabinet that can withstand the weight of the projector for the installation. Please do not pile up the projectors directly on top of one another.

---

**NOTE:**

- For the range of the projection distance, please refer to the Appendix “Throw distance and screen size”. (→ page 158)
Displaying Two Pictures at the Same Time

The projector has a feature that allows you to view two different signals simultaneously. You have two modes: PIP mode and PICTURE BY PICTURE mode.

The projection video in the first screen display is known as the main display while the projection video that is called out subsequently is known as the sub-display.

Select the projection function under [DISPLAY] → [PIP/PICTURE BY PICTURE] → [MODE] in the on-screen menu (the default factory setting when shipped is PIP). (→ page 85)

- A single screen is projected when power is turned on.

Picture in Picture function

A small sub-display is displayed inside the main display.

The sub-display can be set up and adjusted as follows. (→ page 86)
- Select whether to display the sub-display at the top right, top left, bottom right or bottom left of the screen (the size of the sub-display can be selected and the position can be fine-tuned)
- Switch the main display with the sub-display

Picture by picture function

Display the main display and sub-display side by side.

The main display and sub-display can be set up and adjusted as follows. (→ page 86)
- Selecting the display boundary (ratio) of the main display and sub-display
- Switch the main display and sub-display

Input terminals that can be used for the main screen and sub-screen.

The main screen and sub-screen can provide the following input terminals.
- The main display and sub-display support computer signals up to WUXGA@60HzRB.

<table>
<thead>
<tr>
<th>Sub-Display or additional display</th>
<th>HDMI1</th>
<th>HDMI2</th>
<th>DisplayPort</th>
<th>BNC</th>
<th>BNC(CV)</th>
<th>BNC(Y/C)</th>
<th>COMPUTER</th>
<th>HDBaseT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Display</td>
<td></td>
<td></td>
<td></td>
<td>BNC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI1</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>HDMI2</td>
<td>No</td>
<td></td>
<td></td>
<td>BNC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DisplayPort</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>BNC</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNC(CV)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BNC(Y/C)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>COMPUTER</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDBaseT</td>
<td>No</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

NOTE:
- Some signals may not appear depending on the resolution.
4. Multi-Screen Projection

Projecting two screens

1. Press the MENU button to display the on-screen menu and select [DISPLAY] → [PIP/PICTURE BY PICTURE].

   ![PIP/PICTURE BY PICTURE menu](image)

   This displays the [PIP/PICTURE BY PICTURE] screen in the on-screen menu.

2. Select [SUB INPUT] using the ▼/▲ buttons, and press the ENTER button.

   This displays the [SUB INPUT] screen.

3. Select the input signal using the ▼/▲ buttons, and press the ENTER button.

   ![SUB INPUT menu](image)

   The [PIP] (PICTURE IN PICTURE) or [PICTURE BY PICTURE] screen set up under [MODE] is projected. (→ page 85)
   - When the signal name is displayed in grey, this means that it cannot be selected.
   - The signal can also be selected by pressing the PIP button or PBP/POP button on the remote control.

4. Press the MENU button.

   The on-screen menu will disappear.

5. When returning to single screen, display the [PIP/PICTURE BY PICTURE] screen one more time and select [OFF] in the [SUB INPUT] screen of the Step 3.

TIP:
- During dual-screen projection, if the selected input is not supported by the sub-screen, the sub-screen will appear as a black screen.
4. Multi-Screen Projection

Switching the main display with the sub-display and vice versa

1. Press the MENU button to display the on-screen menu and select [DISPLAY] → [PIP/PICTURE BY PICTURE].

   ![On-screen menu interface]

   This displays the [PIP/PICTURE BY PICTURE] screen in the on-screen menu.

2. Select [PICTURE SWAP] using the ▼/▲ buttons and then press the ENTER button.
   Display the screen for switching the display positions.

3. Select [ON] using the ▼ button and then press the ENTER button.

   ![PIP/PICTURE BY PICTURE screen]

   The video of the main display will switch with that of the sub-display.

   ![Video switching diagram]

   The signal output from the HDMI output terminal does not change even if the display positions are switched.

4. Press the menu button.
   The on-screen menu will disappear.
Restrictions

• The following operations are enabled only for the main display.
  • Audio-visual adjustments
  • Video magnification / compression using the partial D-ZOOM/ZOOM +/- buttons.
    However, magnification / compression is up to the positions set in [PICTURE BY PICTURE BORDER] only.
  • TEST PATTERN

• The following operations are enabled for both the main display and sub-display. These operations cannot be applied individually.
  • Momentary deletion of video / audio
  • Video pause

• [PIP/PICTURE BY PICTURE] cannot be used when a 3D video is being displayed.
• When using the [PIP/PICTURE BY PICTURE] function, [CLOSED CAPTION] and [DYNAMIC CONTRAST] can be used.
• [PIP/PICTURE BY PICTURE] cannot be used when the signal input has a resolution of 1920 × 1200 or more.
• The HDMI output terminal has a repeater function. The output resolution is limited by the maximum resolution of the connected monitor and projector.
Displaying a Picture Using [EDGE BLENDING]

A high resolution video can be projected on an even bigger screen by combining multiple projectors on the left, right, top and bottom. This projector is equipped with an “EDGE BLENDING Function” that makes the edges (boundaries) of the projection screen indistinguishable.

NOTE:
• For projector throw distances, refer to “Throw distance and screen size” on page 158.
• Before performing the Edge Blending function, place the projector in the correct position so that the image becomes square in the appropriate size, and then make optical adjustments (lens shift, focus, and zoom).
• Adjust the brightness of each projector using [LAMP ADJUST] under [LAMP MODE]. In addition, use [REF. WHITE BALANCE] to adjust the [CONTRA스트], [BRIGHTNESS] and [UNIFORMITY].

Before explaining use of the Edge Blending function

This section explains the case for “Example: Placing two projectors side by side”. As shown, the projected image on the left is referred to as “Projector A” and the projected image on the right is referred to “Projector B”. Unless otherwise specified hereinafter, the “projector” is used to mean both A and B.

Example: Placing two projectors side by side
Preparation:
• Turn on the projector and display a signal.
• When performing settings or adjustments using the remote control, enable the [CONTROL ID] so as not to activate the other projectors. (→ page 105)

Setting the overlap of projection screens
① Enable [EDGE BLENDING].

1 Press the “Edge Blend.” button.
The [EDGE BLENDING] screen will be displayed. Align the cursor with [MODE] and then press the ENTER button. The mode screen will be displayed.

2 Select [MODE] → [ON] and press the ENTER button.

This enables the Edge Blending function. The following menu items are available: [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL]

3 Select [RIGHT] for Projector A and [LEFT] for Projector B.
Press the ENTER button.

The following items are available:
[CONTROL], [MARKER], [RANGE], and [POSITION]
Select [CONTROL] → [ON] and press the ENTER button.

Each [TOP], [BOTTOM], [LEFT], [RIGHT], and [BLACK LEVEL] has its own [CONTROL], [MARKER], [RANGE], and [POSITION].

- For Projector A, set the [CONTROL] for the [TOP], [LEFT], and [BOTTOM] to [OFF]. Similarly for Projector B, set the [CONTROL] for the [TOP], [RIGHT] and [BOTTOM] to [OFF].

Adjust [RANGE] and [POSITION] to determine an area of overlapped edges of images projected from each projector.

Turning on [MARKER] will display markers in magenta and green. The magenta marker is used for [RANGE] and green one for [POSITION].

* The 2 screens are separated in the diagram for explanatory purposes.
4. Multi-Screen Projection

1 Adjust [RANGE].
   Use the ◀ or ▶ button to adjust the overlapped area.

   ![RANGE Adjust](image)

   TIP:
   • Adjust to overlap one projector’s marker with the other projector’s marker.

2 Adjust [POSITION].
   Use the ◀ or ▶ button to align one edge with the other edge of overlapped images.

   ![POSITION Adjust](image)

   TIP:
   • When displaying a signal with a different resolution, perform the Edge Blending function from the start.
   • Setting of [MARKER] will not be saved and return to [OFF] when the projector is turned off.
   • To display or hide the marker while the projector is running, turn on or off [MARKER] from the menu.
**4. Multi-Screen Projection**

**Black Level Adjustment**

This adjusts the black level of the overlapping area and the non-overlapping area of the multi-screen (EDGE BLENDING). Adjust the brightness level if you feel the difference is too large.

**NOTE:**
This function is enabled only when [MODE] is turned on. Adjustable area varies depending on what combination of [TOP], [BOTTOM], [LEFT] and [RIGHT] are turned on.

Example: Adjusting the Black Level when placing two projectors side by side

1. **Turn on [MODE]**
2. **Select [BLACK LEVEL] and press the ENTER button.**
   The screen will switch to the black level adjustment screen.

3. **Use the ▼ or ▲ button to select an item and use the ◀ or ▶ to adjust the black level.**
   Do this for the other projector if necessary.
9-segmented portions for Black Level adjustment

The center projector

This function adjusts the brightness level of 9-segmented portions for the center projector and 4-segmented portions for the left bottom projector as shown below.

TIP:
- The number of black level division screens (maximum of nine divisions) changes depending on the number of edge blending positions selected (top, bottom, right, left). In addition, when the top / bottom and left / right ends are selected, the corner division screen appears.
- The edge blending width is the width set in the range and the corner is formed by the intersecting area of the top / bottom ends or left / right ends.
- The [BLACK LEVEL] can be adjusted to make it brighter only.
5. Using On-Screen Menu

1. **Using the Menus**

   **NOTE:** The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

   1. Press the MENU button on the remote control or the projector cabinet to display the menu.

   ![Menu Screen]

   **NOTE:** The commands such as ENTER, EXIT, ▲▼, ◀▶ in the bottom show available buttons for your operation.

   2. Press the ◀▶ buttons on the remote control or the projector cabinet to display the submenu.

   3. Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first tab.

   4. Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or set.

      You can use the ◀▶ buttons on the remote control or the projector cabinet to select the tab you want.

   5. Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

   6. Adjust the level or turn the selected item on or off by using the ▲▼ ◀▶ buttons on the remote control or the projector cabinet.

      Changes are stored until adjusted again.

   7. Repeat steps 2-6 to adjust an additional item, or press the EXIT button on the remote control or the projector cabinet to quit the menu display.

      **NOTE:** When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

   8. Press the MENU button to close the menu.

      To return to the previous menu, press the EXIT button.
Menu Elements

Menu windows or dialog boxes typically have the following elements:

- **Highlight**: Indicates the selected menu or item.
- **Solid triangle**: Indicates further choices are available. A highlighted triangle indicates the item is active.
- **Tab**: Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
- **Radio button**: Use this round button to select an option in a dialog box.
- **Source**: Indicates the currently selected source.
- **Menu mode**: Indicates the current menu mode: BASIC or ADVANCED.
- **Off Timer remaining time**: Indicates the remaining countdown time when the [OFF TIMER] is preset.
- **Slide bar**: Indicates settings or the direction of adjustment.
- **ECO mode symbol**: Indicates [ECO MODE] is set.
- **Key Lock symbol**: Indicates the [CONTROL PANEL LOCK] is enabled.
- **Thermometer symbol**: Indicates the [ECO MODE] is forcibly set to [ON] mode because the internal temperature is too high.
- **High Altitude symbol**: Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
### List of Menu Items

Some menu items are not available depending on the input source.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td></td>
</tr>
<tr>
<td>1:HDMI1</td>
<td>*</td>
</tr>
<tr>
<td>2:HDMI2</td>
<td>*</td>
</tr>
<tr>
<td>3:DisplayPort</td>
<td></td>
</tr>
<tr>
<td>4:8NC</td>
<td>*</td>
</tr>
<tr>
<td>5:8NC(CV)</td>
<td>*</td>
</tr>
<tr>
<td>6:8NC(Y/C)</td>
<td>*</td>
</tr>
<tr>
<td>7:COMPUTER</td>
<td></td>
</tr>
<tr>
<td>8:HDBaseT</td>
<td></td>
</tr>
<tr>
<td>ENTRY LIST</td>
<td></td>
</tr>
<tr>
<td>TEST PATTERN</td>
<td></td>
</tr>
<tr>
<td>MODE</td>
<td>STANDARD</td>
</tr>
<tr>
<td>PRESET</td>
<td>STANDARD, PROFESSIONAL</td>
</tr>
<tr>
<td>GENERAL</td>
<td></td>
</tr>
<tr>
<td>REFERENCE</td>
<td></td>
</tr>
<tr>
<td>GAMMA CORRECTION</td>
<td></td>
</tr>
<tr>
<td>SCREEN SIZE</td>
<td></td>
</tr>
<tr>
<td>COLOR TEMPERATURE</td>
<td></td>
</tr>
<tr>
<td>DYNAMIC CONTRAST</td>
<td></td>
</tr>
<tr>
<td>WHITE BALANCE</td>
<td></td>
</tr>
<tr>
<td>CONTRAST R</td>
<td>0</td>
</tr>
<tr>
<td>CONTRAST G</td>
<td>0</td>
</tr>
<tr>
<td>CONTRAST B</td>
<td>0</td>
</tr>
<tr>
<td>BRIGHTNESS R</td>
<td>0</td>
</tr>
<tr>
<td>BRIGHTNESS G</td>
<td>0</td>
</tr>
<tr>
<td>BRIGHTNESS B</td>
<td>0</td>
</tr>
<tr>
<td>COLOR CORRECTION</td>
<td></td>
</tr>
<tr>
<td>RED</td>
<td>0</td>
</tr>
<tr>
<td>GREEN</td>
<td>0</td>
</tr>
<tr>
<td>BLUE</td>
<td>0</td>
</tr>
<tr>
<td>YELLOW</td>
<td>0</td>
</tr>
<tr>
<td>MAGENTA</td>
<td>0</td>
</tr>
<tr>
<td>CYAN</td>
<td>0</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>50</td>
</tr>
<tr>
<td>BRIGHTNESS</td>
<td>50</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>10</td>
</tr>
<tr>
<td>COLOR</td>
<td>50</td>
</tr>
<tr>
<td>HUE</td>
<td>0</td>
</tr>
<tr>
<td>INPUT RESOLUTION</td>
<td></td>
</tr>
<tr>
<td>VIDEO</td>
<td></td>
</tr>
<tr>
<td>NOISE REDUCTION</td>
<td>RANDOM NR</td>
</tr>
<tr>
<td>MOSQUITO NR</td>
<td>OFF, LOW, MEDIUM, HIGH</td>
</tr>
<tr>
<td>BLOCK NR</td>
<td>OFF, LOW, MEDIUM, HIGH</td>
</tr>
<tr>
<td>DEINTERLACE</td>
<td>NORMAL, MOVIE, STILL</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>AUTO</td>
</tr>
<tr>
<td>ENHANCEMENT</td>
<td>OFF, AUTO, NORMAL</td>
</tr>
<tr>
<td>SIGNAL TYPE</td>
<td>AUTO, RGB, COMPONENT</td>
</tr>
<tr>
<td>VIDEO LEVEL</td>
<td>AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td>3D SETTINGS</td>
<td></td>
</tr>
<tr>
<td>STEREOPEN</td>
<td>SINGLE</td>
</tr>
<tr>
<td>FILTERS</td>
<td>SINGLE</td>
</tr>
<tr>
<td>FORMAT</td>
<td>AUTO</td>
</tr>
<tr>
<td>L/R INVERT</td>
<td>OFF, ON</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.
1 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].
2 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
3 When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], the [COLOR TEMPERATURE] is not available.
### 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SUB INPUT</strong></td>
<td>OFF, HDMI1, HDMI2, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, HDBaseT</td>
<td></td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td>PIP, PICTURE BY PICTURE</td>
<td></td>
</tr>
<tr>
<td><strong>PICTURE SWAP</strong></td>
<td>OFF, OFF, ON</td>
<td></td>
</tr>
<tr>
<td><strong>PIP SETTING</strong></td>
<td>START POSITION</td>
<td>TOP-LEFT, TOP-RIGHT, BOTTOM-LEFT, BOTTOM-RIGHT</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL POSITION</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VERTICAL POSITION</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SIZE</td>
<td>LARGE, MEDIUM, SMALL</td>
</tr>
<tr>
<td><strong>BORDER</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>KEYSTONE</strong></td>
<td>HORIZONTAL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VERTICAL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TILT</td>
<td></td>
</tr>
<tr>
<td><strong>CORNERSTONE</strong></td>
<td>TOP-LEFT, TOP, TOP-RIGHT, LEFT, RIGHT, BOTTOM-LEFT, BOTTOM, BOTTOM-RIGHT</td>
<td></td>
</tr>
<tr>
<td><strong>HORIZONTAL CORNER</strong></td>
<td>TOP-LEFT, TOP, TOP-RIGHT, LEFT, RIGHT, BOTTOM-LEFT, BOTTOM, BOTTOM-RIGHT</td>
<td></td>
</tr>
<tr>
<td><strong>VERTICAL CORNER</strong></td>
<td>TOP-LEFT, TOP-RIGHT, LEFT, RIGHT, BOTTOM-LEFT, BOTTOM, BOTTOM-RIGHT</td>
<td></td>
</tr>
<tr>
<td><strong>PINCUSHION</strong></td>
<td>TOP, BOTTOM, LEFT, RIGHT</td>
<td></td>
</tr>
<tr>
<td><strong>PC TOOL</strong></td>
<td>OFF, OFF, 1, 2, 3</td>
<td></td>
</tr>
<tr>
<td><strong>RESET</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DISPLAY</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>EDGE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>BLENDING</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MULTI SCREEN</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WHITE BALANCE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PICTURE SETTING</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td>OFF, OFF, ON</td>
<td></td>
</tr>
<tr>
<td><strong>CONTRAST</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONTRAST W</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONTRAST R</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONTRAST G</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONTRAST B</td>
<td></td>
</tr>
<tr>
<td><strong>BRIGHTNESS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>BRIGHTNESS W</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BRIGHTNESS R</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BRIGHTNESS G</td>
<td></td>
</tr>
<tr>
<td><strong>ZOOM</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WIDTH</strong></td>
<td>1 UNIT, 2 UNITS, 3 UNITS, 4 UNITS</td>
<td></td>
</tr>
<tr>
<td><strong>HEIGHT</strong></td>
<td>1 UNIT, 2 UNITS, 3 UNITS, 4 UNITS</td>
<td></td>
</tr>
<tr>
<td><strong>HORIZONTAL POSITION</strong></td>
<td>1st UNIT, 2nd UNIT, 3rd UNIT, 4th UNIT</td>
<td></td>
</tr>
<tr>
<td><strong>VERTICAL POSITION</strong></td>
<td>1st UNIT, 2nd UNIT, 3rd UNIT, 4th UNIT</td>
<td></td>
</tr>
</tbody>
</table>
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LANGUAGE</strong></td>
<td>ENGLISH</td>
<td>ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, 日本語, DANSK, PORTUGUÉS, ČEŠTINA, MAGYAR, POLSKI, NEDERLANDS, SUOMI, NORSK, TÜRKÇE, РУССКИЙ, Ελληνικά, 中文, 한국어, ROMANA, HRVATSKA, ŽILINSKA, INDONESIA, हिन्दी, ไทย, 繁體中文</td>
</tr>
<tr>
<td><strong>COLOR SELECT</strong></td>
<td>COLOR</td>
<td>COLOR, MONOCHROME</td>
</tr>
<tr>
<td><strong>INPUT DISPLAY</strong></td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>MESSAGE DISPLAY</strong></td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>ID DISPLAY</strong></td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>ECO MESSAGE</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>3D CAUTION MESSAGE</strong></td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>DISPLAY TIME</strong></td>
<td>AUTO 45 SEC</td>
<td>MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC</td>
</tr>
<tr>
<td><strong>FILTER MESSAGE</strong></td>
<td>OFF</td>
<td>OFF, 100[H], 500[H], 1000[H], 2000[H]</td>
</tr>
<tr>
<td><strong>ORIENTATION</strong></td>
<td>AUTO</td>
<td>AUTO, DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING FRONT</td>
</tr>
<tr>
<td><strong>SCREEN TYPE</strong></td>
<td>FREE</td>
<td>FREE, 4:3 SCREEN, 16:9 SCREEN, 16:10 SCREEN</td>
</tr>
<tr>
<td><strong>WALL COLOR</strong></td>
<td>OFF</td>
<td>OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD (GRAY), LIGHT YELLOW, LIGHT GREEN, LIGHT BLUE, SKY BLUE, LIGHT ROSE, PINK</td>
</tr>
<tr>
<td><strong>FAN MODE</strong></td>
<td>OFF</td>
<td>AUTO, HIGH, HIGH ALTITUDE</td>
</tr>
<tr>
<td><strong>LAMP MODE</strong></td>
<td>ECO MODE</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>REF. WHITE BALANCE</strong></td>
<td>LAMP ADJUST</td>
<td>CONTRAST R, CONTRAST G, CONTRAST B, BRIGHTNESS R, BRIGHTNESS G, BRIGHTNESS B, UNIFORMITY R, UNIFORMITY B</td>
</tr>
<tr>
<td><strong>STATIC CONVERGENCE</strong></td>
<td>HORIZONTAL R, HORIZONTAL G, HORIZONTAL B, VERTICAL R, VERTICAL G, VERTICAL B</td>
<td></td>
</tr>
</tbody>
</table>
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ADMINISTRATOR MODE</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu Mode</td>
<td>ADVANCED</td>
<td>ADVANCED, BASIC</td>
</tr>
<tr>
<td>Not Save Setting Values</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>New Password</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Confirm Password</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PROGRAM TIMER</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Active</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Day</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function</td>
<td>POWER, INPUT</td>
<td>ECO MODE</td>
</tr>
<tr>
<td>Advanced Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Input</td>
<td>HDMI1, HDMI2, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, HDBaseT</td>
<td></td>
</tr>
<tr>
<td>Eco Mode</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Repeate</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>DATE AND TIME SETTINGS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date and Time Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>MM/DD/YYYY</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>HH:MM</td>
<td></td>
</tr>
<tr>
<td>Internet Time Server</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>IP Address</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SUMMER TIME SETTINGS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>Mon(Start)</td>
<td>1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12</td>
<td></td>
</tr>
<tr>
<td>Day(Start)</td>
<td>FIRST WEEK, SECOND WEEK, THIRD WEEK, FOURTH WEEK, LAST WEEK</td>
<td></td>
</tr>
<tr>
<td>Time(Start)</td>
<td>SUN, MON, TUE, WED, THU, FRI, SAT</td>
<td></td>
</tr>
<tr>
<td>Mon(Exit)</td>
<td>1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12</td>
<td></td>
</tr>
<tr>
<td>Day(Exit)</td>
<td>FIRST WEEK, SECOND WEEK, THIRD WEEK, FOURTH WEEK, LAST WEEK</td>
<td></td>
</tr>
<tr>
<td>Time(Exit)</td>
<td>SUN, MON, TUE, WED, THU, FRI, SAT</td>
<td></td>
</tr>
<tr>
<td>Time Difference</td>
<td>+01:00, +00:30, -00:30, -01:00</td>
<td></td>
</tr>
<tr>
<td><strong>MOUSE</strong></td>
<td></td>
<td>(Note) Cannot be used for this device.</td>
</tr>
<tr>
<td>Control Panel Lock</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Security</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Communication Speed</td>
<td>38400bps</td>
<td>4800bps, 9600bps, 19200bps, 38400bps, 115200bps</td>
</tr>
<tr>
<td>Control ID</td>
<td>CONTROL ID NUMBER</td>
<td>1, 254</td>
</tr>
<tr>
<td>Control ID</td>
<td>CONTROL ID</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>Remote Sensor</td>
<td>FRONT/BACK</td>
<td>FRONT/BACK, FRONT, BACK, HDBase-T</td>
</tr>
<tr>
<td>BEEP</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
</tbody>
</table>
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SETUP</strong></td>
<td></td>
</tr>
<tr>
<td><strong>NETWORK</strong></td>
<td></td>
</tr>
<tr>
<td><strong>WIRED LAN</strong></td>
<td></td>
</tr>
<tr>
<td>PROFILES</td>
<td>DISABLE, PROFILE 1, PROFILE 2</td>
</tr>
<tr>
<td>DHCP</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>192.168.0.10</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>AUTO DNS</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>DNS CONFIGURATION</td>
<td>RECONNECT</td>
</tr>
<tr>
<td>PROJECOT NAME</td>
<td>PROJECTOR NAME PA622U Series</td>
</tr>
<tr>
<td>DOMAIN</td>
<td>HOST NAME</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:tJane@nec.com">tJane@nec.com</a></td>
</tr>
<tr>
<td>ALERT MAIL</td>
<td></td>
</tr>
<tr>
<td>ALERT MAIL NAME</td>
<td>PROJECTOR NAME PA622U Series</td>
</tr>
<tr>
<td>SMTP SERVER</td>
<td></td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td></td>
</tr>
<tr>
<td>RECIPIENT 1</td>
<td></td>
</tr>
<tr>
<td>RECIPIENT 2</td>
<td></td>
</tr>
<tr>
<td>RECIPIENT 3</td>
<td></td>
</tr>
<tr>
<td>TEST MAIL</td>
<td></td>
</tr>
<tr>
<td>NETWORK SERVICE</td>
<td></td>
</tr>
<tr>
<td>HTTP</td>
<td>NEW PASSWORD</td>
</tr>
<tr>
<td>HTTP SERVER</td>
<td></td>
</tr>
<tr>
<td>HTTP SERVER NAME</td>
<td></td>
</tr>
<tr>
<td>PJLink</td>
<td></td>
</tr>
<tr>
<td>PJLink NEW PASSWORD</td>
<td>CONFIRM PASSWORD</td>
</tr>
<tr>
<td>PJLink SMTP SERVER NAME</td>
<td>CONFIRM PASSWORD</td>
</tr>
<tr>
<td>PJLink SENDER'S ADDRESS</td>
<td></td>
</tr>
<tr>
<td>PJLink RECPIENT'S ADDRESS 1</td>
<td></td>
</tr>
<tr>
<td>PJLink RECPIENT'S ADDRESS 2</td>
<td></td>
</tr>
<tr>
<td>PJLink RECPIENT'S ADDRESS 3</td>
<td></td>
</tr>
<tr>
<td>AMX BEACON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>SOURCE OPTIONS</strong></td>
<td></td>
</tr>
<tr>
<td>AUTO ADJUST</td>
<td>NORMAL, OFF, NORMAL, FINE</td>
</tr>
<tr>
<td>COLOR SYSTEM</td>
<td>AUTO ADJUST</td>
</tr>
<tr>
<td>BNC(VIDEO)</td>
<td>AUTO, NTSC3.58, NTSC4.3, PAL, PAL-M, PAL-N, PAL60, SECAM</td>
</tr>
<tr>
<td>BNC(Y/C)</td>
<td>AUTO, NTSC3.58, NTSC4.3, PAL, PAL-M, PAL-N, PAL60, SECAM</td>
</tr>
<tr>
<td>AUDIO SELECT</td>
<td>AUTO ADJUST</td>
</tr>
<tr>
<td>HDMI1</td>
<td>HDMI1, HDMI2, BNC</td>
</tr>
<tr>
<td>HDMI2</td>
<td>HDMI2, BNC</td>
</tr>
<tr>
<td>DisplayPort</td>
<td>DisplayPort, BNC</td>
</tr>
<tr>
<td>HDBaseT</td>
<td>HDBaseT, BNC</td>
</tr>
<tr>
<td>DEFAULT INPUT SELECT</td>
<td>LAST, AUTO, HDMI1, HDMI2, DisplayPort, BNC, BNC(Y/C), COMPUTER, HDBaseT</td>
</tr>
<tr>
<td>SEAMLESS SWITCHING</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>CLOSED CAPTION</td>
<td>OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, TEXT1, TEXT2, TEXT3, TEXT4</td>
</tr>
<tr>
<td>BACKGROUND</td>
<td>BLUE, BLACK, LOGO</td>
</tr>
<tr>
<td>POWER OPTIONS</td>
<td></td>
</tr>
<tr>
<td>STANDBY MODE</td>
<td>NORMAL, OFF, NORMAL, HDBaseT STANDBY</td>
</tr>
<tr>
<td>DIRECT POWER ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>AUTO POWER ON SELECT</td>
<td>OFF, HDMI1, HDMI2, DisplayPort, COMPUTER, HDBaseT</td>
</tr>
<tr>
<td>AUTO POWER OFF</td>
<td>1:00, OFF, 0:05, 0:10, 0:15, 0:20, 0:30, 1:00</td>
</tr>
<tr>
<td>OFF TIMER</td>
<td>OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00</td>
</tr>
<tr>
<td><strong>RESET</strong></td>
<td></td>
</tr>
<tr>
<td>CURRENT SIGNAL</td>
<td>ALL DATA</td>
</tr>
<tr>
<td>ALL DATA</td>
<td>ALL DATA (INCLUDING ENTRY LIST)</td>
</tr>
<tr>
<td>CLEAR LAMP HOURS</td>
<td>CLEAR LAMP HOURS</td>
</tr>
<tr>
<td>CLEAR FILTER HOURS</td>
<td>CLEAR FILTER HOURS</td>
</tr>
</tbody>
</table>
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USAGE TIME</strong></td>
<td>LAMP LIFE REMAINING, LAMP HOURS USED, FILTER HOURS USED, TOTAL CARBON SAVINGS</td>
</tr>
<tr>
<td><strong>SOURCE(1)</strong></td>
<td>INPUT TERMINAL, RESOLUTION, HORIZONTAL FREQUENCY, VERTICAL FREQUENCY, SYNC TYPE, SYNC POLARITY, SCAN TYPE, SOURCE NAME, ENTRY NO.</td>
</tr>
<tr>
<td><strong>SOURCE(2)</strong></td>
<td>SIGNAL TYPE, VIDEO TYPE, BIT DEPTH, VIDEO LEVEL, LINK RATE, LINK LANE, 3D FORMAT</td>
</tr>
<tr>
<td><strong>INFO.</strong></td>
<td>WIRED LAN, IP ADDRESS, SUBNET MASK, GATEWAY, MAC ADDRESS</td>
</tr>
<tr>
<td><strong>VERSION(1)</strong></td>
<td>FIRMWARE, DATA, SUB-CPU</td>
</tr>
<tr>
<td><strong>OTHERS</strong></td>
<td>OTHERS, DATE TIME, PROJECTOR NAME, MODEL NO, SERIAL NUMBER, CONTROL ID (when [CONTROL ID] is set)</td>
</tr>
<tr>
<td><strong>CONDITIONS</strong></td>
<td>INTAKE TEMPERATURE, EXHAUST TEMPERATURE, INSTALLATION POSITION, X-AXIS, Y-AXIS, Z-AXIS</td>
</tr>
<tr>
<td><strong>HDBaseT</strong></td>
<td>SIGNAL QUALITY, OPERATION MODE, LINK STATUS, HDMI STATUS</td>
</tr>
</tbody>
</table>
### Menu Descriptions & Functions [INPUT]

#### 1: HDMI1
This projects the video of the device connected to the HDMI 1 IN terminal.

#### 2: HDMI2
This projects the video of the device connected to the HDMI 2 IN terminal.

#### 3: DisplayPort
This projects the video of the device connected to the Display Port input terminal.

#### 4: BNC
This projects the video of the device connected to the video input terminal.
(This projects the analog RGB signal or component signal.)

#### 5: BNC(CV)
This projects the video of the device connected to the BNC (CV) video input terminal.
(This projects the composite video signal.)

#### 6: BNC(Y/C)
This projects the video of the device connected to the BNC (Y/C) video input terminal.
(This projects the S-video signal.)

#### 7: COMPUTER
This projects the video of the device connected to the computer video input terminal.
(This projects the analog RGB signal or component signal.)

#### 8: HDBaseT
Projecting the HDBaseT or WIRED LAN signal.

**ENTRY LIST**
Displays a list of signals. See the following pages.

**TEST PATTERN**
Closes the menu and switches to the test pattern screen.
Using the Entry List

When any source adjustments are made, the adjustments are automatically registered in the Entry List. The (adjustment values of) registered signals can be loaded from the Entry List whenever necessary. However, only up to 100 patterns can be registered in the Entry List. When 100 patterns have been registered in the Entry List, an error message is then displayed and no additional patterns can be registered. You should thus delete (adjustment values of) signals that are no longer needed.

Displaying the Entry list

1. **Press the MENU button.**
   The menu will be displayed.

2. **Press the ▼ or ▶ button to select [INPUT].**
   The INPUT list will be displayed.

3. **Use the ◀, ▶, ▲, or ▼ to select [ENTRY LIST] and press the ENTER button.**
   The ENTRY LIST windows will be displayed.

   If the ENTRY LIST window is not displayed, switch the menu to [ADVANCED].

   To switch the menu between [ADVANCED] and [BASIC], select [SETUP] → [CONTROL] → [TOOLS] → [ADMINISTRATOR MODE] → [MENU MODE]. (→ page 99)
5. Using On-Screen Menu

Entering the currently projected signal into the Entry List [STORE]

1. Press the ▲ or ▼ button to select any number.

2. Press the ◄ or ► button to select [STORE] and press the ENTER button.

<table>
<thead>
<tr>
<th>NO.</th>
<th>SOURCE NAME</th>
<th>RESOLUTION</th>
<th>INPUT</th>
<th>LOCK</th>
<th>SKIP</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>1280x1024 60Hz</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>002</td>
<td>NTSC358</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>003</td>
<td>AAA</td>
<td>1024 x 768</td>
<td>HDMI1</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>004</td>
<td>004</td>
<td>1024 x 768</td>
<td>HDMI1</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>005</td>
<td>005</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>006</td>
<td>006</td>
<td>1024 x 768</td>
<td>HDMI1</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>007</td>
<td>007</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>008</td>
<td>008</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>009</td>
<td>009</td>
<td>1024 x 768</td>
<td>HDMI1</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>010</td>
<td>010</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>011</td>
<td>011</td>
<td>1024 x 768</td>
<td>BNC(CV)</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>012</td>
<td>012</td>
<td>1024 x 768</td>
<td>HDMI1</td>
<td>✔ ✔</td>
<td></td>
</tr>
<tr>
<td>013</td>
<td>013</td>
<td>1024 x 768</td>
<td>COMPUTER</td>
<td>✔ ✔</td>
<td></td>
</tr>
</tbody>
</table>

Calling up a signal from the Entry List [LOAD]

Press the ▲ or ▼ button to select a signal and press the ENTER button.

Editing a signal from the Entry List [EDIT]

1. Press the ▲ or ▼ button to select a signal you wish to edit.

2. Press the ◄, ►, ▲, or ▼ button to select [EDIT] and press the ENTER button.

The Edit window will be displayed.

<table>
<thead>
<tr>
<th>SOURCE NAME</th>
<th>Enter a signal name. Up to 18 alphanumeric characters can be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT</td>
<td>The input terminal can be changed. Switching between HDMI 1/HDMI 2/DisplayPort/BNC/BNC (CV)/BNC (Y/C)/Computer is possible.</td>
</tr>
<tr>
<td>LOCK</td>
<td>Set so that the selected signal cannot be deleted when [ALL DELETE] is executed. The changes made after LOCK execution cannot be saved.</td>
</tr>
<tr>
<td>SKIP</td>
<td>Set so that the selected signal will be skipped during auto search.</td>
</tr>
</tbody>
</table>

3. Set the above items and select [OK] and press the ENTER button.

NOTE: The input terminal cannot be changed to the currently projected signal.
5. Using On-Screen Menu

Cutting a signal from the Entry List [CUT]

1. Press the ▲ or ▼ button to select a signal you wish to delete.
2. Press the ◀, ▶, ▲, or ▼ button to select [CUT] and press the ENTER button.
   The signal will be deleted from the Entry List and the deleted signal will be displayed on the clipboard at the bottom of the Entry List.

NOTE:
• The currently projected signal cannot be deleted.
• When the locked signal is selected, it will be displayed in gray which indicates it is not available.

TIP:
• Data on the clipboard can be passed onto the Entry List.
• Data on the clipboard will not be lost after the Entry List is closed.

Copying and pasting a signal from the Entry List [COPY] / [PASTE]

1. Press the ▲ or ▼ button to select a signal you wish to copy.
2. Press the ◀, ▶, ▲, or ▼ button to select [COPY] and press the ENTER button.
   The copied signal will be displayed on the clipboard at the bottom of the Entry List.
3. Press the ◀ or ▶ button to move to the list.
4. Press the ▲ or ▼ button to select a signal.
5. Press the ◀, ▶, ▲, or ▼ button to select [PASTE] and press the ENTER button.
   Data on the clipboard will be pasted to the signal.

Deleting all the signals from the Entry List [ALL DELTE]

1. Press the ◀, ▶, ▲, or ▼ button to select [ALL DELETE] and press the ENTER button.
   The confirmation message will be displayed.
2. Press the ◀ or ▶ button to select [YES] and press the ENTER button.

NOTE: The locked signal cannot be deleted.
5. Using On-Screen Menu

5 Menu Descriptions & Functions [ADJUST]

[PICTURE]

[MODE]
This function allows you to determine how to save settings for [DETAIL SETTINGS] of [PRESET] for each input.

- STANDARD
  - Saves settings for each item of [PRESET] (Preset 1 through 7)
- PROFESSIONAL
  - Saves all the settings of [PICTURE] for each input.

**NOTE:**
- When [TEST PATTERN] is displayed, [MODE] cannot be selected.

[PRESET]
This function allows you to select optimized settings for your projected image. You can adjust neutral tint for yellow, cyan or magenta. There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set user adjustable settings to customize each gamma or color. Your settings can be stored in [PRESET 1] to [PRESET 7].

- HIGH-BRIGHT
  - Recommended for use in a brightly lit room.
- PRESENTATION
  - Recommended for making a presentation using a PowerPoint file.
- VIDEO
  - Recommended for typical TV program viewing.
- MOVIE
  - Recommended for movies.
- GRAPHIC
  - Recommended for graphics.
- sRGB
  - Standard color values
- DICOM SIM
  - Recommended for DICOM simulation format.

**NOTE:**
- The [DICOM SIM] option is for training/reference only and should not be used for actual diagnosis.
- DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiology (ACR) and the National Electrical Manufacturers Association (NEMA). The standard specifies how digital image data can be moved from system to system.
5. Using On-Screen Menu

[DETAIL SETTINGS]

Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7]. First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE].

- HIGH-BRIGHT .... Recommended for use in a brightly lit room.
- PRESENTATION ..... Recommended for making a presentation using a PowerPoint file.
- VIDEO ............... Recommended for typical TV program viewing.
- MOVIE .............. Recommended for movies.
- GRAPHIC ............ Recommended for graphics.
- sRGB ................. Standard color values.
- DICOM SIM. ........ Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:
- DYNAMIC ............ Creates a high-contrast picture.
- NATURAL ............. Natural reproduction of the picture.
- BLACK DETAIL ....... Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.
- LARGE .............. For screen size of 150"
- MEDIUM ............ For screen size of 100"
- SMALL .............. For screen size of 50"

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].
Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice. 
A value between 5000 K and 10500 K can be set in 100 K units.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
When set, the most optimal contrast ratio is adjusted according to the video.
OFF.................. Dynamic contrast is disabled.
MOTION IMAGE..... Most optimal settings for moving images.
STILL IMAGE........ Most optimal settings for static images. Rapidly follows any changes in the video.

NOTE:
• Depending on the conditions, projector settings such as [DYNAMIC CONTRAST] may not be able to be selected.

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; Brightness for each color (RGB) is used to adjust the black level of the screen.

[COLOR CORRECTION]
Corrects the color for all signals.
Adjusts the tone for the colors red, green, blue, yellow, magenta and cyan.

<table>
<thead>
<tr>
<th></th>
<th>RED</th>
<th>GREEN</th>
<th>BLUE</th>
<th>YELLOW</th>
<th>MAGENTA</th>
<th>CYAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>HUE</td>
<td>+ Direction</td>
<td>Magenta direction</td>
<td>+ Direction</td>
<td>Red direction</td>
<td>+ Direction</td>
<td>Green direction</td>
</tr>
<tr>
<td>- Direction</td>
<td>Yellow direction</td>
<td>- Direction</td>
<td>Cyan direction</td>
<td>- Direction</td>
<td>Red direction</td>
<td></td>
</tr>
<tr>
<td>SATURATION</td>
<td>+ Direction</td>
<td>Vivid</td>
<td>+ Direction</td>
<td>Vivid</td>
<td>+ Direction</td>
<td>Vivid</td>
</tr>
<tr>
<td></td>
<td>- Direction</td>
<td>Weak</td>
<td>- Direction</td>
<td>Weak</td>
<td>- Direction</td>
<td>Weak</td>
</tr>
</tbody>
</table>

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.
5. Using On-Screen Menu

(COLOR)
Increases or decreases the color saturation level.

(HUE)
Varies the color level from +/- green to +/- blue. The red level is used as reference.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>CONTRAST</th>
<th>BRIGHTNESS</th>
<th>SHARPNESS</th>
<th>COLOR</th>
<th>HUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB system of “COMPUTER/Display-Port/HDMI/HDBaseT”</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>COMPONENT system of “COMPUTER/DisplayPort/HDMI/HDBaseT”</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Composite Video/S-Video</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Yes = Adjustable, No = Not adjustable

NOTE:
• When [TEST PATTERN] is displayed, [CONTRAST], [BRIGHTNESS], [SHARPNESS], [COLOR] and [HUE] cannot be adjusted.

(RESET)
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected will not be reset.
5. Using On-Screen Menu

[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK ............... Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

PHASE ............... Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.) Use [PHASE] only after the [CLOCK] is complete.

NOTE: The [CLOCK] and [PHASE] items are available for RGB signals only.
5. Using On-Screen Menu

Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

- An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.
- The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, its adjustments will be called up and applied.

   To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] and reset the adjustments.

[BLANKING]
Adjusts the display range (blanking) at the top, bottom, left and right edges of the input signal.

Selecting Overscan Percentage [OVERSCAN]
Select overscan percentage (Auto, 0%, 5% and 10%) for signal.

NOTE:
- The [OVERSCAN] item is not available:
  - when [NATIVE] is selected for [ASPECT RATIO].
Selecting the Aspect Ratio [ASPECT RATIO]

Use this function to select the screen's vertical:horizontal aspect ratio. Select the screen type (4:3 screen, 16:9 screen or 16:10 screen) at the screen setting before setting the aspect ratio. (→ page 97)
The projector automatically identifies the signal being input and sets the optimum aspect ratio.

**For Computer signal**

![ASPECT RATIO](image)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 800</td>
</tr>
<tr>
<td>HD(FWXGA)</td>
<td>1366 × 768</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
</tr>
<tr>
<td>WUXGA+</td>
<td>1680 × 1050</td>
</tr>
<tr>
<td>FHD(1080P)</td>
<td>1920 × 1080</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200</td>
</tr>
<tr>
<td>WUXGA</td>
<td>2560 × 1600</td>
</tr>
</tbody>
</table>

**Options**

<table>
<thead>
<tr>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
</tr>
<tr>
<td>4:3</td>
</tr>
<tr>
<td>5:4</td>
</tr>
<tr>
<td>16:9</td>
</tr>
<tr>
<td>15:9</td>
</tr>
<tr>
<td>16:10</td>
</tr>
</tbody>
</table>

The projector will automatically determine the incoming signal and display it in its aspect ratio. The projector may erroneously determine the aspect ratio depending on its signal. If this occurs, select the appropriate aspect ratio from the following.

**For Component/Video/S-Video signals**

When the screen type is set to 4:3

![ASPECT RATIO](image)

When the screen type is set to 16:9 or 16:10

![ASPECT RATIO](image)
### 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Options</th>
<th>Function</th>
</tr>
</thead>
</table>
| NATIVE       | The projector displays the current image in its true resolution when the incoming computer signal has a lower or higher resolution than the projector's native resolution. *(→ page 2)*  
When the incoming computer signal has a higher resolution than the projector's native resolution, the center of an image will be displayed.  
![4:3](image) → ![4:3](image) |
| LETTER BOX   | The image of a letterbox signal (16:9) is stretched equally in the horizontal and vertical directions to fit the screen.                       
![LETTER BOX](image) → ![LETTER BOX](image) |
| WIDE SCREEN  | The image of a squeeze signal (16:9) is stretched left and right in 16:9.                                                                   
![Squeeze](image) → ![Squeeze](image) |
| ZOOM         | The image of a squeeze signal (16:9) is stretched left and right in 4:3. Parts of the displayed image are cropped at the left and right edges and therefore not visible.  
![Squeeze](image) → ![Squeeze](image) |
| FULL         | Project to full screen size.                                                                                                                                 |

**Tip:**
- Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
- The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect ratio for a video source.  
The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
- The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

**[INPUT RESOLUTION]**
The resolution is assigned automatically when the resolution of the input signal from the computer video input terminal or BNC video input terminal (analog RGB) cannot be distinguished.
Using Noise Reduction [NOISE REDUCTION]
When projecting a video image, you can use the [NOISE REDUCTION] function to reduce the screen noise (roughness and distortion). This device is equipped with three types of noise reduction functions. Select the function according to the type of noise. Depending on the noise level, the noise reduction effect can be set to [OFF], [LOW], [MEDIUM] or [HIGH]. [NOISE REDUCTION] can be selected for SDTV, HDTV signal and component signal input.

- RANDOM NR ....... Reduces flickering random noise in an image.
- MOSQUITO NR ...... Reduces mosquito noise that appears around the edges of an image during Blu-ray playback.
- BLOCK NR .......... Reduces block noise or mosaic-like patterns by selecting ON.

Selecting Interlaced Progressive Conversion Process Mode [DEINTERLACE]
This function allows you to select an interlaced-to-progressive conversion process for video signals.

- NORMAL............... Automatically distinguishes a moving image from a static image to create a distinct image. Please select [MOVIE] if there are any obvious jitter and noises.
- MOVIE ................ Select when projecting moving images. This is suitable for signals with a lot of jitter and noise.
- STILL .................. Select when projecting static images. The video will flicker when a moving image is projected.

NOTE: This function is not available with RGB signals.

[CONTRAST ENHANCEMENT]
Using the characteristics of the human eye, a picture quality with a sense of contrast and resolution is achieved.

- OFF .................. Suite vision is switched off.
- AUTO ................. Contrast and picture quality are automatically improved using the suite vision function.
- NORMAL .............. Adjust the gain manually.
[SIGNAL TYPE]
Selection of RGB and component signals. Normally, this is set to [AUTO]. Please change the setting if the color of the image remains unnatural.

  AUTO .................. Automatically distinguishes RGB and component signals.
  RGB .................... Switches to the RGB input.
  COMPONENT .......... Switches to the component signal input.

[VIDEO LEVEL]
Selection of the video signal level when connecting an external device to the HDMI 1 IN terminal, HDMI 2 IN terminal, DisplayPort input terminal, and HDBaseT input terminal of the projector.

  AUTO ................... The video level is switched automatically based on the information from the device outputting the signal.
  Depending on the connected device, this setting may not be made properly. In this case, switch to [NORMAL” or “ENHANCED” from the menu and view with the optimum setting.
  NORMAL............... This disables the enhanced mode.
  ENHANCED............. This improves the image’s contrast, expressing the dark and light sections more dynamically.
  SUPER WHITE ....... The video contrast is improved and the dark areas appear more dynamic.
[3D SETTINGS]

Please refer to “3-8 Projecting 3D videos” (→ page 39) for the operation.

STereo Viewer
Stack up a single or multiple projectors and carry out the settings for projecting 3D videos. Select the left / right settings of the 3D eyewear using the stereo viewer.

- SINGLE ................. Use a single projector to project 3D videos.
- DUAL LEFT .............. Use a dedicated projector for displaying videos on the left.
- DUAL RIGHT ............ Use a dedicated projector for displaying videos on the right.

Stereo Filter
Stack up a single or multiple projectors and carry out the settings for projecting 3D videos. Image setting for 3D glasses made by Infitec.

- SINGLE ................. Use a single projector to project 3D videos.
- DUAL LEFT .............. Use a dedicated projector for displaying videos on the left.
- DUAL RIGHT ............ Use a dedicated projector for displaying videos on the right.

Format
Select the 3D video format (recording / transmission format). Select to match the 3D broadcast and 3D media. Normally, [AUTO] is selected. Please select the 3D input signal format when the 3D detection signal of the format cannot be distinguished.

L/R Invert
Invert the display order of the left and right videos.
Select [ON] if you feel uncomfortable with the 3D display when [OFF] is selected.
5. Using On-Screen Menu

6 Menu Descriptions & Functions [DISPLAY]
[PIP/PICTURE BY PICTURE]

SUB INPUT
Select the input signal to be displayed in the sub-display.
Please refer to “4-2 Displaying Two Pictures at the Same Time” (→ page 52) for details on the operation.

MODE
Select either PIP or PICTURE BY PICTURE when switching to 2-screen display.

PICTURE SWAP
The videos in the main display and sub-display will be switched.
Please refer to “4-2 Displaying Two Pictures at the Same Time” (→ page 54) for details.

PIP SETTING
Select the display position, position adjustment and size of the sub-display in the PIP screen.

START POSITION... Selection of the display position of the sub-display when switching to the PIP screen.

HORIZONTAL POSITION
.......................... Adjust the display position of the sub-display in the horizontal direction. The respective corners will serve as reference points.

VERTICAL POSITION
.......................... Adjust the display position of the sub-display in the vertical direction. The respective corners will serve as reference points.

SIZE...................... Select the display size of the sub-display.
5. Using On-Screen Menu

TIP:
The horizontal position and vertical position are the amount of movement from the reference points. For example, when TOP-LEFT is adjusted, the position is displayed with the same amount of movement even if displayed with other starting positions. The maximum amount of movement is half the resolution of the projector.

BORDER
Select the display boundary of the main display and sub-display of the [PICTURE BY PICTURE] screen.

TIP:
- For PA622U/PA522U, six stages can be selected.
- For PA672W/PA572W/PA722X/PA622X, three stages can be selected.
5. Using On-Screen Menu

[GEOMETRIC CORRECTION]

Display the trapezoid correction screen and adjust the trapezoidal distortion of the projection screen. To display the [KEYSTONE] screen, select → [DISPLAY] → [GEOMETRIC CORRECTION] → [KEYSTONE] in the on-screen menu. The [GEOMETRIC CORRECTION] screen can also be displayed by pressing the Geometric. button on the remote control.

HORIZONTAL.... Adjustments when projecting from a diagonal direction to the screen.

VERTICAL .......... Adjustments when projecting from the top or bottom direction to the screen.

TILT ................. Adjusts the distortion when performing trapezoidal correction with the screen moved in the vertical direction using the lens shift.

THROW RATIO....... Adjusts according to the projection ratio of the optional lens used.

<table>
<thead>
<tr>
<th>Model name of lens unit</th>
<th>Adjustment range</th>
</tr>
</thead>
<tbody>
<tr>
<td>NP11FL</td>
<td>8</td>
</tr>
<tr>
<td>NP30ZL</td>
<td>8–10</td>
</tr>
<tr>
<td>NP12ZL</td>
<td>12–15</td>
</tr>
<tr>
<td>NP13ZL</td>
<td>15–30</td>
</tr>
<tr>
<td>NP14ZL</td>
<td>29–47</td>
</tr>
<tr>
<td>NP15ZL</td>
<td>46–71</td>
</tr>
</tbody>
</table>

NOTE:
- When power is supplied to the device, the adjustment value of the [KEYSTONE] used previously is retained even if the gradient of the device is changed.
- When clearing the adjustment value of [KEYSTONE], press the Geometric. button for 2 or more seconds.
- When setting other [GEOMETRIC CORRECTION] functions, the [KEYSTONE] menu cannot be selected. When performing trapezoidal correction, press the Geometric. button for 2 or more seconds to clear the adjustment value of [GEOMETRIC CORRECTION].
- As electrical correction is carried out by [KEYSTONE], the brightness may be reduced or the screen quality may deteriorate sometimes.
CORNERSTONE
Display the 4-point correction screen and adjust the trapezoidal distortion of the projection screen. Please refer to “Correcting Horizontal and Vertical Keystone Distortion [CORNERSTONE]” (→ page 33) for details on the operation.

HORIZONTAL CORNER/VERTICAL CORNER
Distortion correction for corner projection such as wall surfaces.

HORIZONTAL CORNER
Perform correction for projection onto a wall lying at an angle to the horizontal direction.

* Reverse angle correction is also possible.

VERTICAL CORNER
Perform correction for projection onto a wall lying at an angle to the vertical direction.

* Reverse angle correction is also possible.

NOTE:
• When the maximum adjustment range is exceeded, distortion adjustment is disabled. Set up the projector at an optimal angle as the deterioration in the image quality increases as the distortion adjustment volume gets larger.
• Please note that the image will go out of focus due to the difference in the distance between the upper and lower or left and right sides and the center of the screen for projections cutting across corners. Lenses with short focal points are also not recommended for projections cutting across corners as the image will go out of focus.
5. Using On-Screen Menu

Adjustment method
1. Align the cursor with the [HORIZONTAL CORNER] or [VERTICAL CORNER] of the [GEOMETRIC CORRECTION] menu and then press the ENTER button.
   • The adjustment screen will be displayed.
2. Press the ▼▲◂◆ buttons to align the cursor (yellow box) with the target adjustment point and then press the ENTER button.
   • The cursor will change into an adjustment point (yellow in color).
3. Press the ▼▲◂◆ buttons to adjust the corners or sides of the screen and then press the ENTER button.
   • The adjustment point will go back to being a cursor (yellow box).

Explanation of screen transition
• The adjustment points of the four corners (a, c, f and h in the drawing) will move independently.
• The following adjustment points differ at the [HORIZONTAL CORNER] and [VERTICAL CORNER].
  HORIZONTAL CORNER: When Point b in the drawing is moved, and the upper side and Point g are moved, the lower side will move in a parallel manner.
  VERTICAL CORNER: When Point d in the drawing is moved, and the left side and Point e are moved, the right side will move in a parallel manner.

[Adjustment points of the [HORIZONTAL CORNER] screen and movement points of the projection screen]

Point b will be displaced in a parallel manner at the same time as Points a, b, c

Point g will be displaced in a parallel manner at the same time as Points f, g, h

[Adjustment points of the [VERTICAL CORNER] screen and movement points of the projection screen]

Point d will be displaced in a parallel manner at the same time as Points a, d, f

Point e will be displaced in a parallel manner at the same time as Points f, g, h

4. Start from Step 2 onwards to adjust the other points.
5. When the adjustment is completed, press the ▼▲◂◆ buttons to align the cursor with the [EXIT] in the adjustment screen and then press the ENTER button.
   • Switch to the [GEOMETRIC CORRECTION] menu screen.
5. Using On-Screen Menu

PINCUSHION
Adjust the curve distortion of the projection screen.

- **TOP**................. Adjust the curve distortion of the upper edge of the projection screen.
- **BOTTOM**............. Adjust the curve distortion of the lower edge of the projection screen.
- **LEFT**.................. Adjust the curve distortion of the left edge of the projection screen.
- **RIGHT**............... Adjust the curve distortion of the right edge of the projection screen.

PC TOOL
Recall the geometric correction data that is registered in the projector beforehand. There are three types of registered data.

**NOTE:**
- KEYSSTONE, CORNERSTONE, and PINCUSHION cannot be selected when setting the geometric correction using a PC tool.
- To clear the [GEOMETRIC CORRECTION] data that has been set up, press the Geometric button for 2 or more seconds.
- As electrical correction is carried out in geometric correction, the brightness may be affected and the picture quality may be degraded.

RESET
Reset the adjustment value that has been set up in GEOMETRIC CORRECTION (return to the initial value).
This adjusts the edges (boundaries) of the projection screen when projecting high resolution videos using a combination of several projectors in the up, down, left and right positions.

**MODE**
This enables or disables the EDGE BLENDING function.
When MODE is set to ON, the TOP, BOTTOM, LEFT, RIGHT and BLACK LEVEL settings can be adjusted.

**TOP/BOTTOM/LEFT/RIGHT**
This selects the EDGE BLENDING locations on the left, right, top and bottom on the screen.
The following settings can be adjusted when an item is selected. (→ page 57)

- **CONTROL** ............... Enable TOP, BOTTOM, LEFT and RIGHT functions.
- **MARKER** ............... Set whether to display marker or not when adjusting the range and display position. When turned on, a magenta marker for adjusting the range adjustment and a green marker for adjusting the display position will be displayed.
- **RANGE** ................ Adjust the range (width) of the edge blending.
- **POSITION** ............ Adjust the display position of the edge blending.

**BLACK LEVEL**
Divide the screen into nine parts and keep the black level uniform for each projector.
The nine divisions screens are TOP-LEFT, TOP-CENTER, TOP-RIGHT, CENTER-LEFT, CENTER, CENTER-RIGHT, BOTTOM-LEFT, BOTTOM-CENTER and BOTTOM-RIGHT. (→ page 60)
5. Using On-Screen Menu

[MULTI SCREEN]

WHITE BALANCE
This adjusts the white balance for each projector when projecting using a combination of several projectors. This can be adjusted when [MODE] is set to [ON].

BRIGHTNESS W, BRIGHTNESS R, BRIGHTNESS G, BRIGHTNESS B
........................................... Adjusting the black color of the video.
CONTRAST W, CONTRAST R, CONTRAST G, CONTRAST B
........................................... Adjusting the white color of the video.

PICTURE SETTINGS
This sets the division condition when projecting using a combination of several projectors. Please refer to “4. Multi-Screen Projection” (→ page 48) for details.

<table>
<thead>
<tr>
<th>MODE</th>
<th>OFF</th>
<th>Use the projector in a standalone state.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ZOOM</td>
<td>This adjusts the position and width of the video area that you wish to divide. The edge blending width will also be automatically set to that width.</td>
</tr>
<tr>
<td></td>
<td>TILING</td>
<td>This assigns the divided screens to the projectors. The edge blending function will also be set automatically.</td>
</tr>
<tr>
<td>ZOOM</td>
<td>HORIZONTAL ZOOM</td>
<td>This enlarges the video area in the horizontal direction.</td>
</tr>
<tr>
<td></td>
<td>VERTICAL ZOOM</td>
<td>This enlarges the video area in the vertical direction.</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL POSITION</td>
<td>This shifts the video area in the horizontal direction.</td>
</tr>
<tr>
<td></td>
<td>VERTICAL POSITION</td>
<td>This shifts the video area in the vertical direction.</td>
</tr>
<tr>
<td>TILING</td>
<td>WIDTH</td>
<td>This selects the number of projectors to be arranged horizontally.</td>
</tr>
<tr>
<td></td>
<td>HEIGHT</td>
<td>This selects the number of projectors to be arranged vertically.</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL POSITION</td>
<td>This selects the position of the projector starting from the left among those arranged horizontally.</td>
</tr>
<tr>
<td></td>
<td>VERTICAL POSITION</td>
<td>This selects the position of the projector starting from the top among those arranged vertically.</td>
</tr>
</tbody>
</table>
5. Using On-Screen Menu

Conditions for using tiling
All the projectors need to fulfill the following conditions.
• The panel size must be the same
• The projection screen size must be the same
• The left and right ends or top and bottom ends of the projection screen must be consistent.
• The settings for the left and right edges of the edge blending are the same
• The settings for the top and bottom edges of the edge blending are the same
If the tiling conditions are satisfied, the video screen of the projector at each installation position will be automatically extracted and projected.
If the tiling conditions are not satisfied, adjust the video screen of the projector at each installation position using the zoom function.

Tiling setting example) Number of horizontal units = 2, Number of vertical units = 2

Horizontal order = Second unit
Vertical order = First unit
7 Menu Descriptions & Functions [SETUP]

[MENU]

Selecting Menu Language [LANGUAGE]
You can choose one of 29 languages for on-screen instructions.

**NOTE:** Your setting will not be affected even when [RESET] is done from the menu.

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [INPUT DISPLAY]
This option turns on or off input name display such as HDMI1, HDMI2, DisplayPort, BNC, BNC(CV), BNC(Y/C), COMPUTER, HDBaseT to be displayed on the top right of the screen.

Turning messages on and off [MESSAGE DISPLAY]
This option selects whether or not to display projector messages at the bottom of the projected image. Even when “OFF” is selected, the security lock warning is displayed. The security lock warning turns off when the security lock is canceled.

Turning ON/OFF Control ID [ID DISPLAY]

ID DISPLAY ........... This option turns on or off the ID number which is displayed when the ID SET button on the remote control is pressed. (→ page 105)
Turning On / Off Eco Message [ECO MESSAGE]
This option turns on or off the following messages when the projector is turned on.

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message to prompt you to select [ON] for [ECO MODE].

When [ON] is selected for [ECO MODE]

<table>
<thead>
<tr>
<th>CARBON METER</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECO MODE</td>
</tr>
<tr>
<td>THANK YOU FOR SAVING THE ENVIRONMENT.</td>
</tr>
</tbody>
</table>

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 30 seconds.

When [OFF] is selected for [ECO MODE]

<table>
<thead>
<tr>
<th>CARBON METER</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECO MODE</td>
</tr>
<tr>
<td>USING ECO MODE REDUCES CARBON FOOTPRINT AND LENGTHENS LAMP LIFE.</td>
</tr>
</tbody>
</table>

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 98)
To close the message, press the EXIT button.

[3D CAUTION MESSAGE]
This selects whether to display a caution message or not when switching to a 3D video.
The default condition when shipped from the factory is ON.

OFF ...................... The 3D caution message screen will not be displayed.
ON ...................... The 3D caution message screen will be displayed when switching to a 3D video. Press the ENTER button to cancel the message.
    • The message will disappear automatically after 60 seconds or when other buttons are pressed. If it disappears automatically, the 3D caution message will be displayed again when switching to a 3D video.

Selecting Menu Display Time [DISPLAY TIME]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the factory preset.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference between displaying the message for cleaning the filters. Clean the filter when you get the message “PLEASE CLEAN FILTER.” (→ page 138)
Five options are available: OFF, 100[H], 500[H], 1000[H], 2000[H]
The default setting is [OFF].

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
5. Using On-Screen Menu

[INSTALLATION]

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

NOTE:
• Please consult the retail store if you require special installation services e.g. when mounting the projector to a ceiling. Never install the projector on your own. This may result in the projector falling down and causing injury to people.
• When using the projector suspended from a ceiling, ensure that people do not stay below the projector. In the event the lamp were to break, there is a risk that glass fragments may fall from the projector.

AUTO ................. This automatically detects and projects the DESKTOP FRONT and CEILING FRONT.

NOTE:
• The DESKTOP REAR and CEILING REAR will not be detected. Please select manually.

TIP:
• Check whether the automatic DESKTOP FRONT is installed within ±10 degrees for floor installation and whether the CEILING FRONT is within ±10 degrees for ceiling installation. Select manually when the projection screen is inverted.
5. Using On-Screen Menu

Selecting Aspect Ratio and Position for Screen [SCREEN TYPE]

<table>
<thead>
<tr>
<th>Screen type</th>
<th>Sets the aspect ratio of the projection screen.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FREE</td>
<td>The ratio of the liquid crystal panel is selected. Select this when projecting multi-screen and 17:9 screen (2K).</td>
</tr>
<tr>
<td>4:3 screen</td>
<td>For a screen with a 4:3 aspect ratio</td>
</tr>
<tr>
<td>16:9 screen</td>
<td>For a screen with a 16:9 aspect ratio</td>
</tr>
<tr>
<td>16:10 screen</td>
<td>For a screen with a 16:10 aspect ratio</td>
</tr>
</tbody>
</table>

NOTE:
- After changing the screen type, check the setting of [ASPECT RATIO] in the menu. (→ page 80)

Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.


Selecting Fan Mode [FAN MODE]

Fan Mode is used to set the speed of the internal cooling fan.

MODE ................. Select three modes for fan speed: AUTO, HIGH, and HIGH ALTITUDE.
- AUTO: The built-in fans automatically run at a variable speed according to the internal temperature.
- HIGH: The built-in fans run at high speed
- HIGH ALTITUDE: The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 5500 feet/1600 meters or higher. To use the projector with ECO MODE ON in other installed conditions than desktop/ceiling with +/-20°, heed the following:
  2. Select [OFF] for [ECO MODE] at altitude 6800 feet/2100 meters or higher.

NOTE:
- Make sure the speed is set to [HIGH] when you are using this device continuously for several days.
- Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher.
- Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
- Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
- Using the projector at altitudes approximately 5500 feet/1600 meters or higher can shorten the life of optical components such as the lamp.
- Your setting will not be affected even when [RESET] is done from the menu.

TIP:
- When [HIGH ALTITUDE] is selected for [FAN MODE], a symbol icon will be displayed at the bottom of the menu.
[LAMP MODE]
When eco-mode is set to [ON], the CO₂ emissions (calculated from the reduction in power consumption) of the projector can be reduced. The eco-mode reduces power consumption by mainly lowering the brightness of the lamp. As a result, the lamp replacement time (as a guide)* is extended. (→ page 118)
* Replacement time not guaranteed.

LAMP ADJUST...... This can be set when the eco-mode is set to [OFF]. Adjust the lamp to match the brightness of each projector when projecting a multi-screen display using multiple projectors.

<table>
<thead>
<tr>
<th>ECO MODE</th>
<th>OFF</th>
<th>The lamp luminance (brightness) will become 100% and the screen will turn bright. The luminance of the lamp can be set using the lamp adjustment.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ON</td>
<td>The lamp luminance (brightness) will become approximately 80% and the lamp replacement time (estimated)* will be extended. * The replacement time is not guaranteed.</td>
</tr>
<tr>
<td>LAMP ADJUST</td>
<td>When the [ECO MODE] is set to [OFF], [LAMP ADJUST] is enabled. Adjust the lamp to match the brightness of each projector when projecting a multi-screen display using multiple projectors.</td>
<td></td>
</tr>
</tbody>
</table>

[REF. WHITE BALANCE]
This feature allows you to adjust the white balance for all signals. The white and black levels of the signal are adjusted for optimum color reproduction. Uniformity is also adjusted when the redness (R) and blueness (B) of the white color in the screen’s horizontal (left/right) direction are uneven.

CONTRAST R/CONTRAST G/CONTRAST B
................................. These adjust the picture’s white color.

BRIGHTNESS R/BRIGHTNESS G/BRIGHTNESS B
................................. These adjust the picture’s black color.

UNIFORMITY R...... The further this is set to the + side, the stronger the redness on the left side of the picture (increasing towards the left edge) and the weaker the redness on the right side of the picture (decreasing towards the right edge). This is reversed when set to the – side.

UNIFORMITY B...... The further this is set to the + side, the stronger the blueness on the left side of the picture (increasing towards the left edge) and the weaker the blueness on the right side of the picture (decreasing towards the right edge). This is reversed when set to the – side.

[STATIC CONVERGENCE]
This features allows you to adjust for color deviation in the picture. This can be adjusted in units of ± 1 pixel in the horizontal direction for HORIZONTAL R, G and B, in the vertical direction for VERTICAL R, G and B.
5. Using On-Screen Menu

[CONTROL]

TOOLS

ADMINISTRATOR MODE
This allows you to select MENU MODE, save settings, and set a password for the administrator mode.

<table>
<thead>
<tr>
<th>MENU MODE</th>
<th>Select either [BASIC] or [ADVANCED] menu. (→ page 64)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOT SAVE SETTING VALUES</td>
<td>Placing a check mark will not save your projector settings. Clear this check box to save your projector settings.</td>
</tr>
<tr>
<td>NEW PASSWORD/CONFIRM PASS-WORD</td>
<td>Assign a password for the administrator mode. Up to 10 alphanumeric characters</td>
</tr>
</tbody>
</table>
This option turns on/standby the projector and changes video signals, and selects ECO mode automatically at a specified time.

**NOTE:**
- Before using [PROGRAM TIMER], make sure that the [DATE AND TIME] feature is set. (→ page 103)
Make sure that the projector is in the standby condition with the POWER cord connected.
The projector has a built-in clock. The clock will keep working for about two weeks after the main power is turned off. If the main power is not supplied to the projector for two weeks or more, the built-in clock stops working.

**Setting a new program timer**

1. On the **PROGRAM TIMER** screen, use the ▲ or ▼ button to select [SETTINGS] and press the ENTER button.

   ![PROGRAM TIMER screen](image)

   The [PROGRAM LIST] screen will be displayed.

2. Select a blank program number and press the ENTER button.

   ![PROGRAM LIST screen](image)

   The [EDIT] screen will be displayed.

3. **Make settings for each item as required.**

   ![EDIT screen](image)

   ACTIVE .................. Place a check mark to enable the program.
   DAY..................... Select days of the week for the program timer. To execute the program from Monday to Friday, select [MON-
Using On-Screen Menu

To execute the program in everyday basis, select [EVERYDAY].

**TIME** Set the time to execute the program. Enter time in 24-hour format.

**FUNCTION** Select a function to be executed. Selecting [POWER] will allow you to turn on or off the projector by setting [ADVANCED SETTINGS]. Selecting [INPUT] will allow you to select a video source by setting [ADVANCED SETTINGS]. Selecting [ECO MODE] will allow you to select [ECO MODE] by setting [ADVANCED SETTINGS].

**ADVANCED SETTINGS** Select power on/off, a type of video source, or ECO MODE for the selected item in [FUNCTION].

**REPEAT** Place a check mark to repeat the program continuing basis. To use the program this week only, clear the check mark.

4. **Select [OK] and press the ENTER button.**

   This will complete the settings.

   You will be returned to the [PROGRAM LIST] screen.

5. **Select [BACK] and press the ENTER button.**

   You will be returned to the [PROGRAM TIMER] screen.

6. **Select [OK] and press the ENTER button.**

   You will be returned to the [TOOLS] screen.

**NOTE:**
- Up to 30 different timer settings can be programmed.
- When [PROGRAM TIMER] is turned on, the [STANDBY MODE] setting is ignored.
- The Program Timer is executed on a set time basis, not in a program basis.
- Once the program not marked with a check in [REPEAT] has been executed, the check mark in the [ACTIVE] check box will be cleared automatically and the program will be disabled.
- When the on-time and the off-time set for the same time, the off-time setting will take preference.
- Two different sources are set for the same time, the larger program number will take preference.
- The on-time setting will not be executed while the cooling fans are running or an error is occurring.
- If the off-time setting is expired under the condition in which the power off is not possible, the off-timer setting will not be executed until the power off becomes possible.
- Programs not marked with a check mark in [ACTIVE] of the [EDIT] screen will not be executed even if the Program Timer is enabled.
- When the projector is turned on by using the program timer and if you want to turn off the projector, set the off-time or do it manually so as not to leave the projector on for a long period of time.
5. Using On-Screen Menu

Activating the program timer

   The selection screen will be displayed.
2. Press the ▼ button to align the cursor with [ON] and then press the ENTER button.
   Return to the [PROGRAM TIMER] screen.

NOTE:
• When the effective settings of the [PROGRAM TIMER] have not been set to [ON], the program will not be executed even if the [ACTIVE] items in the program list have been ticked.
• Even when the effective settings of the [PROGRAM TIMER] are set to [ON], the [PROGRAM TIMER] will not work until the [PROGRAM TIMER] screen is closed.

Changing the programmed settings

1. On the [PROGRAM LIST] screen, select a program you want to edit and press the ENTER button.
2. Change the settings on the [EDIT] screen.
3. Select [OK] and press the ENTER button.
   The programmed settings will be changed.
   You will be returned to the [PROGRAM LIST] screen.

Changing the order of programs

1. On the [PROGRAM LIST] screen, select a program whose order you want to change and press the ▶ button.
2. Press the ▼ button to select ▲ or ▼.
3. Press the ENTER button a few times to select a row to which you wish to move the program.
   The order of the programs will be changed.

Deleting the programs

1. On the [PROGRAM LIST] screen, select a program number you want to delete and press the ▶ button.
2. Press the ▼ button to select [DELETE].
3. Press the ENTER button.
   The confirmation screen will be displayed.
4. Select [YES] and press the ENTER button.
   The program will be deleted.

This will complete deleting the program.
You can set the current time, month, date, and year.

**NOTE:** The projector has a built-in clock. The clock will keep working for about 2 weeks after the main power is turned off. If the main power is off for 2 weeks or more, the built-in clock will cease. If the built-in clock ceases, set the date and time again. The built-in clock will not cease while in the standby mode.

- **TIME ZONE SETTINGS**............. Select your time zone.
- **DATE AND TIME SETTINGS**...... Set your current date (MM/DD/YYYY) and time (HH:MM).
- **INTERNET TIME SERVER**........ If you place a check mark, the projector’s built-in clock will be synchronized with an Internet time server in every 24 hours and at the time of projector’s startup.
- **UPDATE**.......................... Synchronizes the projector’s built-in clock immediately. The UPDATE button is not available unless the INTERNET TIME SERVER check box is turned on.
- **SUMMER TIME SETTINGS**........ If you place a check mark, the clock for daylight saving will be enabled.

**[MOUSE]**
This function cannot be used in this device. It is used for future expansion purposes only.
Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
- How to cancel the [CONTROL PANEL LOCK]
  When the [CONTROL PANEL LOCK] is set to [ON], press the EXIT button or the INPUT button on the main body for about 10 seconds to cancel the [CONTROL PANEL LOCK] setting.

TIP:
- When the [CONTROL PANEL LOCK] is turned on, a key lock icon [ ] will be displayed at the bottom right of the menu.
- This CONTROL PANEL LOCK does not affect the remote control functions.

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function.
Unless the correct keyword is entered, the projector cannot project an image. (→ page 36)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 115200 bps. The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).

NOTE:
- Select [38400bps] or less when using the supplied software programs.
- Your selected communication speed will not be affected even when [RESET] is done from the menu.
5. Using On-Screen Menu

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER ...... Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID...................... Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE:
• When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support the CONTROL ID function. (If this case the buttons on the projector cabinet can be used.)
• Your setting will not be affected even when [RESET] is done from the menu.
• Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control ID.

Assigning or Changing the Control ID

1. Turn on the projector.
2. Press the ID SET button on the remote control.
The CONTROL ID screen will be displayed.

CONTROL ID
CONTROL ID NUMBER 1
CONTROL ID OFF

If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the control ID used for the projector by using the following procedure (Step 3).

3. Press one of numeric keypad buttons while pressing and holding the ID SET button on the remote control.
Example:
To assign “3”, press the “3” button on the remote control.
No ID means that all the projectors can be operated together with a single remote control. To set “No ID”, enter “000” or press the CLEAR button.
TIP: The range of IDs is from 1 to 254.
4. Release the ID SET button.
The updated CONTROL ID screen will be displayed.

NOTE:
• The IDs can be cleared in a few days after the batteries are run down or removed.
• Accidentally pressing any one of the buttons of the remote control will clear currently specified ID with batteries removed.
5. Using On-Screen Menu

Turning On or Off Remote Sensor [REMOTE SENSOR]
This option determines which remote sensor on the projector is enabled in wireless mode. The options are: FRONT/BACK, FRONT, BACK, and HDBaseT.

**NOTE:**
• The remote control of the projector will not be able to receive signals if the power supply of the HDBaseT transmission device connected to the projector is switched on when this has been set to "HDBaseT".

**TIP:**
• If the remote control system does not function when direct sunlight or strong illumination strikes the remote control sensor of the projector, change another option.

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are performed.

• Displaying the main menu
• Switching sources
• Resetting data by using [RESET]
• Pressing POWER ON or STANDBY button
5. Using On-Screen Menu

**[NETWORK SETTINGS]**

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>NETWORK SETTINGS</td>
<td>SOURCE OPTIONS</td>
</tr>
<tr>
<td></td>
<td>WIRED LAN</td>
<td>PROJECTOR NAME</td>
<td>DOMAIN</td>
<td>ALERT MAIL</td>
</tr>
<tr>
<td>&lt;ENTER&gt;</td>
<td>:SELECT</td>
<td>EXIT</td>
<td>←:MOVE</td>
<td>←:MOVE</td>
</tr>
</tbody>
</table>

**Important:**

- Consult with your network administrator about these settings.
- When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projector. (→ page 137)

**TIP:** The network settings you make will not be affected even when [RESET] is done from the menu.

**Hints on How to Set Up LAN Connection**

**To set up the projector for a LAN connection:**
Select [WIRED LAN] → [PROFILES] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for wired LAN.
Next turn on or off for [DHCP], [IP ADDRESS], [SUBNET MASK], and [GATEWAY] and select [OK] and press the ENTER button. (→ page 108)

**To recall LAN settings stored in the profile number:**
Select [PROFILE 1] or [PROFILE 2] for wired LAN, and then select [OK] and press the ENTER button. (→ page 108)

**To connect a DHCP server:**
Turn on [DHCP] for wired LAN. Select [ON] and press the ENTER button. To specify IP address without using the DHCP server, turn off [DHCP]. (→ page 108)

**To receive lamp replacement time or error messages via e-mail:**
Select [ALERT MAIL], and set [SENDER'S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT'S ADDRESS].
Last, select [OK] and press the ENTER button. (→ page 110)
### WIRED LAN

**Profiles**
- The settings for using the built-in Ethernet/HDBaseT port in the projector can be recorded in the projector memory in two ways.
- Select [PROFILE 1] or [PROFILE 2] and then do settings for [DHCP] and the other options. After doing this, select [OK] and press the ENTER button. This will store your settings in memory.
- To recall the settings from memory:
  - After selecting [PROFILE 1] or [PROFILE 2] from the [FILES] list.
  - Select [OK] and press the ENTER button.
- Select [DISABLE] when not connecting to a wired LAN.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Place a check mark to automatically assign an IP address to the projector from your DHCP server. Clear this check box to register the IP address or subnet mask number obtained from your network administrator.</td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>Set your IP address of the network connected to the projector when [DHCP] is turned off.</td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector when [DHCP] is turned off.</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector when [DHCP] is turned off.</td>
</tr>
<tr>
<td>AUTO DNS</td>
<td>Place a check mark to automatically assign the IP address of your DNS server connected to the projector from your DHCP server. Clear this check box to set the IP address of your DNS server connected to the projector.</td>
</tr>
<tr>
<td>DNS CONFIGURATION</td>
<td>Set the IP address of your DNS server on the network connected to the projector when [AUTO DNS] is cleared.</td>
</tr>
<tr>
<td>RECONNECT</td>
<td>Retry to connect the projector to a network. Try this if you have changed [PROFILES].</td>
</tr>
</tbody>
</table>
5. Using On-Screen Menu

**PROJECTOR NAME**

Set a unique projector name.

- Up to 16 alphanumeric characters and symbols

**DOMAIN**

Set a host name and domain name of the projector.

**HOST NAME**

Set a host name of the projector.

- Up to 15 alphanumeric characters

**DOMAIN NAME**

Set a domain name of the projector.

- Up to 60 alphanumeric characters
### ALERT MAIL

This option will notify your computer of lamp replace time or error messages via e-mail when using wireless or wired LAN. Placing a checkmark will turn on the Alert Mail feature. Clearing a checkmark will turn off the Alert Mail feature.

**Sample of a message to be sent from the projector:**

The lamp and filters are at the end of its usable life. Please replace the lamp and filters.

Projector Name: NEC Projector
Lamp Hours Used: 100 [H]

<table>
<thead>
<tr>
<th>HOST NAME</th>
<th>Type in a host name.</th>
<th>Up to 15 alphanumeric characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOMAIN NAME</td>
<td>Type in a domain name of the network connected to the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
<tr>
<td>SENDER'S ADDRESS</td>
<td>Specify the sender's address.</td>
<td>Up to 60 alphanumeric characters and symbols</td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td>Type in the SMTP server name to be connected to the projector.</td>
<td>Up to 60 alphanumeric characters</td>
</tr>
<tr>
<td>RECIPIENT'S ADDRESS 1, 2, 3</td>
<td>Type in your recipient's address.</td>
<td>Up to 60 alphanumeric characters and symbols</td>
</tr>
</tbody>
</table>

**TEST MAIL**

Send a test mail to check if your settings are correct.

**NOTE:**
- If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient's Address is correctly set.
- Unless any one of the [SENDER'S ADDRESS], [SMTP SERVER'S NAME] or [RECIPIENT'S ADDRESS 1-3] is selected, [TEST MAIL] is not available.
- Be sure to highlight [OK] and press the ENTER button before executing [TEST MAIL].
### NETWORK SERVICE

<table>
<thead>
<tr>
<th>HTTP SERVER</th>
<th>Description</th>
<th>Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMX BEACON</td>
<td>Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX's NetLinx control system.</td>
<td>Up to 32 alphanumeric</td>
</tr>
<tr>
<td>PJLink</td>
<td>This option allows you to set a password when you use the PJLink feature.</td>
<td>Up to 32 alphanumeric</td>
</tr>
</tbody>
</table>

**NOTE:**
- Do not forget your password. However, if you forget your password, consult with your dealer.
- What is PJLink?
  PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005. The projector supports all the commands of PJLink Class 1.
- Setting of PJLink will not be affected even when [RESET] is done from the menu.

**TIP:**
- When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server.
- Placing a checkmark will enable detecting the projector from AMX Device Discovery.
- Clearing a checkmark will disable detecting the projector from AMX Device Discovery.
[SOURCE OPTIONS]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

OFF ......................... The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
NORMAL .................... Default setting. The computer signal will be automatically adjusted. Normally select this option.
FINE ......................... Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NORMAL] is selected.

TIP:
• The default setting when shipped from the factory is [NORMAL].
• When the AUTO ADJ. button is pressed, the same [FINE] adjustment is carried out.

[COLOR SYSTEM]
This feature allows you to select the TV video signal, which differs from country to country (NTSC, PAL, etc.). This is set to [AUTO] by factory default. Set this if the projector cannot identify the signal automatically.

[AUDIO SELECT]
This selects the audio input of the HDMI 1 IN terminal, HDMI 2 IN terminal, DisplayPort input terminal and Ethernet/HDBaseT port.
When inputting analog audio, connect the audio output terminal of the connecting device with the BNC audio input terminal and set the Audio Select to “BNC”.

Selecting Default Source [DEFAULT INPUT SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

LAST ....................... Sets the projector to default to the previous or last active input each time the projector is turned on.
AUTO ....................... Searches for an active source in order of HDMI1 → HDMI2 → DisplayPort → BNC → BNC(CV) → BNC(Y/C) → COMPUTER → HDBaseT and displays the first found source.
HDMI1 ..................... Displays the digital source from the HDMI 1 IN connector every time the projector is turned on.
HDMI2 ..................... Displays the digital source from the HDMI 2 IN connector every time the projector is turned on.
DisplayPort ............. Displays the digital source from the DisplayPort every time the projector is turned on.
BNC ......................... Project the input signal from the BNC video input terminal
BNC(CV) ................... Project the input signal from the BNC(CV) video input terminal.
BNC(Y/C) ................... Project the input signal from the BNC(Y/C) video input terminal.
COMPUTER ............... Displays the computer signal from the COMPUTER IN connector every time the projector is turned on.
HDBaseT ................... Project the HDBaseT signal.
[SEAMLESS SWITCHING]
When the input connector is switched, the image displayed before switching is held to switch to the new image without a break due to absence of a signal.

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video or S-Video.
The subtitles and text will be displayed a short while after the on-screen menu disappears.

   OFF .......................... This exits the closed caption mode.
   CAPTION 1-4 ........ Text is superimposed.
   TEXT 1-4 ................ Text is displayed.

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

NOTE:
• Even when the background logo is selected, if two pictures are displayed in [PIP/PICTURE BY PICTURE] mode, the blue background is displayed without the logo when there is no signal.
5. Using On-Screen Menu

**[POWER OPTIONS]**

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>POWER OPTIONS</strong></td>
<td><strong>RESET</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **STANDBY MODE**
  - DIRECT POWER ON: OFF
  - AUTO POWER ON SELECT: OFF
  - AUTO POWER OFF: OFF
  - OFF TIMER: OFF

---

**Selecting Power-saving in [STANDBY MODE]**

Setting the power consumption in the standby mode.

**NORMAL**

In the standby mode, the power consumption of the projector is 0.11 W (100-130 V)/0.16 W (200-240 V).

In the standby mode, the POWER indicator lights up in red while the STATUS indicator will go off.

- When set to [NORMAL], the following terminals and functions will be disabled. HDMI output terminals, audio output terminals, Ethernet/HDBaseT port, USB-A port, LAN function, mail notification function

**HDBaseT STANDBY**

Compared to [NORMAL], the power consumption in the standby mode is higher but power can be supplied to the projector using a wired LAN.

In the standby mode, the power indicator will light up in orange while the status indicator will be turned off.

**Important:**

- When [HDBaseT STANDBY] is selected, [AUTO POWER OFF] will turn grey in color and be disabled and [0:15] will be selected automatically.
- In the following conditions, the [STANDBY MODE] setting will be disabled and the projector will go into the sleep mode.
  - Sleep mode refers to the mode whereby the functional restrictions due to the [STANDBY MODE] setting are removed.
- When [ENABLE] is selected under [NETWORK SERVICE] → [AMX BEACON]
- When [HDBaseT] is selected under [CONTROL] → [REMOTE SENSOR]
- When a signal is being received from a HDBaseT transmission device
- When [NORMAL] is selected, the [AUTO POWER ON SELECT] display turns grey in color and is disabled, and [OFF] is automatically selected.

**NOTE:**

- When connecting to a HDBaseT transmission device sold commercially, if the transmission device is set to transmit remote control signals, the power consumption of the projector in the standby mode will increase.

**TIP:**

- Your setting will not be affected even when [RESET] is done from the menu.
- The power consumption in the standby mode will not be included in calculating CO₂ emission reduction.

**Enabling Direct Power On [DIRECT POWER ON]**

Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
5. Using On-Screen Menu

Turning On the Projector By Applying Computer Signal [AUTO POWER ON SELECT]

This setting automatically projects any computer signal that is input when the projector is in the standby mode. Connect to the input terminal on the projector using a cable and put the projector in the standby mode.

When using the [AUTO POWER ON SELECT], set the [STANDBY MODE] to [HDBaseT STANDBY], turn on the power supply of the transmission device and keep it in a connected state.

OFF .......................... AUTO POWER ON SELECT function will be switch off.
HDMI1, HDMI2, DisplayPort, COMPUTER, HDBaseT .......................... When a computer signal of a selected input terminal is detected, the power supply of the projector will be turned on automatically and the computer screen will be projected.

NOTE:
• This function will not work for computer signals such as Sync on Green or Composite Sync and when component signals are input to the computer or BNC video input terminal.
• If you want to test the AUTO POWER ON SELECT after switching off the power supply of the projector, wait for three or more seconds after switching off the power before inputting any computer signal. When the power supply is switched off and the projector goes into the standby mode, the projector will continue to remain in the standby mode without power supply being restored if a computer signal continues to be input to the projector.

Enabling Power Management [AUTO POWER OFF]

When this option is selected you can enable the projector to automatically turn off (at the selected time: 0:05, 0:10, 0:15, 0:20, 0:30, 1:00) if there is no signal received by any input or if no operation is performed.

NOTE:
• The power will not go off automatically when a signal from the Ethernet/HDBaseT port is being projected.
• [AUTO POWER OFF] appears in grey when the [STANDBY MODE] is set to [HDBaseT STANDBY] and [0:15] will be set automatically.

Using Off Timer [OFF TIMER]

1. Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.
2. Press the ENTER button on the remote control.
3. The remaining time starts counting down.
4. The projector will turn off after the countdown is complete.

NOTE:
• To cancel the preset time, set [OFF] for the preset time or turn off the power.
• When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 MINUTES] message will be displayed on the bottom of the screen.
Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source(s) except the following:

![On-Screen Menu Menu Options](image)

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels.
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], [ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [EDGE BLENDING], [MULTI SCREEN], [SCREEN TYPE], [GEOMETRIC CORRECTION], [REF. WHITE BALANCE], [STATIC CONVERGENCE], [ADMINISTRATOR MODE], [CONTROL PANEL LOCK], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], and [WIRED LAN].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

[ALL DATA (INCLUDING ENTRY LIST)]
Reset all the adjustments and settings for all the signals to the factory preset except [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [EDGE BLENDING], [MULTI SCREEN], [SCREEN TYPE], [GEOMETRIC CORRECTION], [REF. WHITE BALANCE], [STATIC CONVERGENCE], [ADMINISTRATOR MODE], [CONTROL PANEL LOCK], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], and [WIRED LAN].
Also deletes all the signals in the [ENTRY LIST] and returns to the factory preset.

NOTE: Locked signals in Entry List cannot be reset.

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

NOTE:
• Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.
• Performing [CLEAR LAMP HOURS] will return the [LAMP ADJUST] in [LAMP MODE] to its default adjustments. When the projector is used for multi-screen projection, use [LAMP ADJUST] to adjust the brightness again.
Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
 Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

The [OFF] item is selected for [FILTER MESSAGE] at the time of shipment. When [OFF] is selected, you do not need to clear the filter usage hour.

NOTE: Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
5. Using On-Screen Menu

⑧ Menu Descriptions & Functions [INFO.]

Displays the status of the current signal and lamp usage. This item has nine pages. The information included is as follows:

*TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

**[USAGE TIME]**

![Image of INFO menu]

- [LAMP LIFE REMAINING] (%)*
- [LAMP HOURS USED] (H)
- [FILTER HOURS USED] (H)
- [TOTAL CARBON SAVINGS] (kg-CO2)

*The progress indicator shows the percentage of remaining bulb life. The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE REMAINING bar indicator changes from 0% to 100 Hours and starts counting down. If the remaining lamp time reaches 0 hours, the projector will not turn on.

*The message to the effect that the lamp or the filters should be replaced will be displayed for one minute when the projector is turned on and when the POWER button on the projector or the remote control is pressed. To dismiss this message, press any button on the projector or the remote control.

<table>
<thead>
<tr>
<th>Lamp life(H)</th>
<th>ECO MODE</th>
<th>During portrait installation</th>
<th>Replacement lamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORMAL (OFF)</td>
<td>ECO (ON)</td>
<td>2000</td>
<td>NP26LP</td>
</tr>
<tr>
<td>3000</td>
<td>4000</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- [TOTAL CARBON SAVINGS]

This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving calculation is based on the OECD (2008 Edition). (→ page 30)
5. Using On-Screen Menu

**[SOURCE(1)]**

<table>
<thead>
<tr>
<th>INPUT TERMINAL</th>
<th>HDMI1</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESOLUTION</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>HORIZONTAL FREQUENCY</td>
<td>48.58 kHz</td>
</tr>
<tr>
<td>VERTICAL FREQUENCY</td>
<td>62.1 Hz</td>
</tr>
<tr>
<td>SYNC TYPE</td>
<td>SEPARATE SYNC</td>
</tr>
<tr>
<td>SYNC POLARITY</td>
<td>H: (-) V: (-)</td>
</tr>
<tr>
<td>SCAN TYPE</td>
<td>NON-INTERLACE</td>
</tr>
<tr>
<td>SOURCE NAME</td>
<td>1024 x 768</td>
</tr>
<tr>
<td>ENTRY NO.</td>
<td>1</td>
</tr>
</tbody>
</table>

**[SOURCE(2)]**

<table>
<thead>
<tr>
<th>SIGNAL TYPE</th>
<th>RGB</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO TYPE</td>
<td>NTSC</td>
</tr>
<tr>
<td>BIT DEPTH</td>
<td>6 [bits]</td>
</tr>
<tr>
<td>VIDEO LEVEL</td>
<td>FULL</td>
</tr>
<tr>
<td>LINK RATE</td>
<td>2.7 Gbps</td>
</tr>
<tr>
<td>LINK LANE</td>
<td>1 [lane]</td>
</tr>
<tr>
<td>3D FORMAT</td>
<td>FRAME PACKING</td>
</tr>
</tbody>
</table>

**[WIRED LAN]**

<table>
<thead>
<tr>
<th>IP ADDRESS</th>
<th>192.168.0.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUBNET MASK</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>192.168.0.1</td>
</tr>
<tr>
<td>MAC ADDRESS</td>
<td>00-00-00-00-00-00</td>
</tr>
</tbody>
</table>

**SOURCE(1) Inputs:**
- **INPUT TERMINAL**
- **RESOLUTION**
- **HORIZONTAL FREQUENCY**
- **VERTICAL FREQUENCY**
- **SYNC TYPE**
- **SYNC POLARITY**
- **SCAN TYPE**
- **SOURCE NAME**
- **ENTRY NO.**

**SOURCE(2) Inputs:**
- **SIGNAL TYPE**
- **VIDEO TYPE**
- **BIT DEPTH**
- **VIDEO LEVEL**
- **LINK RATE**
- **LINK LANE**
- **3D FORMAT**

**WIRED LAN Inputs:**
- **IP ADDRESS**
- **SUBNET MASK**
- **GATEWAY**
- **MAC ADDRESS**
5. Using On-Screen Menu

[VERSION(1)]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRED LAN</td>
<td>VERSION(1)</td>
<td>OTHERS</td>
<td>CONDITIONS</td>
<td>(2/3)</td>
</tr>
<tr>
<td>FIRMWARE</td>
<td>1.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DATA</td>
<td>1.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUB-CPU</td>
<td>1.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

FIRMWARE

SUB-CPU

[OTHERS]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO</th>
</tr>
</thead>
<tbody>
<tr>
<td>WIRED LAN</td>
<td>VERSION(1)</td>
<td>OTHERS</td>
<td>CONDITIONS</td>
<td>(2/3)</td>
</tr>
<tr>
<td>DATE TIME</td>
<td>--/--/----- (-) ---:---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROJECTOR NAME</td>
<td>PA622U Series</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MODEL NO.</td>
<td>NP-PA622U</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SERIAL NUMBER</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONTROL ID</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

DATE TIME

MODEL NO.

PROJECTOR NAME

SERIAL NUMBER

CONTROL ID (when [CONTROL ID] is set)
[CONDITIONS]

<table>
<thead>
<tr>
<th>INPUT</th>
<th>ADJUST</th>
<th>DISPLAY</th>
<th>SETUP</th>
<th>INFO.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>COND.</td>
</tr>
</tbody>
</table>

- INTAKE TEMPERATURE: -0.8°C / 0.2°F
- EXHAUST TEMPERATURE: 26.9°C / 80.5°F
- INSTALLATION POSITION: DESKTOP TILTDOWN
- X-AXIS
- Y-AXIS
- Z-AXIS

About the X-AXIS, Y-AXIS and Z-AXIS CONDITIONS

* Arrow direction of the Z-AXIS in the figure represents the top of the projector.

- X-AXIS Display the projector image at an angle of −100 – +100 degrees to the horizontal in the X-axis direction.

- Y-AXIS Display the projector image at an angle of −100 – +100 degrees to the horizontal in the Y-axis direction.

- Z-AXIS Display the projector image at an angle of −100 – +100 degrees to the vertical in the Z-axis direction.
Mounting a lens (sold separately)

Six separate bayonet style lenses can be used with this projector. The descriptions here are for the NP13ZL (2x zoom) lens. Mount other lenses in the same manner.

NOTE:

• The projector and lenses are made of precision parts. Do not subject them to shock or excessive forces.
• Remove the separately sold lens when moving the projector. If not, the lens could be subject to shock while the projector is being moved, damaging the lens and the lens shift mechanism.
• Turn off the power and wait for the cooling fan to stop before mounting or removing the lens.
• Never touch the lens surface while the projector is operating.
• Be very careful not to let dirt, grease, etc., on the lens surface and not to scratch the lens surface.
• Perform these operations on a flat surface over a piece of cloth, etc., to prevent the lens from getting scratched.
• When leaving the lens off the projector for long periods of time, mount the dust cap on the projector to prevent dust or dirt from getting inside.
• If you have multiple projectors, be careful of the following:
  - When mounting a lens designed exclusively for this projector onto another projector in the NP series, be sure to remove the lens attachment before mounting the lens on the projector. The lens cannot be mounted if its attachment is on. For the types of lenses that can be mounted and instructions on removing them, see the lens’s operating instructions.
  - Other types of lenses cannot be mounted on this projector.

Mounting the lens

1. Remove the dust cap from the projector.

2. Remove the lens cap on the back of the lens.

3. Insert the lens onto the projector with the yellow-marked protrusion on the lens facing upwards.

   There is a positioning slit on the projector’s lens insertion slot. Insert the lens slowly all the way in, keeping the positioning slit at the same angle.
4. **Turn the lens clockwise.**
   
   Turn until a click is heard.
   
   The lens is now fastened onto the projector.

**TIP:** Mounting the lens theft prevention screw
Fasten the lens theft prevention screw included with the projector to the bottom of the projector so that the lens cannot be removed easily.

---

**Removing the lens**

1. **While pressing the lens release button on the projector’s front panel fully in, turn the lens counterclockwise.**
   
   The lens comes off.
   
   **NOTE:**
   
   • Check the following areas if the lens unit cannot be removed even when the lens release button is pressed.
   
   1. Check whether the theft prevention screws of the lens unit have been installed.
   
   2. The lens release button may be locked sometimes. In that case, turn the lens fully to the right. The lens release button lock will be released.

2. **Slowly pull the lens off the projector.**
   
   • After removing the lens, mount the lens caps (front and back) included with the lens before storing the lens.
   
   • If no lens is going to be mounted on the projector, mount the dust cap included with the projector.
6. Installation and Connections

2 Making Connections

A computer cable, BNC cable (5-core type), HDMI cable, or a DisplayPort cable can be used to connect to a computer. The connection cable is not enclosed with the projector. Please get ready a suitable cable for the connection.

Analog RGB signal connection

- Connect the computer cable to the display output terminal (mini D-sub 15 pin) on the computer and the computer video input terminal on the projector. Please use a computer cable attached with a ferrite core.
- When connecting the display output terminal (mini D-sub 15 pin) on the computer to the BNC video input terminal, use a conversion cable to convert the BNC cable (5 core) to a mini D-sub 15 pin cable.

Computer cable (sold commercially)

RGB - to - BNC cable (not supplied)

Stereo mini-plug audio cable (not supplied)

NOTE: Please check the operating manual of the computer as the name, position and direction of the terminal may differ depending on the computer.

Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>INPUT button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>7:COMPUTER</td>
<td>7/COMPUTER</td>
</tr>
<tr>
<td>BNC IN</td>
<td>4:BNC</td>
<td>4/BNC</td>
</tr>
</tbody>
</table>
6. Installation and Connections

**Digital RGB signal connection**

- Connect a commercially available HDMI cable between the computer’s HDMI output connector and the projector’s HDMI1 or HDMI2 input connector.
- Connect a commercially available DisplayPort cable between the computer’s DisplayPort output connector and the projector’s DisplayPort input connector.

- Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>INPUT button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1 IN</td>
<td>1:HDMI 1</td>
<td>1/HDMI 1</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>2:HDMI 2</td>
<td>2/HDMI 2</td>
</tr>
<tr>
<td>DisplayPort IN</td>
<td>3:DisplayPort</td>
<td>3/DisplayPort</td>
</tr>
</tbody>
</table>

HDMI cable (not supplied)  
DisplayPort cable (not supplied)
Cautions when connecting an HDMI cable

• Use a certified High Speed HDMI® Cable or High Speed HDMI® Cable with Ethernet.

Cautions when connecting a DisplayPort cable

• Use a certified DisplayPort cable.

- Depending on the computer, some time may be required until the image is displayed.
- Some DisplayPort cables (commercially available) have locks.
- To disconnect the cable, press the button on the top of the cable’s connector, then pull the cable out.
- Power can be supplied to the connecting device from the Display Port input terminal (maximum of 1.65 W). However, power will not be supplied to the computer.
- When signals from a device that uses a signal converter adapter are connected to the DisplayPort input connector, in some cases the image may not be displayed.
- When the HDMI output of a computer is connected to the DisplayPort input connector, use a converter (commercially available).
Cautions when using a DVI signal

- When the computer has a DVI output connector, use a commercially available converter cable to connect the computer to the projector’s HDMI 1 or HDMI 2 input connector (only digital video signals can be input). Also, connect the computer’s audio output to the projector’s BNC audio input connector. In this case, switch the HDMI1 or HDMI2 setting at on-screen menu’s audio selection on the projector to [BNC]. (→ page 112)

To connect the computer’s DVI output connector to the projector’s DisplayPort input connector, use a commercially available converter.

**NOTE: When Viewing a DVI Digital Signal**

- Turn off the power of the computer and projector before connecting.
- Lower the computer’s volume setting before connecting an audio cable to the headphones connector. When using with a computer connected to the projector, adjust the volume of both the projector and computer to set the appropriate volume level.
- If the computer has a mini-jack type audio output connector, we recommend connecting the audio cable to that connector.
- When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
- Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard. The cable should be within 197'/5 m long.
- Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
- To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC. Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.
- Some graphics cards have both analog RGB (15-pin D-Sub) and DVI (or DFP) outputs. Use of the 15-pin D-Sub connector may result in no picture being displayed from the digital output of the graphics card.
- Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
- The COMPUTER video input connectors support Windows Plug and Play. The BNC video input connector does not support Windows Plug and Play.
- A Mac signal adapter (commercially available) may be required to connect a Mac computer.
- To connect a Mac computer equipped with a Mini DisplayPort to the projector, use a commercially available Mini DisplayPort → DisplayPort converter cable.
Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer analog image you’re projecting.

- BNC(CV) component video signals and BNC(Y/C) S-video signals will not be output.
- Please refer to Page 85 when displaying the PIP/PBP screen.

**NOTE:**

- **When outputting HDMI signals,** turn on the power of the video device on the output side and keep it connected before inputting video signals into this device. The HDMI output terminals of the projector are equipped with repeater functions. When a device is connected to the HDMI output terminal, the resolution of the output signal is limited by the resolution supported by the connected device.
- **When the [STANDBY MODE] of this device is set to [NORMAL],** HDMI signals will not be output. To output HDMI signals, set the [STANDBY MODE] to [HDBaseT STANDBY], turn on the power supply of the transmission device and keep it connected.
- **In the case of the HDMI output terminal of the projector,** the theoretical number of units that can be connected in a series is seven. The maximum number of units that can be connected may be reduced by the external environment and quality of the signal and cable, etc. The number of units that can be connected may differ depending on the HDCP version, restriction on the number of HDCP repeaters in the source device and the quality of the cable. The overall system needs to be checked in advance when building a system.
- **When audio equipment is connected,** the projector speaker is disabled.
- **To output audio from the audio output terminal when the input terminal is neither “COMPUTER IN” nor “BNC IN”,** select [BNC] under [AUDIO SELECT] of the on-screen menu.
- **When the [STANDBY MODE] is set to [NORMAL],** video and audio will not be output if the projector goes into the standby mode. Set the mode to [HDBaseT STANDBY], turn on the power of the transmission device and keep it in a connected state.
• Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>INPUT button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>BNC(CV) IN</td>
<td>5:BNC(CV)</td>
<td>5/BNC(CV)</td>
</tr>
<tr>
<td>BNC(Y/C) IN</td>
<td>6:BNC(Y/C)</td>
<td>6/BNC(Y/C)</td>
</tr>
</tbody>
</table>

**NOTE:**
- The BNC (analog RGB/component), BNC (CV) and BNC (Y/C) audio input terminals are shared.
6. Installation and Connections

Connecting Component Input

- Select the source name for its appropriate input connector after turning on the projector.

<table>
<thead>
<tr>
<th>Input connector</th>
<th>INPUT button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>7:COMPUTER</td>
<td>7/COMPUTER</td>
</tr>
<tr>
<td>BNC IN</td>
<td>4:BNC</td>
<td>4/BNC</td>
</tr>
</tbody>
</table>

NOTE:
- When the signal format is set to [AUTO] (default factory setting when shipped), the computer signal and component signal are automatically distinguished and switched. If the signals cannot be distinguished, select [COMPONENT] under [ADJUST] → [VIDEO] → [SIGNAL TYPE] in the on-screen menu of the projector.
- To connect to a video device with a D connector, use the sold separately D connector converter adapter (model ADP-DT1E).
Connecting HDMI Input
You can connect the HDMI output of your Blu-ray player, hard disk player, or notebook type PC to the HDMI 1 IN or HDMI 2 IN connector of your projector.

**TIP:** For users of audio video equipment with an HDMI connector:
Select “Enhanced” rather than “Normal” if HDMI output is switchable between “Enhanced” and “Normal”. This will provide improved image contrast and more detailed dark areas.
For more information on settings, refer to the instruction manual of the audio video equipment to be connected.

- When connecting the HDMI 1 IN or HDMI 2 IN connector of the projector to the Blu-ray player, the projector’s video level can be made settings in accordance with the Blu-ray player’s video level. In the menu select [ADJUST] → [VIDEO] → [VIDEO LEVEL] and make necessary settings.
- If the HDMI input sound cannot be heard, in the menu select [AUDIO SELECT] → [HDMI1] or [HDMI2].
- If the HDMI input’s sound is not output, check that [SOURCE OPTIONS] → [AUDIO SELECT] → [HDMI1] or [HDMI2] on the projector’s on-screen menu is set to “HDMI”. (→ page 112)
Connecting to a HDBaseT transmission device (sold commercially)

HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance. Use a LAN cable sold commercially to connect the Ethernet / HDBaseT port of the projector (RJ-45) to a HDBaseT transmission device sold commercially. The Ethernet/HDBaseT port of the projector supports HDMI signals (HDCP) from transmission devices, control signals from external devices (serial, LAN) and remote control signals (IR commands).

Connection example

NOTE:
- Please use a shielded twisted pair (STP) cable of Category 5e or higher for the LAN cable (sold commercially).
- The maximum transmission distance over the LAN cable is 100 m. (the maximum distance is 70 m for a 4K signal)
- Please do not use other transmission equipment between the projector and transmission equipment. The picture quality may be degraded as a result.
- This projector is not guaranteed to work with all HDBaseT transmission devices sold commercially.
6. Installation and Connections

Portrait projection (vertical orientation)

Portrait screens from a computer can be projected by installing the projector in a vertical orientation. All the screens such as the on-screen menu will be rotated in a counter-clockwise direction.

The projector is equipped with a sensor to automatically detect the installation state.

When the projector is installed in a portrait configuration for the first time with the lamp lit up, a caution message to indicate that the operating time of the lamp may be shortened will be displayed. This message will automatically disappear when the installation state of the projector is returned to the original state.

![Portrait projection (vertical orientation)](image)

**Precautions during installation**

- Please do not install the projector in a vertical orientation on top of the floor or table on its own. The air inlet may be obstructed, resulting in the projector getting warm and the possibility of fire and malfunction occurring.
- For vertical installation, install the projector with the air inlet (filter) facing downwards. A stand for supporting the projector needs to be made for this purpose. In this case, the stand must be designed such that the center of gravity of the projector is located well within the legs of the stand. If not, the projector may fall over and result in injury, damage and malfunction.
- Do not use the lens shift function when performing portrait projection. Use the position of the lens shift mechanism in the center (lens center).

**NOTE:**

- The lamp replacement time (as a guide) * is about 2000 hours for portrait projection.
  
  * Replacement time is not guaranteed.
- When installing in a portrait configuration for the first time, portrait projection cannot be used when the number of lamp hours used shown under [INFO.] → [USAGE TIME] → [LAMP HOURS USED] in the on-screen menu exceeds 1900 hours.
- When the [FAN MODE] is set to a mode other than [AUTO], portrait projection cannot be used.

**Design and manufacturing conditions for the stand**

Please engage an installation service provider for the design and manufacture of the customized stand to be used for portrait projection. Please ensure that the following are complied with when designing the stand.

1. Maintain an opening of at least 310 × 170 mm so as not to obstruct the air inlet / filter of the projector.
2. Maintain a distance of at least 130 mm between the projector air inlet and the floor (for the opening of the filter cover).
3. Use the four screw holes at the back of the projector to secure it to the stand.
   - Screw hole center dimension: 200 × 250 mm
   - Screw hole dimension on the projector: M4 with a maximum depth of 8 mm.
   * Please design the stand such that the rear legs at the back of the projector do not contact the stand. The front legs can be turned and removed.
4. Horizontal adjustment mechanism (for example, bolts and nuts in four locations)
5. Please design the stand such that it does not topple over easily.
Reference drawings

* The drawing showing the dimensional requirements is not an actual stand design drawing.

![Reference drawings diagram]

Lens shift securing method

1. **Pull the securing lever cover towards you to remove it.**
   - The cover cannot be detached from the projector.

2. **Turn the screws to the left to loosen them.**
   - Screws cannot be removed.
3. Slide the securing lever towards the top until it comes to a stop and then turn the screws to the right to tighten them.
   • Tighten the screws while pressing the securing lever towards the top.
   • Loosen the screws first before re-adjusting the lens shift.

4. Fix the four securing lever covers.

NOTE:
• Determine the screen position first before using the securing levers.
• Do not turn the zoom ring when using the securing lever. Please do not remove the lens either.
• The securing lever is used to support the lens and not to secure the lens. As a result, the screen may shift when the lens is touched.
Connecting to a Wired LAN

The projector comes standard with a Ethernet/HDBaseT port (RJ-45) which provides a LAN connection using a LAN cable. To use a LAN connection, you are required to set the LAN on the projector menu. Select [SETUP] → [NETWORK SETTINGS] → [WIRED LAN]. (→ page 107).

Example of LAN connection

Example of wired LAN connection

NOTE: Use a Category 5 or higher LAN cable.
7. Maintenance

This section describes the simple maintenance procedures you should follow to clean the filters, the lens, the cabinet, and to replace the lamp and the filters.

1 Cleaning the Filters

The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter is dirty or clogged, your projector may overheat.

⚠️ WARNING

- Please do not use a spray containing flammable gas to remove dust attached to the filters, etc. Doing so may result in fires.

**NOTE:** The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is displayed, clean the filters. The time to clean the filters is set to [OFF] at time of shipment. (→ page 95)

To cancel the message, press any button on the projector cabinet or the remote control.

The two-layer filter on the projector improves cooling and dust-proof capabilities compared with the conventional models.

The outsides (intake side) of the first and second layer filters remove dust.

To clean the filter, detach the filter unit and the filter cover.

⚠️ CAUTION

- Before cleaning the filters, turn off the projector, disconnect the power cord and then allow the cabinet to cool. Failure to do so can result in electric shock or burn injuries.

1. Press down on the buttons on the left and right and then pull the filter cover towards you to open it.
   The cover will open about 90 degrees before it stops.

When mounting the projector to a ceiling

The filter cover will open about 90 degrees before it comes to a stop at the stopper position. Remove your hands as the stopper will be detached if it is opened further. The filter cover will stop at a position of about 90 degrees.

However, the filter cover may close if the projector vibrates.
2. Remove the filter unit by pulling out the tab.

3. Remove the four filters.
   Hold and remove the filters fitted to the two sides of the filter unit.

4. Use a vacuum cleaner to vacuum all the dust inside.
   Get rid of dust in the filter.

   NOTE:
   - Whenever you vacuum the filter, use the soft brush attachment to vacuum. This is to avoid damage to the filter.
   - Do not wash the filter with water. Doing so can result in filter clogging.

5. Remove the dust on the front and back of the filter unit.
   - Please also remove all dust from the filter cover of the projector.
6. Attach 4 new filters to both sides of the filter unit.
   The installation locations of the filters are differentiated by whether there are any slits (notches). Install the filter under the flange around the filter unit as follows.

   (1) Attach the 2 filters with transparent frames fitted to the grips to the side of the filter unit where the knob is located.

   • Turn over the side of the filter with the transparent box and then install it.

   (2) Attach the 2 filters with the black lines to the side of the filter unit where there is no knob.

   • Turn over the side of the filter with the black line, and then insert the slits into the protrusions on the filter unit to install it.

7. Mount the filter unit back onto the projector cabinet.
   Insert the filter unit onto the projector with the sides on which the left and right hooks are located on the outside.

8. Close the filter cover.
   After closing, push the filter cover near the buttons until a “click” sound is heard. The filter cover will be secured in position.

9. Clear the filter usage hours.
   Plug the power cord into the wall outlet, and then turn on the projector.

   From the menu, select [RESET] → [CLEAR FILTER HOURS].
   (→ page 117)

   The interval time to clean the filters is set to [OFF] at time of shipment. When using the projector as it is, you do not clear the filter usage.
2 Cleaning the Lens

- Turn off the projector before cleaning.
- The projector has a plastic lens. Use a commercially available plastic lens cleaner.
- Do not scratch or mar the lens surface as a plastic lens is easily scratched.
- Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

⚠️ WARNING
- Please do not use a spray containing flammable gas to remove dust attached to the lens, etc. Doing so may result in fires.

3 Cleaning the Cabinet

Turn off the projector, and unplug the projector before cleaning.
- Use a dry soft cloth to wipe dust off the cabinet.
  - If heavily soiled, use a mild detergent.
- Never use strong detergents or solvents such as alcohol or thinner.
- When cleaning the ventilation slits or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner into the slits of the cabinet.

Vacuum the dust off the ventilation slits.

- Clogged ventilation slits may cause a rise in the internal temperature of the projector, resulting in malfunction.
- Do not scratch or hit the cabinet with your fingers or any hard objects
- Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the lens, or the screen. Do not leave a rubber or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off.
Replacing the Lamp and the Filters

When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER. USE THE SPECIFIED LAMP FOR SAFETY AND PERFORMANCE.” will appear (*). Even though the lamp may still be working, replace the lamp to maintain the optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter. (→ page 116)

⚠️ CAUTION

• DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

• Use the specified lamp for safety and performance.

• DO NOT REMOVE ANY SCREWS except one lamp cover screw and two lamp housing screws. You could receive an electric shock.

• Do not break the glass on the lamp housing.
  Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause an unwanted shadow and poor picture quality.

• The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
• for one minute after the projector has been powered on
• when the (POWER) button on the projector cabinet or the STANDBY button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:
• Phillips screwdriver (plus-head)
• Replacement lamp:
  NP26LP

Flow of Replacing the Lamp and the Filters

Step 1. Replace the lamp

Step 2. Replace the filters (→ page 145)

Step 3. Clear the lamp usage hours and the filter usage hours (→ page 116, 117)
To replace the lamp:

1. **Remove the lamp cover.**
   (1) Loosen the lamp cover screw
   • The lamp cover screw is not removable.
   (2) Pull the bottom of the lamp cover towards you and remove it.

2. **Remove the lamp housing.**
   (1) Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condition.
   • The two screws are not removable.
   • There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this interlock.
   (2) Remove the lamp housing by holding it.

⚠️ **CAUTION:**
Make sure that the lamp housing is cool enough to before removing it.
3. Install a new lamp housing.

(1) Insert a new lamp housing until the lamp housing is plugged into the socket.
(2) Position so that the guide hole in the bottom right of the lamp house is over the protrusion on the projector then press all the way in.
(3) Secure it in place with the two screws.
   - Be sure to tighten the screws.

4. Reattach the lamp cover.

(1) Insert the top edge of the lamp cover into the groove in the projector and close the lamp cover.
(2) Tighten the screw to secure the lamp cover.
   - Be sure to tighten the screw.

This completes the lamp replacement.
Go on to the filter replacement.

NOTE:
- When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector cannot turn on and the menu is not displayed. If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. When the lamp time clock is reset to zero, the LAMP indicator goes out.
- For portrait projection, the power supply will be switched off when the lamp replacement time (estimated)* is reached. A lamp replacement message will be displayed 100 hours before the lamp replacement time is reached.

* The replacement time is not guaranteed.
To replace the filters:
Four filters are packaged with the replacement lamp.
Honeycomb filter (coarse mesh): Large and small sizes (attached to the outside of the filter unit)
Accordian filter (fine mesh): Large and small sizes (attached to the inside of the filter unit)

NOTE:
• Replace all four filters at the same time.
• Before replacing the filters, wipe off dust and dirt from the projector cabinet.
• The projector is precision equipment. Keep out dust and dirt during filter replacement.
• Do not wash the filters with soap and water. Soap and water will damage the filter membrane.
• Put filters into place. Incorrect attachment of a filter may cause dust and dirt to get into the inside of the projector.

Before replacing the filters, replace the lamp. (→ page 143)

1. Press down on the buttons on the left and right and then pull the filter cover towards you to open it.
   The cover will open about 90 degrees before it stops.
   **When mounting the projector to a ceiling**
   The filter cover will open about 90 degrees before it comes to a stop at the stopper position. Remove your hands as the stopper will be detached if it is opened further. The filter cover will stop at a position of about 90 degrees.
   However, the filter cover may close if the projector vibrates.

2. Remove the filter unit by pulling out the tab.
3. **Remove the four filters.**
   Hold onto the filters fitted to both sides of the filter unit to remove the filter unit.

4. **Remove dust from the filter unit and the filter cover.**
   Clean both outside and inside.

5. **Attach 4 new filters to both sides of the filter unit.**
   The installation locations of the filters are differentiated by whether there are any slits (notches). Install the filter under the flange around the filter unit as follows.
   (1) Attach the 2 filters with transparent frames fitted to the grips to the side of the filter unit where the knob is located.
      • Turn over the side of the filter with the transparent box and then install it.
   (2) Attach the 2 filters with the black lines to the side of the filter unit where there is no knob.
      • Turn over the side of the filter with the black line, and then insert the slits into the protrusions on the filter unit to install it.

6. **Mount the filter unit back onto the projector cabinet.**
   Insert the filter unit onto the projector with the sides on which the left and right hooks are located on the outside.

7. **Close the filter cover.**
   After closing, push the filter cover near the buttons until a “click” sound is heard. The filter cover will be secured in position.

   This completes the filter replacement.
   Go on to the clearing lamp and filter hour meters.

To clear the lamp usage hours and the filter usage hours:
1. **Place the projector where you use it.**
2. **Plug the power cord into the wall outlet, and then turn on the projector.**
3. **Clear the lamp usage hours and the filter usage hours.**
   1. From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.
   2. Select [CLEAR FILTER HOURS] and reset the filter usage hours. (→ page 117)
## 8. User Supportware

### 1. Operating Environment for Software Included on CD-ROM

#### Names and Features of Bundled Software Programs

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Remote Tool</td>
<td>When the computer and projector are connected using a network (wired LAN), such operations as turning the projector’s power on and off and switching the signal can be performed. It is also possible to send an image to the projector and register it as the background logo. Once the image is registered, it can be locked to prevent the logo from being overwritten.</td>
</tr>
<tr>
<td>PC Control Utility Pro 4</td>
<td>This is a software program used to operate the projector from the computer when the computer and the projector are connected with LAN. (→ page 137)</td>
</tr>
<tr>
<td>PC Control Utility Pro 5 (for Mac OS)</td>
<td>• PC Control Utility Pro 4 can be used with a serial connection.</td>
</tr>
</tbody>
</table>

* The following three software on the CD-ROM cannot be used in this device. Image Express Utility Lite (for Windows/Mac OS), Image Express Utility 2.0 (for Windows) and Desktop Control Utility 1.0 (for Windows)

**Download service**

For the update information about these software programs, visit our website:


**Operating Environment**

The following is the operating environment for Image Express Utility Lite. For the operating environment of other software program, refer to the help function of each software program.

#### [Windows]

<table>
<thead>
<tr>
<th>Supported OS</th>
<th>Windows 8 (Core Edition)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 8 Pro</td>
</tr>
<tr>
<td></td>
<td>Windows 8 Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Basic</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Premium</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Ultimate</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Basic</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Premium</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Business</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Ultimate</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows XP Home Edition (32-bit version) Service Pack 3 or later</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional (32-bit version) Service Pack 3 or later</td>
</tr>
<tr>
<td></td>
<td>• Windows power-saving function is not supported.</td>
</tr>
<tr>
<td></td>
<td>• To use the audio transfer capability, Windows 8/Windows 7/Windows Vista Service Pack 1 or later is required.</td>
</tr>
</tbody>
</table>

#### [Mac]

| Supported OS | Mac OS X v10.6, v10.7, v10.8 |

147
## 2 Installing Software Program

### Installation for Windows software

The software programs except PC Control Utility Pro 5 support Windows 8, Windows 7, Windows Vista, and Windows XP.

**NOTE:**
- To install or uninstall each software program, the Windows user account must have “Administrator” privilege (Windows 8, Windows 7, Windows Vista) or “Computer Administrator” privilege (Windows XP).
- Exit all running programs before installation. If another program is running, the installation may not be completed.

### 1 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.

The menu window will be displayed.

**TIP:**
If the menu window will not be displayed, try the following procedure.
For Windows 7
1. **Click “start” on Windows.**
2. **Click “All Programs” → “Accessories” → “Run”**.
3. **Type your CD-ROM drive name (example: “Q:”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)**
4. **Click “OK”.**

   The menu window will be displayed.
2 Click a software program you wish to install on the menu window. The installation will start.

- Follow the instructions on the installer screens to complete the installation.

**TIP:**

**Uninstalling a Software Program**

**Preparation:**
Exit the software program before uninstalling. To uninstall the software program, the Windows user account must have “Administrator” privilege (Windows 8, Windows 7, and Windows Vista) or “Computer Administrator” privilege (Windows XP).

- **For Windows 8/Windows 7/Windows Vista**
  1. Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2. Click “Uninstall a program” under “Programs”.
     The “Programs and Features” window will be displayed.
  3. **Select the software program and click it.**
  4. **Click “Uninstall/Change” or “Uninstall”.**
     - When the “User Account Control” windows is displayed, click “Continue”.
     - Follow the instructions on the screens to complete the uninstallation.

- **For Windows XP**
  1. Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2. **Double-click “Add / Remove Programs”**.
     The Add / Remove Programs window will be displayed.
  3. **Click the software program from the list and then click “Remove”**.
     Follow the instructions on the screens to complete the uninstallation.
Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer.

1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.
2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.
3. Double-click the “Mac OS X” folder.
4. Double-click “PC Control Utility.mpkg”.
   The installer will start.
5. Click “Next”.
   “END USER LICENSE AGREEMENT” screen will be displayed.
6. Read “END USER LICENSE AGREEMENT” and click “Next”.
   The confirmation window will be displayed.
7. Click “I accept the terms in the license agreement”.
   Follow the instructions on the installer screens to complete the installation.

TIP:

• Uninstalling a software program
1. Put the “PC Control Utility Pro 5” folder to the Trash icon.
2. Put the configuration file of PC Control Utility Pro 5 to the Trash icon.
   • The configuration file of PC Control Utility Pro 5 is located in “/Users/<your user name>/Application Data/NEC Projector User Supportware/PC Control Utility Pro 5”.
Operating the Projector Via the LAN (Virtual Remote Tool)

This will help you perform operations such as projector's power on or off and signal selection via a LAN connection. It is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote control operation on your PC.

Virtual Remote screen
Remote Control Window
Toolbar

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 153)

NOTE:
• Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
  (Only via serial or LAN connection)
  * File size: Within 256 kilobytes
  * Image size: Within the resolution of the projector
  * File format: PNG (Full color)
• Logo data (image) sent using the Virtual Remote Tool will be displayed in the center with the surrounding area in black.
• To put the default “NEC logo” back in the background logo, you need to register it as the background logo by using the image file (PA622U/NP-PA522U: Logo\necpj_bbwux.png, PA672W/PA572W: Logo\necpj_bbwx.png, PA722X/NP-PA622X: Logo\necpj_bb_x.png) included on the supplied NEC Projector CD-ROM.
Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 137) and “9. Controlling the Projector by Using an HTTP Browser” (→ page 42)

Start Virtual Remote Tool
Start using the shortcut icon
• Double-click the shortcut icon on the Windows Desktop.

Start from the Start menu
• Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] → [Virtual Remote Tool].
When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

Follow the instructions on the screens
When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

NOTE:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via network connection.

TIP:
• The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window.
To do so, click to place a check mark for “Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.
8. User Supportware

Exiting Virtual Remote Tool

1. **Click the Virtual Remote Tool icon on the Taskbar.**
   The pop-up menu will be displayed.

2. **Click “Exit”.**
   The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool

• Displaying the help file using the taskbar

1. **Click the Virtual Remote Tool icon on the taskbar when Virtual Remote Tool is running.**
   The pop-up menu will be displayed.

2. **Click “Help”.**
   The Help screen will be displayed.

• Displaying the help file using the Start Menu.

1. **Click “Start”, “All programs” or “Programs”, “NEC Projector User Supportware”, “Virtual Remote Tool”, and then “Virtual Remote Tool Help” in this order.**
   The Help screen will be displayed.
### Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5)

Using the utility software “PC Control Utility Pro 4” or “PC Control Utility Pro 5” included on the companion NEC Projector CD-ROM, the projector can be controlled from a computer over a LAN.

PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 157)

<table>
<thead>
<tr>
<th>Control Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event schedule.</td>
</tr>
</tbody>
</table>

**Screen of PC Control Utility Pro 4**

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 156, 157)

1. **Step 1:** Install PC Control Utility Pro 4/Pro 5 on the computer.
2. **Step 2:** Connect the projector to a LAN.
3. **Step 3:** Start PC Control Utility Pro 4/Pro 5.

- To run PC Control Utility Pro 4 on Windows 8, Windows XP Home Edition and Windows XP Professional, “Microsoft .NET Framework” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install the it on your computer.

**TIP:**
- **PC Control Utility Pro 4** can be used with a serial connection.

#### Using on Windows

**Step 1:** Install PC Control Utility Pro 4 on the computer

**NOTE:**
- To install or uninstall the program, the Windows user account must have [Administrator] privilege (Windows 8, Windows 7, Windows Vista and Windows XP)
- Exit all running programs before installation. If another program is running, the installation may not be completed.

1. **Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.**
   The menu window will be displayed.
TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. Click “start” on Windows.
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
4. Click “OK”.
the menu window will be displayed.

2 Click “PC Control Utility Pro 4” on the menu window.
The installation will start.

When the installation is complete, the Welcome window will be displayed.

3 Click “Next”.
“END USER LICENSE AGREEMENT” screen will be displayed.

Read “END USER LICENSE AGREEMENT” carefully.

4 If you agree, click “I accept the terms in the license agreement” and then click “Next”.
• Follow the instructions on the installer screens to complete the installation.
• When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling a Software Program”. (→ page 149)
Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 137) and “9. Controlling the Projector by Using an HTTP Browser” (→ page 42)

Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4”.

NOTE:
• For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the scheduler.
[Example] For Windows 7:
Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer to sleep” → “Never”.
NOTE:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN) connection.

TIP:
Viewing the Help of PC Control Utility Pro 4
• Displaying the Help file of PC Control Utility Pro 4 while it is running.
  Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.
  The pop-up menu will be displayed.

• Displaying the help file using the Start Menu.
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4 Help”.
  The Help screen will be displayed.
Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer

1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.
2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.
3. Double-click the “Mac OS X” folder.
4. Double-click “PC Control Utility.mpkg”.
   The installer will start.
5. Click “Next”.
   “END USER LICENSE AGREEMENT” screen will be displayed.
6. Read “END USER LICENSE AGREEMENT” and click “Next”.
   The confirmation window will be displayed.
7. Click “I accept the terms in the license agreement”.
   Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 137) and “Controlling the Projector by Using an HTTP Browser” (→ page 42)

Step 3: Start PC Control Utility Pro 5

1. Open your Applications folder in Mac OS.
2. Click the “PC Control Utility Pro 5” folder.
3. Click the “PC Control Utility Pro 5” icon.
   PC Control Utility Pro 5 will start.

NOTE:
• For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN) connection.

TIP:
Viewing the Help of PC Control Utility Pro 5
• Displaying the Help file of PC Control Utility Pro 5 while it is running.
  From the menu bar, click “Help” → “Help” in this order.
  The Help screen will be displayed.
• Displaying the Help using the Dock
  1. Open “Application Folder” in Mac OS.
  2. Click the “PC Control Utility Pro 5” folder.
  3. Click the “PC Control Utility Pro 5 Help” icon.
     The Help screen will be displayed.
Appendix

Throw distance and screen size

Six separate bayonet style lenses can be used on this projector. Refer to the information on this page and use a lens suited for the installation environment (screen size and throw distance). For instructions on mounting the lens, see page 123.

Lens types and throw distance

**PA722X/PA622X**

<table>
<thead>
<tr>
<th>Screen size</th>
<th>NP11FL</th>
<th>NP30ZL</th>
<th>NP12ZL</th>
<th>NP13ZL</th>
<th>NP14ZL</th>
<th>NP15ZL</th>
</tr>
</thead>
<tbody>
<tr>
<td>30”</td>
<td></td>
<td></td>
<td>0.7 - 0.9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40”</td>
<td>0.6</td>
<td></td>
<td>0.9 - 1.2</td>
<td>1.2 - 2.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>60”</td>
<td>1.0</td>
<td>1.0 - 1.3</td>
<td>1.4 - 1.9</td>
<td>1.8 - 3.7</td>
<td>3.6 - 5.8</td>
<td>5.7 - 8.7</td>
</tr>
<tr>
<td>80”</td>
<td>1.3</td>
<td>1.3 - 1.7</td>
<td>1.9 - 2.5</td>
<td>2.4 - 4.9</td>
<td>4.8 - 7.8</td>
<td>7.6 - 11.6</td>
</tr>
<tr>
<td>100”</td>
<td>1.6</td>
<td>1.6 - 2.1</td>
<td>2.4 - 3.2</td>
<td>3.0 - 6.1</td>
<td>6.0 - 9.7</td>
<td>9.6 - 14.6</td>
</tr>
<tr>
<td>120”</td>
<td>2.0</td>
<td>2.0 - 2.6</td>
<td>2.9 - 3.8</td>
<td>3.7 - 7.4</td>
<td>7.3 - 11.7</td>
<td>11.5 - 17.6</td>
</tr>
<tr>
<td>150”</td>
<td>2.5</td>
<td>2.5 - 3.2</td>
<td>3.7 - 4.8</td>
<td>4.6 - 9.2</td>
<td>9.1 - 14.7</td>
<td>14.4 - 22.0</td>
</tr>
<tr>
<td>200”</td>
<td>3.3</td>
<td>3.3 - 4.3</td>
<td>4.9 - 6.4</td>
<td>6.1 - 12.3</td>
<td>12.2 - 19.6</td>
<td>19.3 - 29.4</td>
</tr>
<tr>
<td>240”</td>
<td>4.0</td>
<td>4.0 - 5.2</td>
<td>5.2 - 7.7</td>
<td>7.4 - 14.8</td>
<td>14.7 - 23.6</td>
<td>23.2 - 35.3</td>
</tr>
<tr>
<td>300”</td>
<td>5.0</td>
<td>5.0 - 6.5</td>
<td>7.4 - 9.6</td>
<td>9.2 - 18.5</td>
<td>18.4 - 29.5</td>
<td>29.1 - 44.2</td>
</tr>
<tr>
<td>400”</td>
<td>6.7</td>
<td>6.7 - 7.7</td>
<td>9.8 - 12.8</td>
<td>12.3 - 24.7</td>
<td>24.6 - 39.4</td>
<td>38.8 - 59.0</td>
</tr>
<tr>
<td>500”</td>
<td>8.4</td>
<td>8.4 - 10.9</td>
<td>12.3 - 16.0</td>
<td>15.4 - 30.8</td>
<td>30.7 - 49.2</td>
<td>48.6 - 73.8</td>
</tr>
</tbody>
</table>

**TIP**

Calculation of the throw distance from the screen size

NP11FL lens throw distance (m) = H × 0.8 : 0.6 m (min.) to 2.5 m (max.)
NP30ZL lens throw distance (m) = H × 0.8 to H × 1.1 : 1.0 m (min.) to 10.9 m (max.)
NP12ZL lens throw distance (m) = H × 1.2 to H × 1.6 : 0.7 m (min.) to 16.0 m (max.)
NP13ZL lens throw distance (m) = H × 1.5 to H × 3.0 : 1.2 m (min.) to 30.8 m (max.)
NP14ZL lens throw distance (m) = H × 3.0 to H × 4.8 : 3.6 m (min.) to 49.2 m (max.)
NP15ZL lens throw distance (m) = H × 4.7 to H × 7.3 : 5.7 m (min.) to 73.8 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 150” screen with the PA722X/PA622X using the NP13ZL lens:

According to the “Screen Size (for reference)” table (→ page 161), H (screen width) = 304.8 cm.

The throw distance is 304.8 cm × 1.5 to 304.8 cm × 3.0 = 457.2 cm to 914.4 cm (because of the zoom lens).
9. Appendix

PA672W/PA572W

<table>
<thead>
<tr>
<th>Screen size</th>
<th>Lens model name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NP11FL</td>
</tr>
<tr>
<td>30&quot;</td>
<td>0.7 - 1.0</td>
</tr>
<tr>
<td>40&quot;</td>
<td>0.7</td>
</tr>
<tr>
<td>60&quot;</td>
<td>1.0</td>
</tr>
<tr>
<td>80&quot;</td>
<td>1.4</td>
</tr>
<tr>
<td>100&quot;</td>
<td>1.7</td>
</tr>
<tr>
<td>120&quot;</td>
<td>2.1</td>
</tr>
<tr>
<td>150&quot;</td>
<td>2.6</td>
</tr>
<tr>
<td>200&quot;</td>
<td>3.4 - 4.5</td>
</tr>
<tr>
<td>240&quot;</td>
<td>4.1 - 5.4</td>
</tr>
<tr>
<td>300&quot;</td>
<td>5.2 - 6.8</td>
</tr>
<tr>
<td>400&quot;</td>
<td>6.9 - 9.0</td>
</tr>
<tr>
<td>500&quot;</td>
<td>8.7 - 11.3</td>
</tr>
</tbody>
</table>

**TIP**

Calculation of the throw distance from the screen size

NP11FL lens throw distance (m) = \( H \times 0.8 \) : 0.7 m (min.) to 2.6 m (max.)

NP30ZL lens throw distance (m) = \( H \times 0.8 \) to \( H \times 1.0 \) : 1.0 m (min.) to 11.3 m (max.)

NP12ZL lens throw distance (m) = \( H \times 1.2 \) to \( H \times 1.5 \) : 0.7 m (min.) to 16.7 m (max.)

NP13ZL lens throw distance (m) = \( H \times 1.5 \) to \( H \times 3.0 \) : 1.2 m (min.) to 31.9 m (max.)

NP14ZL lens throw distance (m) = \( H \times 2.9 \) to \( H \times 4.7 \) : 3.7 m (min.) to 50.9 m (max.)

NP15ZL lens throw distance (m) = \( H \times 4.6 \) to \( H \times 7.1 \) : 5.9 m (min.) to 76.4 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 150" screen with the PA672W/PA572W using the NP13ZL lens:

According to the “Screen Size (for reference)” table (→ page 161), \( H \) (screen width) = 323.1 cm.

The throw distance is \( 323.1 \text{ cm} \times 1.5 \) to \( 323.1 \text{ cm} \times 3.0 \) = 484.7 cm to 969.3 cm (because of the zoom lens).

PA622U/PA522U

<table>
<thead>
<tr>
<th>Screen size</th>
<th>Lens model name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NP11FL</td>
</tr>
<tr>
<td>30&quot;</td>
<td>0.7 - 0.9</td>
</tr>
<tr>
<td>40&quot;</td>
<td>0.7</td>
</tr>
<tr>
<td>60&quot;</td>
<td>1.0</td>
</tr>
<tr>
<td>80&quot;</td>
<td>1.4</td>
</tr>
<tr>
<td>100&quot;</td>
<td>1.7</td>
</tr>
<tr>
<td>120&quot;</td>
<td>2.1</td>
</tr>
<tr>
<td>150&quot;</td>
<td>2.6</td>
</tr>
<tr>
<td>200&quot;</td>
<td>3.4 - 4.5</td>
</tr>
<tr>
<td>240&quot;</td>
<td>4.1 - 5.4</td>
</tr>
<tr>
<td>300&quot;</td>
<td>5.2 - 6.8</td>
</tr>
<tr>
<td>400&quot;</td>
<td>6.9 - 9.0</td>
</tr>
<tr>
<td>500&quot;</td>
<td>8.7 - 11.3</td>
</tr>
</tbody>
</table>

**TIP**

Calculation of the throw distance from the screen size

NP11FL lens throw distance (m) = \( H \times 0.8 \) : 0.5 m (min.) to 2.6 m (max.)

NP30ZL lens throw distance (m) = \( H \times 0.8 \) to \( H \times 1.0 \) : 1.0 m (min.) to 11.3 m (max.)

NP12ZL lens throw distance (m) = \( H \times 1.2 \) to \( H \times 1.5 \) : 0.7 m (min.) to 16.5 m (max.)

NP13ZL lens throw distance (m) = \( H \times 1.5 \) to \( H \times 3.0 \) : 1.2 m (min.) to 31.9 m (max.)

NP14ZL lens throw distance (m) = \( H \times 2.9 \) to \( H \times 4.7 \) : 3.7 m (min.) to 50.9 m (max.)

NP15ZL lens throw distance (m) = \( H \times 4.6 \) to \( H \times 7.1 \) : 5.9 m (min.) to 76.4 m (max.)

“H” (Horizontal) refers to the screen width.

* Figures differ by several % with the table above because the calculation is approximate.

Ex.: Throw distance when projecting on a 150" screen with the PA622U/PA522U using the NP13ZL lens:

According to the “Screen Size (for reference)” table (→ page 161), \( H \) (screen width) = 323.1 cm.

The throw distance is 323.1 cm × 1.5 to 323.1 cm × 3.0 = 484.7 cm to 969.3 cm (because of the zoom lens).
Projection range for the different lenses

**NP11FL**
- NP-PA622U/NP-PA522U: 0.7–2.6 m
- NP-PA672W/NP-PA572W: 0.7–2.6 m
- NP-PA722X/NP-PA622X: 0.6–2.5 m

**NP30ZL**
- NP-PA622U/NP-PA522U: 1.0–11.3 m
- NP-PA672W/NP-PA572W: 1.0–11.3 m
- NP-PA722X/NP-PA622X: 1.0–10.9 m

**NP12ZL**
- NP-PA622U/NP-PA522U: 0.7–2.6 m
- NP-PA672W/NP-PA572W: 0.7–2.6 m
- NP-PA722X/NP-PA622X: 0.6–2.5 m

**NP13ZL**
- NP-PA622U/NP-PA522U: 1.2–31.9 m
- NP-PA672W/NP-PA572W: 1.2–32.1 m
- NP-PA722X/NP-PA622X: 1.2–30.8 m

**NP14ZL**
- NP-PA622U/NP-PA522U: 3.7–50.9 m
- NP-PA672W/NP-PA572W: 3.7–51.2 m
- NP-PA722X/NP-PA622X: 3.6–49.2 m

**NP15ZL**
- NP-PA622U/NP-PA522U: 5.9–76.4 m
- NP-PA672W/NP-PA572W: 5.9–76.9 m
- NP-PA722X/NP-PA622X: 5.7–73.8 m
### Tables of screen sizes and dimensions

#### PA722X/PA622X

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (inches)</th>
<th>Screen height (inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>24</td>
<td>61.0</td>
</tr>
<tr>
<td>40</td>
<td>32</td>
<td>81.3</td>
</tr>
<tr>
<td>60</td>
<td>48</td>
<td>121.9</td>
</tr>
<tr>
<td>80</td>
<td>64</td>
<td>162.6</td>
</tr>
<tr>
<td>100</td>
<td>80</td>
<td>203.2</td>
</tr>
<tr>
<td>120</td>
<td>96</td>
<td>243.8</td>
</tr>
<tr>
<td>150</td>
<td>120</td>
<td>304.8</td>
</tr>
<tr>
<td>200</td>
<td>160</td>
<td>406.4</td>
</tr>
<tr>
<td>240</td>
<td>192</td>
<td>487.7</td>
</tr>
<tr>
<td>300</td>
<td>240</td>
<td>609.6</td>
</tr>
<tr>
<td>400</td>
<td>320</td>
<td>812.8</td>
</tr>
<tr>
<td>500</td>
<td>400</td>
<td>1016.0</td>
</tr>
</tbody>
</table>

#### PA622U/PA522U/PA672W/PA572W

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (inches)</th>
<th>Screen height (inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>25.4</td>
<td>64.6</td>
</tr>
<tr>
<td>40</td>
<td>33.9</td>
<td>86.2</td>
</tr>
<tr>
<td>60</td>
<td>50.9</td>
<td>129.2</td>
</tr>
<tr>
<td>80</td>
<td>67.8</td>
<td>172.3</td>
</tr>
<tr>
<td>100</td>
<td>84.8</td>
<td>215.4</td>
</tr>
<tr>
<td>120</td>
<td>101.8</td>
<td>258.5</td>
</tr>
<tr>
<td>150</td>
<td>127.2</td>
<td>323.1</td>
</tr>
<tr>
<td>200</td>
<td>169.6</td>
<td>430.8</td>
</tr>
<tr>
<td>240</td>
<td>203.5</td>
<td>516.9</td>
</tr>
<tr>
<td>300</td>
<td>254.4</td>
<td>646.2</td>
</tr>
<tr>
<td>400</td>
<td>339.2</td>
<td>861.6</td>
</tr>
<tr>
<td>500</td>
<td>424.0</td>
<td>1077.0</td>
</tr>
</tbody>
</table>
9. Appendix

**Lens shifting range**

This projector is equipped with a lens shift function for adjusting the position of the projected image by turning the lens shift dials. The lens can be shifted within the range shown below.

**NOTE:**
- The lens shift function cannot be used when using the NP11FL lens.
- Please do not use the lens shift function when projecting portrait images. Please use it with the lens in the center.

* Refer to the lens shift table on the next page for the drawing number of the lens shift range.

**Desk/front projection**

![Diagram of desk/front projection]

Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).

**Ceiling/front projector**

![Diagram of ceiling/front projector]
9. Appendix

### Lens shift table

<table>
<thead>
<tr>
<th>Applicable models</th>
<th>Drawing number</th>
<th>Lens unit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>NP30ZL</td>
</tr>
<tr>
<td>NP-PA622U/</td>
<td>①</td>
<td>50% V</td>
</tr>
<tr>
<td>NP-PA522U</td>
<td>②</td>
<td>10% V</td>
</tr>
<tr>
<td></td>
<td>③</td>
<td>20% H*</td>
</tr>
<tr>
<td></td>
<td>④</td>
<td>20% H*</td>
</tr>
<tr>
<td>NP-PA672W/</td>
<td>①</td>
<td>50% V</td>
</tr>
<tr>
<td>NP-PA572W</td>
<td>②</td>
<td>10% V</td>
</tr>
<tr>
<td></td>
<td>③</td>
<td>20% H</td>
</tr>
<tr>
<td></td>
<td>④</td>
<td>20% H</td>
</tr>
<tr>
<td>NP-PA722X/</td>
<td>①</td>
<td>35% V</td>
</tr>
<tr>
<td>NP-PA622X</td>
<td>②</td>
<td>10% V</td>
</tr>
<tr>
<td></td>
<td>③</td>
<td>20% H</td>
</tr>
<tr>
<td></td>
<td>④</td>
<td>20% H</td>
</tr>
</tbody>
</table>

* For PA622U/PA522U, the shift range in the horizontal direction is up to 15% H when using the lens unit “NP13ZL” to project a screen exceeding Model 150.

Ex.: When projecting on a 150” screen
The explanation is for a PA722X/PA622X projector (4:3 panel) with a NP12ZL lens fitted.
- Please replace the screen dimensions and maximum shift value in the calculations for the PA672W/PA572W and PA622U/PA522U projectors (16:10 panel) as well.

According to the tables of screen sizes and dimensions (→ page 161), H = 304.8 cm, V = 228.6 cm.
Adjustment range in the vertical direction: The projected image can be moved upwards 0.5 x 228.6 cm = 114 cm, downwards 0.1 x 228.6 cm = 22 cm (when the lens is at the center position). For a ceiling/front installation, the above figures are inverted.
Adjustment range in the horizontal direction: The projected image can be moved to the left 0.3 x 304.8 cm = 91 cm, to the right 0.3 x 304.8 cm = 91 cm.
* Figures differ by several % because the calculation is approximate.
## Compatible Input Signal List

### Analog Computer Signal

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>56/60/72/75/85/iMac</td>
</tr>
<tr>
<td>XGA</td>
<td>1920 × 1200 ^3</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>XGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>WXGA</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quadc-VGA</td>
<td>1280 × 768</td>
<td>4 : 3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60/72/75/85</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60/72/75/85</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA+</td>
<td>1600 × 1200 ^3</td>
<td>4 : 3</td>
<td>60/65/70/75</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080 ^3</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13&quot;</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16&quot;</td>
<td>832 × 624</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19&quot;</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21&quot;</td>
<td>1152 × 870 ^5</td>
<td>4 : 3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23&quot;</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>65</td>
</tr>
</tbody>
</table>

### Component Video/S-Video

<table>
<thead>
<tr>
<th>Signal</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>PAL</td>
<td>4 : 3</td>
<td>50</td>
</tr>
<tr>
<td>PAL60</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SECAM</td>
<td>4 : 3</td>
<td>50</td>
</tr>
</tbody>
</table>
### 9. Appendix

#### HDMI

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768 *1</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720 *2</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768 *2</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768 *5</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200 *3</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080 *3</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200 *3</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>2K</td>
<td>2048 × 1080</td>
<td>17 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WQHD</td>
<td>2560 × 1440</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WQXGA</td>
<td>2560 × 1600</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>4K</td>
<td>3840 × 2160</td>
<td>16 : 9</td>
<td>23.98/24/25/29.97/30</td>
</tr>
<tr>
<td></td>
<td>4096 × 2160</td>
<td>17 : 9</td>
<td>24</td>
</tr>
<tr>
<td>HDTV(1080p)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>24/25/30/50/60</td>
</tr>
<tr>
<td>HDTV(1080i)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>48/50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480i/p)</td>
<td>720/1440 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i/p)</td>
<td>720/1440 × 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

#### HDMI 3D

<table>
<thead>
<tr>
<th>Signal Resolution (dots)</th>
<th>Refresh Rate (Hz)</th>
<th>Aspect Ratio</th>
<th>3D Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 × 1080p</td>
<td>23.98/24</td>
<td>16 : 9</td>
<td>Frame Packing</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td></td>
<td>Side By Side</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td></td>
<td>Top and Bottom</td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td></td>
<td>Side By Side</td>
</tr>
<tr>
<td>1920 × 1080i</td>
<td>50</td>
<td></td>
<td>Top and Bottom</td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td></td>
<td>Side By Side</td>
</tr>
<tr>
<td>1280 × 720p</td>
<td>50</td>
<td></td>
<td>Frame Packing</td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td></td>
<td>Side By Side</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Top and Bottom</td>
</tr>
</tbody>
</table>
### DisplayPort

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
<td>15 : 9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366 × 768</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 × 960</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
<td>5 : 4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 × 900</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 × 1050</td>
<td>16 : 10</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
<td>4 : 3</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>2K</td>
<td>2048 × 1080</td>
<td>17 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WQHD</td>
<td>2560 × 1440</td>
<td>16 : 9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA*</td>
<td>2560 × 1600</td>
<td>16 : 10</td>
<td>60 (Reduced Blanking)</td>
</tr>
<tr>
<td>4K</td>
<td>3840 × 2160</td>
<td>16 : 9</td>
<td>23.98/24/25/29.97/30</td>
</tr>
<tr>
<td></td>
<td>4096 × 2160</td>
<td>17 : 9</td>
<td>24</td>
</tr>
<tr>
<td>HDTV(1080p)</td>
<td>1920 × 1080</td>
<td>16 : 9</td>
<td>24/25/30/50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280 × 720</td>
<td>16 : 9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480i/p)</td>
<td>720/1440 × 480</td>
<td>4:3 / 16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i/p)</td>
<td>720/1440 × 576</td>
<td>4:3 / 16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

*1 Native resolution on XGA model (PA722X/PA622X)
*2 Native resolution on WXGA model (PA672W/PA572W)
*3 Native resolution on WUXGA model (PA622U/PA522U)
*4 Approximate Value
*5 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].
*6 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [4:3] for [ASPECT RATIO].

**3D Format**
- Frame Packing
- Side By Side
- Top and Bottom
- Top and Bottom
- Top and Bottom
- Top and Bottom
- Top and Bottom
- Top and Bottom
- Frame Packing
- Frame Packing
- Frame Packing
- Frame Packing
- Frame Packing
- Frame Packing
- Frame Packing
- Frame Packing
- Frame Packing

**DisplayPort 3D**

<table>
<thead>
<tr>
<th>Signal Resolution (dots)</th>
<th>Refresh Rate (Hz)</th>
<th>Aspect Ratio</th>
<th>3D Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1920 × 1080p</td>
<td>23.98/24</td>
<td>16 : 9</td>
<td>Frame Packing</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>Top and Bottom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>100</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>120</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td>1920 × 1080i</td>
<td>25</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>Frame Packing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Frame Packing</td>
<td></td>
</tr>
<tr>
<td>1280 × 720p</td>
<td>25</td>
<td>Side By Side</td>
<td></td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>Frame Packing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>59.94/60</td>
<td>Frame Packing</td>
<td></td>
</tr>
</tbody>
</table>

* Native resolution on XGA model (PA722X/PA622X)
*2 Native resolution on WXGA model (PA672W/PA572W)
*3 Native resolution on WUXGA model (PA622U/PA522U)
*4 Approximate Value

- Signals exceeding the projector’s resolution are handled with Advanced AccuBlend.
- With Advanced AccuBlend, the size of characters and ruled lines may be uneven and colors may be blurred.
- Upon shipment, the projector is set for signals with standard display resolutions and frequencies, but adjustments may be required depending on the type of computer.
### Specifications

<table>
<thead>
<tr>
<th>Model name</th>
<th>PA622U/PA522U/PA672W/PA572W/PA722X/PA622X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Method</td>
<td>Three primary color liquid crystal shutter projection method</td>
</tr>
</tbody>
</table>

#### Specifications of main parts

<table>
<thead>
<tr>
<th>Liquid crystal panel</th>
<th>Size PA722X/PA622X: 0.79” (with MLA) × 3 (aspect ratio: 4:3)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PA672W/PA572W: 0.76” (with MLA) × 3 (aspect ratio: 16:10)</td>
</tr>
<tr>
<td></td>
<td>PA622U/PA522U: 0.76” (with MLA) × 3 (aspect ratio: 16:10)</td>
</tr>
<tr>
<td>Pixels (*)</td>
<td>PA722X/PA622X: 786,432 (1024 dots × 768 lines)</td>
</tr>
<tr>
<td></td>
<td>PA672W/PA572W: 1,024,000 (1280 dots × 800 lines)</td>
</tr>
<tr>
<td></td>
<td>PA622U/PA522U: 2,304,000 (1920 dots × 1200 lines)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Projection lenses</th>
<th>Zoom Manual (zoom range depends on lens)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Focus Manual</td>
</tr>
<tr>
<td></td>
<td>Lens shifting Manual</td>
</tr>
</tbody>
</table>

| Light source         | PA722X/PA672W/PA622U: 350 W AC lamp (264 W when Eco mode is on) |
|                      | PA622X/PA572W/PA522U: 330 W AC lamp (264 W when Eco mode is on) |

| Optical device       | Optical isolation by dichroic mirror, combining by dichroic prism |

| Light output (ECO OFF) | PA722X: 7200 lm, PA622X: 6200 lm, PA672W: 6700 lm, PA572W: 5700 lm, PA622U: 6200 lm, PA522U: 5200 lm |

<table>
<thead>
<tr>
<th>Contrast ratio (all white/all black)</th>
<th>PA722X/PA672W/PA622U: 6000:1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PA622X/PA572W/PA522U: 5000:1</td>
</tr>
</tbody>
</table>

| Screen size (throw distance) | 30” to 500” (throw distance depends on lens) |

| Color reproducibility | 10-bit color processing (approx. 1.07 billion colors) (*4) |

| Audio output          | Built-in 10W monaural speaker |

<table>
<thead>
<tr>
<th>Scanning frequency</th>
<th>Horizontal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Analog: 15 kHz, 24 to 100 kHz (24 kHz or greater for RGB inputs), conforming to VESA standards</td>
</tr>
<tr>
<td></td>
<td>Digital: 15 kHz, 24 to 153 kHz, conforming to VESA standards</td>
</tr>
<tr>
<td></td>
<td>Vertical</td>
</tr>
<tr>
<td></td>
<td>Analog: 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards</td>
</tr>
<tr>
<td></td>
<td>Digital: 24, 25, 30, 48 Hz, 50 to 85 Hz, 100, 120 Hz conforming to VESA standards</td>
</tr>
</tbody>
</table>

| Main adjustment functions | Manual zoom, manual focus, manual lens shift, input signal switching (HDMI1/HDMI2/DisplayPort/BNC/BNC(CV)/BNC(Y/C)/COMPUTER/HDBaseT), auto image adjustment, picture enlarging, picture position adjustment, muting (both video and audio), power on/standby, on-screen display/selection, etc. |

| Max. display resolution (horizontal x vertical) | Analog: 1920 × 1200 (handled with Advanced AccuBlend) Digital: 4096 × 2160 (handled with Advanced AccuBlend) |

<table>
<thead>
<tr>
<th>Input signals R,G,B,H,V</th>
<th>RGB: 0.7Vp-p/75Ω</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Y: 1.0Vp-p/75Ω (with Negative Polarity Sync)</td>
</tr>
<tr>
<td></td>
<td>Cb, Cr (Pb, Pr): 0.7Vp-p/75Ω</td>
</tr>
<tr>
<td></td>
<td>H/V Sync: 4.0Vp-p/TTL</td>
</tr>
<tr>
<td></td>
<td>Composite Sync: 4.0Vp-p/TTL</td>
</tr>
<tr>
<td></td>
<td>Sync on G: 1.0Vp-p/75Ω (with Sync)</td>
</tr>
<tr>
<td>Composite video</td>
<td>1.0Vp-p/75Ω</td>
</tr>
<tr>
<td></td>
<td>Y: 1.0Vp-p/75Ω</td>
</tr>
<tr>
<td></td>
<td>C: 1.0Vp-p/75Ω</td>
</tr>
<tr>
<td>Component</td>
<td>1.0Vp-p/75Ω (with Sync)</td>
</tr>
<tr>
<td></td>
<td>Cb, Cr (Pb, Pr): 0.7Vp-p/75Ω</td>
</tr>
<tr>
<td></td>
<td>DTV: 480i, 480p, 720p, 1080i, 1080p (60Hz)</td>
</tr>
<tr>
<td></td>
<td>576i, 576p, 720p, 1080i (50Hz)</td>
</tr>
<tr>
<td></td>
<td>DVD: Progressive signal (50/60Hz)</td>
</tr>
<tr>
<td>Audio</td>
<td>0.5Vrms/22kΩ or greater</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input/output connectors</th>
<th>Computer/Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video input</td>
<td>Mini D-Sub 15-pin × 1, BNC connector × 5</td>
</tr>
<tr>
<td>Audio input</td>
<td>Stereo mini jack × 2</td>
</tr>
<tr>
<td>Audio output</td>
<td>Stereo mini jack × 1 (common for all signals)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HDMI Video input</th>
<th>HDMI® Connector type A × 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Deep Color (color depth): 8/10/12-bit compatible</td>
</tr>
<tr>
<td></td>
<td>Colorimetry: RGB, YCbCr444 and YCbCr422 compatible</td>
</tr>
<tr>
<td></td>
<td>LipSync compatible, HDCP compatible (*5), Supports 4K and 3D</td>
</tr>
<tr>
<td>Video output</td>
<td>Repeater</td>
</tr>
<tr>
<td>Audio input</td>
<td>HDMI: Sampling frequency ~ 32/44.1/48 kHz, Sampling bits ~ 16/20/24 bits</td>
</tr>
</tbody>
</table>

| HDBaseT Video input     | Deep Color (color depth): Support 8/10/12 bits |
|-------------------------| Colorimetry: Support RGB, YCbCr444 and YCbCr422 |
|                         | Support LipSync , HDCP (*5), 4K , 3D |
| Audio input             | Sampling frequency: 32/44.1/48 kHz |
|                         | Sampling bit: 16/20/24 bit |
Model name: PA622U/PA522U/PA672W/PA572W/PA722X/PA622X

<table>
<thead>
<tr>
<th>DisplayPort</th>
<th>Video input</th>
<th>DisplayPort × 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Data rate: 2.7Gbps/1.62Gbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No. lanes: 1 lane/2 lanes/4 lanes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Color depth: 6-bit, 8-bit, 10-bit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Colorimetry: RGB, YcbCr444 and YcbCr422 compatible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HDCP compatible (*)</td>
</tr>
<tr>
<td>Audio input</td>
<td></td>
<td>DisplayPort: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BNC (CV)</th>
<th>Video input</th>
<th>BNC × 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio input</td>
<td>(shared with the BNC, BNC (CV), BNC (Y/C) audio input terminals)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>BNC (Y/C)</th>
<th>Video input</th>
<th>BNC × 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio input</td>
<td>(shared with the BNC, BNC (CV), BNC (Y/C) audio input terminals)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PC control connector</th>
<th>D-Sub 9-pin × 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB port</td>
<td>USB type A × 1</td>
</tr>
<tr>
<td>Ethernet/HDBaseT port</td>
<td>RJ-45 × 1, Supports BASE-TX</td>
</tr>
<tr>
<td>Remote connector</td>
<td>Stereo mini jack × 1</td>
</tr>
</tbody>
</table>

3D SYNC output terminal: 5 V / 10 mA, synchronized signal output for 3D use

Usage environment:
- Operating temperature: 5 to 40°C (*6)
- Operating humidity: 20 to 80% (with no condensation)
- Storage temperature: -10 to 50°C (*6)
- Storage humidity: 20 to 80% (with no condensation)
- Operating altitude: 0 to 2700 m/8800 feet (1700 to 2700 m/5500 to 8800 feet: Set [FAN MODE] to [HIGH ALITUDE])

Power supply: 100-240 V AC, 50/60Hz

Power consumption:
- Eco mode off: PA722X/PA672W/PA622U: 483 W (100-130 V)/460 W (200-240 V), PA622X/PA572W/PA522U: 463 W (100-130 V)/440 W (200-240 V)
- Eco mode on: PA722X/PA672W/PA622U/PA622X/PA572W/PA522U: 377 W (100-130 V)/362 W (200-240 V)

STANDBY (NORMAL): 0.11 W
STANDBY (HDBaseT): 7.0 W

Rated input current:
- PA722X/PA672W/PA622U: 5.5 A-2.2 A
- PA622X/PA572W/PA522U: 5.1 A-2.2 A

External dimensions:
- 19.7” (width) × 5.68” (height) × 14.1” (depth)/499 (width) × 142 (height) × 359 (depth) mm (not including protruding parts)
- 19.7” (width) × 6.38” (height) × 14.5” (depth)/499 (width) × 162 (height) × 368 (depth) mm (including protruding parts)

Weight: 18.5 lbs/8.4 kg (not including lens)

*1 Effective pixels are more than 99.99%.
*2 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. The light output values will drop to 80% when [ON] is selected for [ECO MODE]. If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.
*3 Compliance with ISO21118-2005
*4 Full color (approx. 16.77 million colors or greater) when the HDBaseT input connector is selected.
*5 HDMI® (Deep Color, Lip Sync) with HDCP
What is HDCP/HDCP technology?
HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI). If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).
Video: Deep Color; 8/10/12-bit, LipSync
Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit
*6 35 to 40°C – “Forced eco mode” (PA622U/PA522U will shift to the eco-mode in stages starting from 33 °C.)
- These specifications and the product's design are subject to change without notice.
Cabinet Dimensions

Unit: mm (inch)
Mounting the cable cover (sold separately)

Mounting the separately sold cable cover (NP04CV) on the projector allows you hide the cables for a cleaner appearance.

**CAUTION**

- After mounting the cable cover, be sure to fasten using the screws provided. If not, the cable cover could fall, damaging the cable cover and possibly resulting in injury.
- Do not bundle the power cord and place it under the cable cover. Doing so could lead to fire.
- Do not apply excessive force to the cable cover. Doing so could damage the cable cover, resulting in the projector falling or causing injury.

**Mounting**

Preparations:
1. Connect the power cord and cables to the projector (the connection cords are omitted from the diagrams).
2. Prepare a Phillips screwdriver.

1. Insert the two round protrusions on the left and right edges of the cable cover into the grooves in the bottom of the projector to line it up.

**NOTE:** Be careful not to let the power cord and cables get pinched by the cable cover.

2. Turn the cable cover screw clockwise.
   - Tighten the screw securely.

**Removing**

1. Turn the cable cover screw counterclockwise until it turns loosely.
   - Hold the cable cover while doing this to prevent it from falling.
   - The screw does not come completely off.

2. Remove the cable cover.
   - Turn the cable cover a little, then lift it off.
### Pin assignments and signal names of main connectors

**COMPUTER IN/ Component Input Connector (Mini D-Sub 15 Pin)**

**Connection and signal level of each pin**

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock</td>
<td></td>
</tr>
</tbody>
</table>

**Signal Level**

- Video signal : 0.7Vp-p (Analog)
- Sync signal : TTL level

---

**HDMI 1 IN/HDMI 2 IN Connector (Type A)**

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TMDS Data 2+</td>
<td>11</td>
<td>TMDS Clock Shield</td>
</tr>
<tr>
<td>2</td>
<td>TMDS Data 2 Shield</td>
<td>12</td>
<td>TMDS Clock−</td>
</tr>
<tr>
<td>3</td>
<td>TMDS Data 2−</td>
<td>13</td>
<td>CEC</td>
</tr>
<tr>
<td>4</td>
<td>TMDS Data 1+</td>
<td>14</td>
<td>Disconnection</td>
</tr>
<tr>
<td>5</td>
<td>TMDS Data 1 Shield</td>
<td>15</td>
<td>SCL</td>
</tr>
<tr>
<td>6</td>
<td>TMDS Data 1−</td>
<td>16</td>
<td>SDA</td>
</tr>
<tr>
<td>7</td>
<td>TMDS Data 0+</td>
<td>17</td>
<td>DDC/CEC grounding</td>
</tr>
<tr>
<td>8</td>
<td>TMDS Data 0 Shield</td>
<td>18</td>
<td>+5 V power supply</td>
</tr>
<tr>
<td>9</td>
<td>TMDS Data 0−</td>
<td>19</td>
<td>Hot plug detection</td>
</tr>
<tr>
<td>10</td>
<td>TMDS Clock +</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**DisplayPort IN Connector**

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Main link lane 3−</td>
<td>11</td>
<td>Grounding 0</td>
</tr>
<tr>
<td>2</td>
<td>Grounding 3</td>
<td>12</td>
<td>Main link lane 0+</td>
</tr>
<tr>
<td>3</td>
<td>Main link lane 3+</td>
<td>13</td>
<td>Configuration 1</td>
</tr>
<tr>
<td>4</td>
<td>Main link lane 2−</td>
<td>14</td>
<td>Configuration 2</td>
</tr>
<tr>
<td>5</td>
<td>Grounding 2</td>
<td>15</td>
<td>Supplementary channel +</td>
</tr>
<tr>
<td>6</td>
<td>Main link lane 2+</td>
<td>16</td>
<td>Grounding 4</td>
</tr>
<tr>
<td>7</td>
<td>Main link lane 1−</td>
<td>17</td>
<td>Supplementary channel −</td>
</tr>
<tr>
<td>8</td>
<td>Grounding 1</td>
<td>18</td>
<td>Hot plug detection</td>
</tr>
<tr>
<td>9</td>
<td>Main link lane 1+</td>
<td>19</td>
<td>Return</td>
</tr>
<tr>
<td>10</td>
<td>Main link lane 0−</td>
<td>20</td>
<td>+3.3 V power supply</td>
</tr>
</tbody>
</table>
### Ethernet/HDBase T Port (RJ-45)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxD+/HDBT0+</td>
</tr>
<tr>
<td>2</td>
<td>TxD−/HDBT0−</td>
</tr>
<tr>
<td>3</td>
<td>RxD+/HDBT1+</td>
</tr>
<tr>
<td>4</td>
<td>Disconnection/HDBT2+</td>
</tr>
<tr>
<td>5</td>
<td>Disconnection/HDBT2−</td>
</tr>
<tr>
<td>6</td>
<td>RxD−/HDBT1−</td>
</tr>
<tr>
<td>7</td>
<td>Disconnection/HDBT3+</td>
</tr>
<tr>
<td>8</td>
<td>Disconnection/HDBT3−</td>
</tr>
</tbody>
</table>

### USB-A Port (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBUS</td>
</tr>
<tr>
<td>2</td>
<td>D−</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
</tr>
<tr>
<td>4</td>
<td>Grounding</td>
</tr>
</tbody>
</table>

### PC CONTROL Port (D-Sub 9 Pin)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unused</td>
</tr>
<tr>
<td>2</td>
<td>RxD reception data</td>
</tr>
<tr>
<td>3</td>
<td>TxD transmission data</td>
</tr>
<tr>
<td>4</td>
<td>Unused</td>
</tr>
<tr>
<td>5</td>
<td>Grounding</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>RTS transmission request</td>
</tr>
<tr>
<td>8</td>
<td>CTS transmission allowed</td>
</tr>
<tr>
<td>9</td>
<td>Unused</td>
</tr>
</tbody>
</table>

Communications protocol
## Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

### Indicator Messages

#### Power Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Power is off.</td>
<td>–</td>
</tr>
<tr>
<td>Flashing Blue (short flashes)</td>
<td>Preparing to turn power on</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Blue (long flashes)</td>
<td>Off timer (enabled)</td>
<td>–</td>
</tr>
<tr>
<td>Orange (short flashes)</td>
<td>Projector cooling</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Orange (long flashes)</td>
<td>Program timer (off time enabled)</td>
<td>–</td>
</tr>
<tr>
<td>Lit Blue</td>
<td>Power on</td>
<td>–</td>
</tr>
<tr>
<td>Lit Red</td>
<td>Standby mode (NORMAL)</td>
<td>–</td>
</tr>
<tr>
<td>Lit Orange</td>
<td>Standby mode (HDBaseT STANDBY)</td>
<td>–</td>
</tr>
</tbody>
</table>

#### Status Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No problem, or standby mode</td>
<td>–</td>
</tr>
<tr>
<td>Flashing Red (cycles of 1)</td>
<td>Cover problem</td>
<td>The lamp cover is not properly mounted. Mount it properly. (→ Page 144)</td>
</tr>
<tr>
<td>Red (cycles of 4)</td>
<td>Fan problem</td>
<td>The cooling fan has stopped turning. Contact an NEC projector customer support center for repairs.</td>
</tr>
<tr>
<td>Flashing Orange</td>
<td>Network conflict</td>
<td>It is not possible to connect the projector's built-in LAN and wireless LAN simultaneously to the same network. To connect the projector's built-in LAN and wireless LAN simultaneously, connect them to different networks.</td>
</tr>
<tr>
<td>Lit Green</td>
<td>STANDBY MODE in sleep mode*</td>
<td>–</td>
</tr>
<tr>
<td>Orange</td>
<td>Button has been pressed while projector is in key lock mode</td>
<td>The projector’s keys are locked. The setting must be canceled to operate the projector. (→ Page 104)</td>
</tr>
<tr>
<td></td>
<td>Projector’s ID number and remote control’s ID number do not match</td>
<td>Check the control IDs. (→ Pages 105)</td>
</tr>
</tbody>
</table>

* Sleep mode refers to the state whereby the functional restrictions due to the standby mode setting are removed.
Lamp Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The lamp is turned off.</td>
<td>–</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Preparing to relight lamp after lighting has failed</td>
<td>Wait a while.</td>
</tr>
<tr>
<td>Red</td>
<td>Lamp replacement grace period</td>
<td>The lamp has reached the end of its service life and is now in the replacement grace period (100 hours). Replace the lamp as soon as possible. (→ page 142)</td>
</tr>
<tr>
<td>Red (cycles of 6)</td>
<td>Lamp does not light</td>
<td>The lamp has not turned on. Wait at least 1 minute, then turn the power back on. If the lamp still does not light, contact an NEC projector customer support center.</td>
</tr>
<tr>
<td>Lit Red</td>
<td>Lamp usage time exceeded</td>
<td>The lamp has exceeded its usage time. The projector's power cannot be turned on until the lamp is replaced. (→ page 142)</td>
</tr>
<tr>
<td>Green</td>
<td>Lamp lit</td>
<td>–</td>
</tr>
</tbody>
</table>

Temp. Indicator

<table>
<thead>
<tr>
<th>Indicator display</th>
<th>Projector status</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No problem</td>
<td></td>
</tr>
<tr>
<td>Flashing Red (cycles of 2)</td>
<td>Temperature problem</td>
<td>The temperature protector has been activated. If the room temperature is high, move the projector to a cool place. If the problem still persists, contact an NEC projector customer support center.</td>
</tr>
<tr>
<td>Lit Orange</td>
<td>High surrounding temperature</td>
<td>The surrounding temperature is high. Lower the room temperature.</td>
</tr>
</tbody>
</table>

If the temperature protector is activated

If the projector's internal temperature rises abnormally, the lamp turns off and the temperature indicator flashes (repeatedly in cycles of 2).

It may happen that the projector's temperature protector is simultaneously activated and the projector's power turns off.

If this happens, do the following:
- Unplug the power cord from the power outlet.
- If using in a place where the surrounding temperature is high, move the projector to a different, cool place.
- If there is dust in the ventilation holes, clean. (→ pages 138 and 141)
- Wait as such about 1 hour for the projector's internal temperature to lower.
### Common Problems & Solutions

(→ “Power/Status/Lamp Indicator” on page 174.)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down | • Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 13, 14)  
  • Ensure that the lamp cover is installed correctly. (→ page 144)  
  • Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
  • Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 116)  
  • The lamp may fail to light. Wait a full minute and then turn on the power again.  
  • Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1600 meters or higher. Using the projector at altitudes approximately 5500 feet/1600 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 97)  
  • If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for some time and then the projector will display the image. Wait for a moment. |
| Will turn off | • Ensure that the [OFF TIMER], [AUTO POWER OFF] or [PROGRAM TIMER] is off. (→ page 100, 115) |
| No picture | • Check if the appropriate input is selected. (→ page 16) If there is still no picture, press the INPUT button or one of the input buttons again.  
  • Ensure your cables are connected properly.  
  • Use menus to adjust the brightness and contrast. (→ page 76)  
  • Ensure that the lens cover is open. (→ page 14)  
  • Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 116)  
  • Enter your registered keyword if the Security function is enabled. (→ page 36)  
  • If the HDMI input or the DisplayPort signal cannot be displayed, try the following.  
     - Reinstall your driver for the graphics card built in your computer, or use the updated driver.  
     - For reinstalling or updating your driver, refer to the user guide accompanied with your computer or graphics card, or contact the support center for your computer manufacturer.  
     - Install the updated driver or OS on your own responsibility.  
     - We are not liable for any trouble and failure caused by this installation.  
     - Signals may not be supported depending on the HDBaseT transmission device. IR and RS232C cannot be used in certain cases as well.  
     - Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
     - In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
     - If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.  
     - See also the page 177. |
| Picture suddenly becomes dark | • Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 97) |
| Color tone or hue is unusual | • Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 97)  
  • Adjust [HUE] in [PICTURE]. (→ page 77) |
| Image isn’t square to the screen | • Reposition the projector to improve its angle to the screen. (→ page 18)  
  • Use the Keystone correction function to correct the trapezoid distortion. (→ page 33) |
| Picture is blurred | • Adjust the focus. (→ page 20)  
  • Reposition the projector to improve its angle to the screen. (→ page 18)  
  • Ensure that the distance between the projector and screen is within the adjustment range of the lens. (→ page 158)  
  • Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 162)  
  • Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
| Flicker appears on screen | • Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 feet/1600 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1600 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO]. (→ page 97) |
| Image is scrolling vertically, horizontally or both | • Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported by the projector. (→ page 164)  
  • Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 79) |
### Problem | Check These Items
--- | ---
Remote control does not work | • Install new batteries. (→ page 10)  
• Make sure there are no obstacles between you and the projector.  
• Stand within 22 feet (7 m) of the projector. (→ page 11)  
• To perform computer mouse operations using the projector’s remote control, connect the optional mouse receiver to the computer. (→ page 31)
Indicator is lit or blinking | • See the POWER/STATUS/LAMP Indicator. (→ page 173)
Cross color in RGB mode | • Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 24)  
• Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 78)

For more information contact your dealer.
If there is no picture, or the picture is not displayed correctly.

• Power on process for the projector and the PC.
  Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.
  In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.
  
  NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 119 or go to next step)

• Enabling the computer’s external display.
  Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

• Non-standard signal output from the computer
  If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.

• Image displayed is incorrect when using a Mac
  When using a Mac with the projector, set the DIP switch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Mac for the changes to take affect.
  For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13” fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then restart the Mac again.
  
  NOTE: A Video Adapter cable manufactured by Apple Computer is needed for a MacBook which does not have a mini D-Sub 15-pin connector.

• Mirroring on a MacBook
  * When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.

• Folders or icons are hidden on the Mac screen
  Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
PC Control Codes and Cable Connection

PC Control Codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI1</td>
<td>02H 03H 00H 00H 02H 01H A1H A9H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI2</td>
<td>02H 03H 00H 00H 02H 01H A2H AAH</td>
</tr>
<tr>
<td>INPUT SELECT DisplayPort</td>
<td>02H 03H 00H 00H 02H 01H A6H AEH</td>
</tr>
<tr>
<td>INPUT SELECT BNC</td>
<td>02H 03H 00H 00H 02H 01H 02H 0AH</td>
</tr>
<tr>
<td>INPUT SELECT BNC(Y/C)</td>
<td>02H 03H 00H 00H 02H 01H 06H 0EH</td>
</tr>
<tr>
<td>INPUT SELECT BNC(CV)</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT HDBaseT</td>
<td>02H 03H 00H 00H 02H 01H 20H 28H</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 10H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
<tr>
<td>SOUND MUTE ON</td>
<td>02H 12H 00H 00H 00H 14H</td>
</tr>
<tr>
<td>SOUND MUTE OFF</td>
<td>02H 13H 00H 00H 00H 15H</td>
</tr>
</tbody>
</table>

NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.

Cable Connection

Communication Protocol
- Baud rate: 38400 bps
- Data length: 8 bits
- Parity: No parity
- Stop bit: One bit
- X on/off: None
- Communications procedure: Full duplex

NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.

PC Control Connector (D-SUB 9P)

NOTE 1: Pins 1, 4, 6 and 9 are no used.

NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.
9 Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

**Frequency of occurrence** □ always □ sometimes (How often?_____________________) □ other (__________________)

### Power

- □ No power (POWER indicator does not light blue). See also “Status Indicator (STATUS)”.
  - □ Power cord’s plug is fully inserted into the wall outlet.
  - □ Lamp cover is installed correctly.
  - □ Lamp Hours Used (lamp operation hours) was cleared after lamp replacement.
  - □ No power even though you press and hold the POWER button.

- □ Shut down during operation.
  - □ Power cord’s plug is fully inserted into the wall outlet.
  - □ Lamp cover is installed correctly.
  - □ [AUTO POWER OFF] is turned off (only models with the [AUTO POWER OFF] function).
  - □ [OFF TIMER] is turned off (only models with the [OFF TIMER] function).

### Video and Audio

- □ No image is displayed from your PC or video equipment to the projector.
  - □ Still no image even though you connect the projector to the PC first, then start the PC.
  - □ Enabling your notebook PC’s signal output to the projector.
    - A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
  - □ No image (blue or black background, no display).
  - □ Still no image even though you press the AUTO ADJUST button.
  - □ Still no image even though you carry out [RESET] in the projector’s menu.
  - □ Signal cable’s plug is fully inserted into the input connector
  - □ A message appears on the screen.
    - (__________________________)
  - □ The source connected to the projector is active and available.
  - □ Still no image even though you adjust the brightness and/or the contrast.
  - □ Input source’s resolution and frequency are supported by the projector.
  - □ Image is too dark.
  - □ Remains unchanged even though you adjust the brightness and/or the contrast.
  - □ Image is distorted.
  - □ Image appears to be trapezoidal (unchanged even though you carry out the [KEYSTONE] adjustment).

- □ Parts of the image are lost.
  - □ Still unchanged even though you press the AUTO ADJUST button.
  - □ Still unchanged even though you carry out [RESET] in the projector’s menu.
  - □ Image is shifted in the vertical or horizontal direction.
  - □ Horizontal and vertical positions are correctly adjusted on a computer signal.
  - □ Input source’s resolution and frequency are supported by the projector.
  - □ Some pixels are lost.
  - □ Image is flickering.
  - □ Still unchanged even though you press the AUTO ADJUST button.
  - □ Still unchanged even though you carry out [RESET] in the projector’s menu.
  - □ Image shows flickering or color drift on a computer signal.
  - □ Still unchanged even though you change [FAN MODE] from [HIGH ALTITUDE] to [AUTO].
  - □ Image appears blurry or out of focus.
  - □ Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
  - □ Still unchanged even though you adjusted the focus.
  - □ No sound.
  - □ Audio cable is correctly connected to the audio input of the projector.
  - □ Still unchanged even though you adjusted the volume level.
  - □ AUDIO OUT is connected to your audio equipment (only models with the AUDIO OUT connector).

### Other

- □ Remote control does not work.
  - □ No obstacles between the sensor of the projector and the remote control.
  - □ Projector is placed near a fluorescent light that can disturb the infrared remote controls.
  - □ Batteries are new and are not reversed in installation.

- □ Buttons on the projector cabinet do not work (only models with the [CONTROL PANEL LOCK] function).
  - □ [CONTROL PANEL LOCK] is not turned on or is disabled in the menu.
  - □ Still unchanged even though you press and hold the EXIT button for a minimum of 10 seconds.
In the space below please describe your problem in detail.

Information on application and environment where your projector is used

**Projector**
- Model number:
- Serial No.:
- Date of purchase:
- Lamp operating time (hours):
- Eco Mode: □ OFF  □ ON
- Information on input signal:
  - Horizontal synch frequency [ ] kHz
  - Vertical synch frequency [ ] Hz
  - Synch polarity H □ (+)  □ (−)
  - V □ (+)  □ (−)
- Synch type □ Separate  □ Composite
- □ Sync on Green
- STATUS Indicator:
  - Steady light □ Orange  □ Green
  - Flashing light [ ] cycles
- Remote control model number:

**Installation environment**
- Screen size: inch
- Screen type: □ White matte  □ Beads  □ Polarization
  □ Wide angle  □ High contrast
- Throw distance: feet/inch/m
- Orientation: □ Ceiling mount  □ Desktop
- Power outlet connection:
  □ Connected directly to wall outlet
  □ Connected to power cord extender or other (the number of connected equipment______________)
  □ Connected to a power cord reel or other (the number of connected equipment______________)

**Computer**
- Manufacturer:
- Model number:
- Notebook PC □ / Desktop □
- Native resolution:
- Refresh rate:
- Video adapter:
- Other:

**Video equipment**
- VCR, Blu-ray player, Video camera, Video game or other
- Manufacturer:
- Model number:

**Signal cable**
- NEC standard or other manufacturer’s cable?
  - Model number: Length: inch/m
- Distribution amplifier
  - Model number:
- Switcher
  - Model number:
- Adapter
  - Model number: